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About MimioClassroom
MimioClassroom is a suite of tools for capturing, creating, and presenting information.

The following MimioClassroom components are described in this User Guide:

n MimioStudio
n MimioTeach
n Mimio Interactive
n MimioCapture
n Mimio Capture Kit
n MimioVote
n MimioView
n MimioPad (Model Number ICD07)
n MimioPad (Model Number RCK-M01)
n MimioMobile
n MimioProjector

MimioStudio
MimioStudio software includes all of the tools you need to make the most out of your
MimioClassroom devices. You can also use the MimioStudio software without a
MimioClassroom device to prepare presentations and manipulate previously created content.

MimioStudio Notebook provides a multi-page workspace for creating lessons and
presentations. Using the MimioStudio Notebook is very similar to using other word
processing or presentation software applications.

MimioStudio Notebook provides multiple authoring and editing tools for creating almost
any type of content. You can use Notebook with MimioStudio Tools to create a variety of
objects including text boxes, freehand writing and drawing, lines, arrows, and many basic
shapes. Images can be imported into a Notebook, both as objects and as background images.

MimioTeach
Using MimioTeach with a projector, you can deliver lessons and presentations directly from
your whiteboard. Using MimioStudio Interactive mode, you control the movement of the
cursor on your screen with the MimioTeach stylus, much like you would with a mouse at
your computer.
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Mimio Interactive
Using Mimio Interactive with a projector, you can deliver lessons and presentations directly
from your whiteboard. Using MimioStudio Interactive mode, you control the movement of
the cursor on your screen with the Mimio Interactive Mouse, much like you would with a
mouse at your computer.

MimioCapture
MimioCapture is used with a MimioTeach-enabled whiteboard to record notes and drawings
from your whiteboard. Using MimioStudio Ink Capture mode, you make notes and drawings
on your whiteboard using the MimioCapture pens. Your notes are automatically captured in
a MimioStudio Notebook.

Mimio Capture Kit
Mimio Capture Kit is used with a Mimio Interactive-enabled whiteboard to record notes and
drawings from your whiteboard. Using MimioStudio Ink Capture mode, you make notes and
drawings on your whiteboard using the Mimio Capture Kit pens. Your notes are
automatically captured in a MimioStudio Notebook.

MimioVote
MimioVote is a wireless, interactive, student response system. Using MimioVote, you can
easily and quickly gather student responses. This quick feedback from students allows you
to make sure each student is keeping up and adjust your lesson accordingly.

MimioView
MimioView works seamlessly with MimioStudio software to display documents, three-
dimensional objects, and microscope slides for your entire class to view. You can use
MimioView to display still images or live video.

MimioPad (Model Number: ICD07)
MimioPad is a 2.4 GHz wireless pad. To configure MimioPad for use, install the
MimioStudio software and plug the MimioPad into your computer using the included USB
cable or connect the MimioPad to your computer wirelessly using the MimioHub. Once
connected, you can use the MimioPad from anywhere in the room to interact with your
computer. No additional configuration is required.

MimioPad (Model Number: RCK-M01)
MimioPad is a 2.4 GHz wireless pad. To configure MimioPad for use, install the
MimioStudio software and plug the wireless receiver into your computer. Once connected,
you can use the MimioPad from anywhere in the room to interact with your computer. No
additional configuration is required.
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MimioMobile
Using the MimioMobile app on a mobile device, teachers and students can collaborate
using interactive whiteboard lessons. The MimioMobile app can be used alone with
MimioStudio software or in conjunction with MimioTeach interactive system and other
MimioClassroom products.

The MimioMobile app is available for the following devices:

n iPad® 2 or later, running iOS 5 or later
n iPhone® 4 or later, running iOS 5 or later
n iPod touch® 4th generation or later, running iOS 5 or later
n Mobile device running Android™ 3.0 (Honeycomb) or later

MimioMobile can be used by both students and teachers. Teachers can pass desktop control
to any student mobile device and initiate group activities so that all students with a mobile
device can simultaneously participate in an activity. Students can also use a mobile device
with MimioMobile in place of a MimioVote unit.

Mobile devices with the MimioMobile app can be used in conjunction with the new
MimioPad tablet.

MimioProjector
Using MimioProjector and a conventional dry erase board, you can bring interactive
teaching into your classroom. MimioProjector easily connects to your computer and can be
used as an interactive projector along with the interactive pens or alone as a non-interactive,
conventional projector.

Minimum System Requirements
The minimum system requirements for MimioStudio are:

n Ubuntu 11.04 or later or Fedora 15 or later
n 512 MB RAM minimum (1 GB RAM recommended)
n 500 MB free disk space (English), 1 GB free disk space (International)
n Internet connection to download and activate the software
n Available USB port (required to use a MimioClassroom device)

Using this Guide
This User Guide includes information for using the different MimioClassroom components.
Depending on the types of MimioClassroom devices you have, some sections of this User
Guide may not apply to you.

The following table provides a summary of the contents.
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User Guide Chapter Description

About MimioClassroom This chapter gives an overview of the MimioClassroom products,
including MimioStudio software, MimioTeach, MimioCapture,
MimioVote, and MimioView.

MimioStudio This chapter describes how to work with MimioStudio Notebook,
Tools, and Gallery to create and deliver lessons and other
presentations.

MimioTeach
This chapter describes how to set up and use MimioTeach with your
whiteboard and a projector. This chapter also describes how to use
MimioStudio in Interactive mode.

Mimio Interactive
This chapter describes how to set up and use Mimio Interactive with
your whiteboard and a projector. This chapter also describes how to
use MimioStudio in Interactive mode.

MimioCapture
(Model Number: ICD10)

This chapter describes how to set up and use MimioCapture model
number ICD10. Included in this chapter are instructions for capturing
notes and drawings from a MimioTeach-enabled whiteboard as
digital ink using MimioCapture.

MimioCapture
(Model Number: ICD04)

This chapter describes how to set up and use MimioCapture model
number ICD04. Included in this chapter are instructions for capturing
notes and drawings from a MimioTeach-enabled whiteboard as
digital ink using MimioCapture.

Mimio Capture Kit

This chapter describes how to set up and use Mimio Capture Kit.
Included in this chapter are instructions for capturing notes and
drawings from a Mimio Interactive-enabled whiteboard as digital ink
using Mimio Capture Kit

MimioVote

This chapter describes how to set up and use MimioVote. Included in
this chapter are instructions for creating and conducting MimioVote
activities, as well as information about setting up and using
MimioStudio Gradebook to save student grades and information.

MimioView This chapter describes how to set up and use MimioView. Included
in this chapter are instructions for displaying and annotating images
in the MimioStudio View window.

MimioPad
Model Number: ICD07

This chapter describes how to set up and use MimioPad model
number ICD07.

MimioPad
Model Number: RCK-M01

This chapter describes how to set up and use MimioPad model
number RCK-M01.

MimioMobile This chapter describes how to set up and use MimioMobile.

4



Using this Guide

User Guide Chapter Description

MimioProjector This chapter describes how to set up and use MimioProjector.

Customizing MimioStudio This chapter describes how to customize the features of the
MimioStudio software and the MimioClassroom devices.

Getting Help
This chapter gives troubleshooting information for some common
problems, describes how to check for and install MimioStudio
software updates, and describes how to contact Technical Support.

Technical and Environmental
Information

This chapter contains technical, certification, and safety information
for the MimioClassroom products.
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MimioStudio
MimioStudio software includes all of the tools you need to make the most out of your
MimioClassroom devices. You can also use the MimioStudio software without a
MimioClassroom device to prepare presentations and manipulate previously created content.

About MimioStudio
The following are the three main MimioStudio software applications that are used to create
and present information.

n MimioStudio Notebook
n MimioStudio Tools
n MimioStudio Gallery

For information about other MimioStudio applications, see the chapters of this User
Guide that describe the MimioClassroom devices that you have.

MimioStudio Notebook provides a multi-page workspace for creating lessons and
presentations. Using the MimioStudio Notebook is very similar to using other word
processing or presentation software applications.

MimioStudio Notebook provides multiple authoring and editing tools for creating almost
any type of content. You can use Notebook with MimioStudio Tools to create a variety of
objects including text boxes, freehand writing and drawing, lines, arrows, and many basic
shapes. Images can be imported into a Notebook, both as objects and as background images.

About MimioStudio Notebook
You can create and present information with MimioStudio Notebook. Using Notebook is
very similar to using other word processing or presentation software. Content created in
Notebook can be saved as Mimio INK files or a variety of other file formats including
HTML, JPEG, PNG, BMP, TIF, and IWB.

You can use Tab View to view a list of files that are attached to a Notebook or to view a
thumbnail of each page in a Notebook.

About MimioStudio Tools
MimioStudio Tools provides a comprehensive set of interactive tools and resources to create
and present information. MimioStudio Tools is used to modify MimioStudio Notebook
pages and to make screen annotations on the whiteboard.

The following table describes the major components of MimioStudio Tools.
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Selection tool Zoom

Pen Brush

Text Highlighter

Line Arrow End

Arrow Start Arrow Both

Rectangle Ellipse

Triangle Right Triangle

Five Pointed Star Hexagon

Pentagon Shape Recognition

Eraser Insert file

Screen clipping Color picker

More colors Object Fill

Outline and Fill color Thickness slider

Color palette Solid Line

Dash Line Square Dot Line

Transparency Gallery

Applications (see below) Right-click

Interactive Mouse

Screen Annotation

From the Applications tool, you can access the following:
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Reveal
Spotlight

Text Tools

Class Manager
Control
 Quick Collaborate

Quick Vote

View

Calculator
Web Browser

MimioStudio Tools has two views: a fully expanded view, for easy access to all features,
and a compressed view, which takes up less space on the screen.

To compress and expand MimioStudio Tools

Double-click  at the top of the MimioStudio Tools toolbar.

About MimioStudio Gallery
MimioStudio Gallery contains elements that can be used to create your lessons and
presentations, such as images, templates, movies, and previously created lessons.
MimioStudio Gallery also contains Screen Annotation snapshots and Collaborate pages.
You can customize the Gallery by adding your own elements.

MimioStudio Gallery consists of the following four main folders:
n Screen Annotations - contains all saved Screen Annotation snapshots.
n Imported Content Packs - contains any imported content that you have not yet added

to the Gallery folder.
n Questions and Results - contains a variety of objects for use with MimioVote.
n Gallery - contains a number of different folders used to categorize items, such as

Geography, Mathematics, and so on.
n Collaborative Sessions - contains all saved Collaborate pages.

The Gallery folder and each of the Gallery subfolders can contain five different types of
objects:

n Images - Images include pictures and graphics.
n Templates - Templates include backgrounds and predefined page layouts.
n Multimedia - Multimedia objects include movies, animation, and sound.
n Questions and Results - Questions and Results include objects for creating and

displaying the results of MimioVote activities.
This section of the Gallery does not appear until you move objects from the
Questions and Results folder to the Gallery folder or a Gallery subfolder.

n Lessons - Lessons include lessons created using MimioStudio Notebook and imported
documents. You can create your own lessons or import lessons created by someone else.

Getting Started with MimioStudio
After installing MimioStudio, MimioStudio Notebook and MimioStudio Tools open on
your desktop.

You can activate MimioStudio software on your computer by connecting a Mimio
hardware device or by entering an activation code.

You can access many of the features in MimioStudio in several ways; from the menu bar,
the MimioStudio Tools buttons, and the right-click menus. The available features change
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depending on what you are doing in the software. Be sure to explore the right-click menu
options as you work with MimioStudio.

Accessing MimioStudio Notebook
Several ways to access MimioStudio Notebook are shown in the following table.

To start from the Do this

Desktop Double-click  on the desktop.

Notification area Right-click , and then choose Notebook.

Applications menu Point toMimioStudio, and then chooseMimioStudio Notebook.

Accessing MimioStudio Tools
Several ways to access MimioStudio Tools are shown in the following table.

To start from the Do this

Notification area Right-click , and then choose Tools.

Applications Menu Point toMimioStudio, and then chooseMimioStudio Tools.

MimioStudio Notebook

Do one of the following:

n Double-click  on the status bar.

n Choose MimioStudio Tools from the Tools menu.

MimioTeach Press the Launch button, , on the MimioTeach bar, and then click
Tools in the Launch window.

Mimio Interactive Press the New page button, , on the Mimio Interactive bar.

Accessing MimioStudio Gallery
Several ways to access MimioStudio Gallery are shown in the following table.

To start from Do this

Applications Menu Point toMimioStudio, Tools, and then chooseMimioStudio Gallery.

MimioStudio Tools Click  on the MimioStudio Tools toolbar.

MimioStudio Notebook

Do one of the following:

n Double-click  on the status bar.

n Choose Gallery from the Insert menu.
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Using MimioStudio Notebook
You can create and present information with MimioStudio Notebook. Using Notebook is
very similar to using other word processing or presentation software. Content created in
Notebook can be saved as Mimio INK files or a variety of other file formats including
HTML, JPEG, PNG, BMP, TIF, and IWB.

You can use Tab View to view a list of files that are attached to a Notebook or to view a
thumbnail of each page in a Notebook.

To open an existing Notebook

1. Start MimioStudio Notebook and click .
2. From the Open dialog box, navigate to and select the file to open and click Open.
To save a Notebook
1. Click the Save button, .
2. From the Save As dialog box, enter a name for your file in the File name box.
3. Choose the desired format from the Save as type list.
4. Click Save.

When saving in a format other than INK, the Select Pages dialog box appears.
5. From the Select Pages dialog box, do the following:

l Select the pages to save under Page Selection.
l Choose a size for the images from the Size list.

6. Click OK.

Working with Pages
Each lesson or presentation created in MimioStudio Notebook consists of a series of pages.
Pages can be viewed, presented, and edited in the main Notebook window or in Full Screen
view. You can view a thumbnail of each page in a Notebook using the Thumbnails pane in
the Tab View.

You can insert new pages, import pages from another Notebook, delete pages, and reorder
pages. You can also change the size of a page, change the background of a page, and add
transition effects between pages in your Notebook.

To insert a new page
Do one of the following:

l Click the New Page button, .

l (Capture mode only) Press the New Page button,  , on your MimioCapture tray.

To select a page

1. In the Tab View, click  to display the Thumbnails pane.
2. Do one of the following:

l To select multiple pages, press CTRL and select each page.
l To select multiple pages that are close to each other, drag a selection rectangle over
the pages to select.
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l To select a range of pages, select the first page, and then press SHIFT and select
the last page.

l To select all pages, choose Select All from the Edit menu.
To insert a duplicate of an existing page

1. In the Tab View, click , and then select the page to duplicate.
2. Do one of the following:

l Choose Duplicate Page from the Insert menu.
l (Capture mode only) Press the Copy Page button, , on your MimioCapture tray.

To delete a page

1. In the Tab View, click , and then select the page to delete.
2. Click the Delete button, .
To import a page from another Notebook

1. In the Tab View of the source Notebook, click  and then select the page to import.
2. Click the Copy button, .
3. Select the location in the target Notebook to insert the page.
4. Click the Paste button, .

You can also import pages by dragging the pages from the source Notebook to the
target Notebook.

To insert the desktop as a new page
1. From MimioStudio Tools, click the Screen Clipping button, .

The desktop is displayed with a transparent mask.

2. Click .
The desktop is inserted as a new page in the Notebook.

To change the page size
1. Choose Page Setup from the File menu.

The Page Setup dialog box appears.
2. Do one of the following:

l From the Page Size list, choose any of the available display or device sizes.
l From the Page Size list, choose Custom, and then enter the desired valued into the
Width and Height boxes.

3. From the Apply To list, choose one of the following:
l Current Page to apply the page size to the current page only.
This option is not available if more than one page is selected in the Tab View.

l Selected Pages to apply the page size to the selected pages.
This option is only available if more than one page is selected in the Tab View.

l Whole Document to apply the page size to all of the pages in the Notebook.
4. (Optional) Do one of the following:

l To apply the page size to all new pages, select the All new pages check box.
This option is only available if no MimioTeach device is connected.
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l To apply the page size to all new pages and the currently connected device, select
the The connected device check box.
This option is only available if a MimioTeach device is connected.

5. Click OK to apply your changes.
To change the background color of a page
1. Choose Background from the Insert menu.
2. From the Background dialog box, click Color.
3. From the Color dialog box, select a color, and then click OK.
4. From the Apply To list, select the pages to apply the background color to.
5. To apply the background color to all new pages, select the All new pages check box.
6. Click OK to apply your changes.
To change the background image of a page
1. Choose Background from the Insert menu.
2. From the Background dialog box, click Image.
3. From the Open dialog box, navigate to and select the image file that you want to use as

your background.
4. Click Open.

The image is displayed in the Preview area.
You can also import an image from another application or from the MimioStudio
Gallery to use as a background. To do this, select the image and drag to the
Preview area.

5. Select the display mode for the new background from the Mode list.

Mode Result

Place The image is placed in the top left corner of the page and is not resized.

Stretch The image is resized to fill the entire page.

Tile The image is tiled repeatedly to fill the entire page and is not resized.

Center The image is placed in the center of the page and is not resized.

6. From the Apply To list, select the pages to apply the background to.
7. To apply the background to all new pages, select the All new pages check box.
8. Click OK to apply your changes.
To add a transition effect between pages
1. Choose Page Transition from the Insert menu.

The Page Transition dialog box appears.
2. From the Transitions list, select the transition to apply.
3. From the Apply To list, select the pages to apply the transition to.
4. To apply the transition to all new pages, select the All new pages check box.
5. Click OK.
To sort pages
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1. In the Tab View, click to display the Thumbnails pane.
2. Select the pages to sort.
3. Drag the selected pages to the desired location.
To print a page

1. In the Tab View, click to display the Thumbnails pane.
2. Select the pages to print.
3. Click the Print button, .

The Print dialog box appears.
4. Click Print.

To print the current page in Ink Capture mode, press the Print Page button, , on your
MimioCapture tray.

Creating an Activity
MimioStudio Notebook includes a wizard that you can use to quickly create and insert an
activity into your Notebook.

The wizard guides you through the following steps to create and insert an activity:

n Step 1: Define - Define the subject, grade level, and template for the activity.
n Step 2: Select - Select the topic and categories for the activity, and when to show

students the correct answers.
n Step 3: Refine - Refine the items available in the activity. You can also choose to

display items as images or text.
n Step 4: Review - Review the activity and enter a student-focused objective.
To start the wizard
1. Open a new or existing Notebook.
2. Choose New Activity from the Insert menu.

The wizard starts.
3. Follow the instructions in the wizard.
4. When finished, click Finish to insert the activity as a new page in the MimioStudio

Notebook.

Creating an Activity - Step 1: Define
When you create an activity using the wizard, you define the subject, grade level, and
template for the activity.

To define the activity
1. Under Subject, select a subject for the activity.
2. Under Grade Level, select the grade level of the students that will participate in the

activity.
3. Under Template, select a template for the activity.
4. Click Next.

Next, you select the topic and categories for the activity.
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Creating an Activity - Step 2: Select
Once you have completed Step 1, you must select the topic and categories for the activity.

The topic and categories available depend on the subject and grade level you selected. The
number of categories that you need to choose depends on the template you selected.

You also select when to reveal the correct answers to your students.

To select the topic, categories, and when to show answers
1. Select a topic for the activity from the Topic list.
2. Select a category from each of the categories lists.

The categories available depend on the topic you selected.
3. Select one of the following from the Reveal answers list:

l Immediately following a student response to show if the student response is correct
or incorrect immediately following each response.

Select this option when students are acquiring new skills. Providing feedback
after each response allows you to explain to the students why a response is
incorrect immediately after an error is made.

l When I choose the check answers item to show the correct and incorrect answers
only when you click the check answers item in the activity.

Select this option when students have already acquired skills. Providing
feedback after all responses are given allows you to test the students to see if
they can complete the entire activity on their own.

4. Click Next to go to the next page of the wizard.

Creating an Activity - Step 3: Refine
Once you have completed Step 1 and Step 2, the wizard automatically generates the choice
pool for the activity. The choice pool contains the set of available items students will use to
complete the activity.

Optionally, you can further refine your activity in the following ways:

n Change the state of items in the library to always include or exclude from the choice
pool.

n Display items as images or text. (Not available for all items.)
n Increase or decrease the number of items available in the choice pool.
n Change the number of items belonging to each category in the choice pool.
n Update the choice pool with new items from the library.

Refining the activity is optional. To skip this page of the wizard and move on to the
next page, click Next.

Selecting Items to Include or Exclude

You can choose to always include or always exclude items from the activity. The following
table describes the available states for each item.
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Always include item in choice pool.

Never include item in choice pool.

No mark Randomly include item in choice pool.

To select items to always include or exclude from the activity
1. Under Library, select the item that you want to always include or exclude.
2. Click one of the following:

l Include to always include the item in the choice pool.

l Exclude to never include the item in the choice pool.
The state of the item is updated in the library.

To clear the include or exclude state for an item
1. Select the included or excluded item.
2. Click Clear.

The state of the item is updated in the library.

Displaying Items as Images or Text

You can choose to display the items in the activity as images or as text.

To display items as images or text
Select one of the following from the Display Type list:
l Text to display all items in the library and the choice pool as text.
l Image to display all items in the library and the choice pool as images. (Not
available for all items.)

Changing Choice Categories

The number of items in the choice pool that belong to each category is determined
automatically. You can replace some of the items in the choice pool with items from a
different category so that the choice pool contains more choices from one category and
fewer from another.

The maximum number of items available in the choice pool is 20. You can increase or
decrease the number of items in the choice pool by adding or removing items.

To change an item in the choice pool
1. Under Choice Pool, select the item or empty position to change.
2. Do one of the following:

l To replace or add an item, click the desired category for the new item.
l To remove the item and leave the position empty, click Empty.

Updating the Choice Pool

You can update the choice pool at any time.

To update the choice pool
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Click Update.

Creating an Activity - Step 4: Review
You can review the activity before inserting the activity into your Notebook. You can also
enter a student-focused objective for your activity.

To review the activity and enter an objective
1. Review the activity.

If necessary, click Back to return to the previous pages of the wizard and make any
desired changes.

2. Enter an objective in the Objective box.
For information about writing a student-focused objective, see Writing an Objective.

3. Click Finish.
The activity is inserted as a new page in the MimioStudio Notebook.

Working with an Activity
Once the activity is inserted as a new page in the MimioStudio Notebook, you have several
options for working with the activity.

The following table describes the options available for working with your activity.

Reset Answers Resets the activity and moves all answers back to the answer pool.

Check Answers Indicates the correct and incorrect answers.

Solve Moves all answers to the correct location in the activity.

Edit Opens the wizard. From the wizard, you can edit the activity.

Update Choices Updates the choices in the answer pool.

To select an option for working with your activity, click .

To display the objective for the activity, click .

Writing an Objective

Writing an Objective
The purpose of the objective is to communicate expectations clearly so that the teacher and
the students have a shared understanding of the performance standards by which the student
will be evaluated. Remember that a good student-focused objective includes the following
four parts:

n Actor - The person who will complete the task (for example, the student)
n Intent - The targeted category of performance (for example, identify birds and reptiles)
n Indicator - The observable and measurable behavior that reflects the intent (for

example, dragging and dropping)
n Outcome - The product that is to be evaluated (for example, images sorted into
columns)
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Example: The student will identify birds and reptiles by dragging the images from the
choice pool into the corresponding columns.

Optionally, you can include the following fifth part in an objective:

n Criterion - The level of performance that is targeted for mastery. This may be stated as
accuracy and/or rate.

Examples:

l The student will identify birds and reptiles by dragging the images from the choice
pool into the corresponding columns with 90% accuracy.

l The student will identify birds and reptiles by dragging the images from the choice
pool into the corresponding columns, with at least 9 out of 10 correct in less than
one minute.

Attaching Files
You can attach any type of file to a MimioStudio Notebook. Once a file is attached to the
Notebook, you can quickly open the file directly from within MimioStudio Notebook.

To attach a file to a Notebook
1. In the Tab View, click  to display the File Attachment pane.
2. On your computer, navigate to and select the file to attach to the Notebook.
3. Drag the file to the File Attachment pane.

The file is attached to the Notebook.
To open an attached file
1. In the Tab View, click  to display the File Attachment pane.
2. Double-click the file to open.

Using MimioStudio Tools
Using MimioStudio Tools, you can create a wide variety of objects on any MimioStudio
Notebook page, including lines, shapes, and freehand drawing and writing.

See Accessing MimioStudio Tools for information on accessing MimioStudio Tools.

Creating Objects
MimioStudio Tools provides tools for inserting freehand writing or drawing into your
MimioStudio Notebook, as well as lines, arrows, basic shapes, and formatted text. You can
also import images and multimedia objects, or insert a clipping of your screen into your
Notebook using Tools.

Once you select a drawing tool, that tool remains selected until you select a different
drawing tool or the selection tool.

To use the freehand pen

1. Click the Pen button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
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3. (Optional) To adjust the line color, do one of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
5. Place the cursor where you want the ink stroke to start on the page.
6. Drag the cursor to draw ink strokes.
To use the freehand brush

1. Click the Brush button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
3. (Optional) To adjust the line color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
5. Place the cursor where you want the brush stroke to start on the page.
6. Drag the cursor to draw brush strokes.
To highlight a portion of the display
1. Click the Highlighter button, .
2. (Optional) To adjust the highlighter width, drag the Thickness slider.
3. (Optional) To change the color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. Place the cursor where you want the highlight stroke to start on the page.
5. Drag the cursor over the area you want to highlight.
To erase ink and highlighting

1. Click the Eraser button, .
2. (Optional) To adjust the eraser width, drag the Thickness slider.
3. Drag the cursor over the ink or highlighter strokes you want to erase.
To add a line or shape
1. Click the line type or shape you want to add.
2. (Optional) To adjust the line or outline width, drag the Thickness slider.
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3. (Optional) To change the line or outline color, select the Outline Color box, and then
do one of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the

following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the line or shape, click the Transparency

button, , and then choose a transparency percentage.
7. Place the cursor where you want the line or shape to start on the page.
8. Drag the cursor to draw the line or shape.
To add formatted text
1. Click the Text button, .
2. Place the cursor where you want the text to start on the page.

For a fixed width text box, place the cursor where you want the text box to start on the
page and then drag to the desired width.

3. Select a font style, size, color, and an alignment option for the text.
4. Enter text in the text box.
To draw a shape

1. Click the Shape Recognition button, .
2. (Optional) To adjust the outline width, drag the Thickness slider.
3. (Optional) To change the outline color, select the Outline Color box, and then do one

of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the

following:
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l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the shape, click the Transparency button, ,

and then choose a transparency percentage.
7. Place the cursor where you want the shape to start on the page.
8. Drag the cursor to draw the shape.

The Shape Recognition tool can be used to draw circles, ellipses, triangles, rectangles,
squares, and lines.

To import a picture, multimedia object, or document
1. Do one of the following:

l From MimioStudio Tools, click , and then choose Insert File.

l From MimioStudio Notebook, choose File from the Insert menu.
2. From the Open dialog box, select the file to import.
3. Click Open.

The image or object is displayed on the Notebook page.
You can also copy and paste images from another application, or drag images from
another application into Notebook.

To insert a screen clipping
1. From MimioStudio Tools, click the Screen Clipping button, .

The desktop is displayed with a transparent mask.
2. Do one of the following:

l Click to insert a rectangular screen clipping.

l Click to insert an elliptical screen clipping.

l Click to insert a free-form screen clipping.

To insert the entire desktop as a new page in the Notebook, click .
3. Drag the cursor to select the area to capture.
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The selected area is inserted in the Notebook page.

Manipulating Objects
Objects on a page can be moved, rotated, copied, deleted, locked, and have their properties
adjusted.

To select an object

1. From MimioStudio Tools, click the Selection button, .
2. Do one of the following:

l Click the object to select.
l To select multiple objects, press CTRL and select each object.
l To select multiple objects that are close to each other, drag a selection rectangle
over the objects to select.

l To select all objects on a page, choose Select All from the Edit menu.
To move an object
1. Select the object to move.
2. Position the cursor over the object.

The cursor changes to the move cursor, .
3. Drag the object to the desired location.

To resize an object
1. Select the object to resize.

A frame is displayed around the object.
2. Position the cursor over one of the white sizing handles.

The cursor changes to the resize cursor, .
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3. Drag the cursor to resize the object.

To constrain object proportions during resizing, right-click the object and choose Fixed
Aspect Ratio.

To rotate an object
1. Select the object to rotate.

A frame is displayed around the object.
2. Position the cursor over the green rotation handle.

The cursor changes to the rotation cursor, .
3. Drag the cursor to rotate the object.

To snap to one of the predefined 45° increments, move the rotate cursor and release
over the predefined rotation anchor point.

To lock the position and properties of an object
1. Select the object to lock.
2. From the Format menu, point to Locking, and then choose Lock.

A locked object cannot be selected.

To unlock an object
From the Format menu, point to Locking, and then choose Unlock All.
Objects can only be unlocked collectively; you cannot unlock individual objects.

To delete an object
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1. Select the object to delete.

2. Drag the object to the trash can, .
To reorder objects
1. Select the object to reorder.
2. Choose Order from the Format menu.
3. Choose how to order the object.

Option Action

Front Brings the selected object to the front of the order.

Back Sends the selected object to the back of the order.

Forward Steps the object forward in the order, by one.

Backward Steps the object backward in the order, by one.

To group objects
1. Select the objects to group.
2. From the Format menu, point to Grouping, and then choose Group.
To ungroup objects
1. Select the objects to ungroup.
2. From the Format menu, point to Grouping, and then choose Ungroup.
To edit object properties
1. Select the object to edit.
2. To adjust the line or outline width, drag the Thickness slider.
3. To adjust the color, select the Outline Color box or the Fill Color box, and then do one

of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

4. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
5. To adjust the transparency, click the Transparency button, , and then choose a

transparency percentage.
To change the fill color of an object
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1. From MimioStudio Tools, click the Object Fill button, .
2. Do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
3. Click the object to change the fill color for.

To change the fill color for an object that currently has no fill color, click the object
border.

To edit text
1. Double-click the text box.
2. Select the text to adjust, or enter new text.
3. Adjust the font style, size, color, or alignment.
To import an object from another Notebook page
1. Select the object to import from the source Notebook page.
2. Click the Copy button, .
3. Navigate to the target Notebook page.
4. Click the Paste button, .

You can also import an object by dragging the object from the source page to the target
page.

To convert ink to text
1. Select the objects to convert.

All selected objects are combined into one text object.
2. Do one of the following:

l Right-click, and then choose Recognize Text.

l Choose Recognize Text from the Tools menu.
To convert ink to shapes
1. Select the objects to convert.
2. Do one of the following:

l Right-click, and then choose Recognize Shapes.

l Choose Recognize Shapes.from the Tools menu.
To snap objects to grid
1. Choose Grid from the View menu.

The Grid dialog box appears.
2. To force objects to snap to grid, select the Snap objects to grid check box.
3. To allow objects to snap to angles, select the Snap objects to angles check box.
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4. To adjust the spacing between grid snap locations, enter the desired value into the
Spacing box.

5. To display a grid on the screen, select the Display grid on screen check box.
6. To make the grid settings permanent for each new MimioStudio Notebook, select the

Set as default for all new documents check box.
7. Click OK.

Adding Actions to Objects
Objects can have actions associated with them. You can associate an action with any object
that you create or import into a MimioStudio Notebook; you cannot add an action to a
template or background.

You can choose to perform the associated action each time you click the object or each time
you drag the object.

You can associate two different actions with a single object. For example, you can
choose to launch a hyperlink when you click an object and clone the object when you
drag the object. However, you cannot associate two different hyperlinks or two different
sounds with the same object.

There are three types of actions that you can associate with objects:

n Launch Hyperlink - opens a file, a web page, or a different page within a Notebook.
n Clone - creates a copy of the object on the Notebook page.
n Play Sound - plays a sound file.
To add a hyperlink to an object
1. Select the object to add the hyperlink to.
2. Choose Hyperlink from the Insert menu.

The Action Settings dialog box appears.
3. Select one of the following from the Action list:

l On Click - to launch the hyperlink each time the object is clicked.
l On Drag - to launch the hyperlink each time the object is dragged.

4. Select Launch Hyperlink from the Feature list.
5. Select Existing file or Web Page from the Link To list.

Alternately, select a page from within the current Notebook from the Link To list.
6. Enter a file name or web address to link to in the Address box.

Alternately, click Browse to search for a file to link to.
7. Click OK to add the hyperlink to the object.
To add cloning to an object
1. Select the object to add the clone action to.
2. Choose Action Settings from the Insert menu.

The Action Settings dialog box appears.
3. Select one of the following from the Action list:

l On Click - to create a copy of the object each time the object is clicked
l On Drag - to create a copy of the object each time the object is dragged
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4. Select Clone from the Feature list, and then click OK.
You can also add the clone action to an object by choosing Clone from the Insert
menu. By default, a copy of the object is created whenever you drag the object.

To add a sound to an object
1. Select the object to link the sound file to.
2. Choose Action Settings from the Insert menu.

The Action Settings dialog box appears.
3. Select one of the following from the Action list:

l On Click - to play the sound file each time the object is clicked
l On Drag - to play the sound file each time the object is dragged

4. Select Play Sound from the Feature list.
5. Click Load.

The Open dialog box appears.
6. Navigate to and select the sound file to link to the object, and then click Open.
7. Click OK in the Action Settings dialog box.
To remove an action from an object
1. Select the object with the action to remove.
2. Choose Action Settings from the Insert menu.

The Action Settings dialog box appears.
3. Choose None from the Feature list, and then click OK.

Adding Animations to Objects
Objects can have animations associated with them. You can associate an animation with
any object that you create or import into a MimioStudio Notebook; you cannot add an
animation to a template or background.

You can choose to perform the associated animation each time you click the object or each
time the page containing the object is displayed.

To add an animation to an object
1. Select the object to add the animation to.
2. Choose Animate from the Insert menu.

The Animation Settings dialog box appears.
3. Select the desired animation from the Animations list.
4. Select one of the following from the Start list:

l When the object is clicked - to start the animation when the object is clicked.
l When the page is entered - to start the animation each time the page containing the
object is displayed.

5. If available, select one of the following from the Triggers list:
l Default
l Results
l Notes

6. Click OK to close the dialog box and save your settings.
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To remove an animation from an object
1. Select the object with the animation to remove.
2. Choose Animate from the Insert menu.

The Animation Settings dialog box appears.
3. Select None from the Animations list, and then click OK.

Using MimioStudio Gallery
MimioStudio Gallery consists of the following four main folders:
n Screen Annotations - contains all saved Screen Annotation snapshots.
n Imported Content Packs - contains any imported content that you have not yet added

to the Gallery folder.
n Questions and Results - contains a variety of objects for use with MimioVote.
n Gallery - contains a number of different folders used to categorize items, such as

Geography, Mathematics, and so on.
n Collaborative Sessions - contains all saved Collaborate pages.

The Gallery folder and each of the Gallery subfolders can contain five different types of
objects:

n Images - Images include pictures and graphics.
n Templates - Templates include backgrounds and predefined page layouts.
n Multimedia - Multimedia objects include movies, animation, and sound.
n Questions and Results - Questions and Results include objects for creating and

displaying the results of MimioVote activities.
This section of the Gallery does not appear until you move objects from the
Questions and Results folder to the Gallery folder or a Gallery subfolder.

n Lessons - Lessons include lessons created using MimioStudio Notebook and imported
documents. You can create your own lessons or import lessons created by someone else.

See Accessing MimioStudio Gallery for information on accessing MimioStudio Gallery.
To navigate MimioStudio Gallery

Click any folder to view the available items in that folder.
Click the arrow next to a Gallery folder to see any subfolders that are contained in that
Gallery folder.

To select a Gallery item
1. Navigate to the Gallery folder that contains the item you want to select.
2. Do one of the following:

l Click the Gallery item to select.
l To select multiple items, press CTRL and select each item.
l To select multiple items that are close to each other, drag a selection rectangle over
the items to select.

l To select a range of items, select the first item, and then press SHIFT and select
the last item.

l To select all items, right-click, and then choose Select All.
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Importing Gallery Items into a Notebook
You can import any Gallery item into a MimioStudio Notebook to add to your presentation.

To import a Gallery item into a Notebook
1. Select the image, template, multimedia item, questions and results object, or lesson to

import.
2. Drag the item into the Notebook.

You can also import items by double-clicking or by copying and pasting the items into
a Notebook.

Customizing the Content of the Gallery
The MimioStudio Gallery is fully expandable and modifiable, so you can add your own
folders, pictures, templates, multimedia items, and lessons.

MimioStudio does not support network or shared galleries.

To import a Gallery folder from a Gallery file
1. Click the Import Content Pack button, .
2. From the Open dialog box, navigate to and select the Gallery file to import.
3. Click Open.

The contents of the Gallery file are added to the Imported Content Packs folder in
MimioStudio Gallery.

4. Review the imported content and make any desired changes.
5. To move the content to the Gallery folder, right-click the folder to move and then

choose Install.
The content is moved to the Gallery folder.

To add a new Gallery folder
1. Select the main Gallery folder or a Gallery subfolder to add the new folder to.
2. Click the New Folder button, .

The Gallery Item Properties dialog box appears.
3. Enter a name for the new folder in the Name box.
4. (Optional) Enter a keyword in the Keywords box to make the new folder searchable

from the Gallery search bar.
5. Click OK.
To add a new item to a folder
1. Select the folder to add the item to.
2. Click the Insert File button, .
3. From the Open dialog box, navigate to and select the file to import.
4. Click Open.

The item is inserted in the appropriate area of the Gallery folder.
You can also add new items by selecting one or more items, and then dragging and
dropping or copying and pasting them into a Gallery folder.

To create a template from a Notebook image
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1. Right-click and drag the image into the Gallery.
The right-click menu appears.

2. Choose Insert as template.
To copy an existing Gallery item
1. Select the Gallery item to copy.
2. Click the Copy button, .
3. Select a Gallery folder to insert the new item into.
4. Click the Paste button, .

The item is inserted in the appropriate area of the Gallery folder.
To delete a Gallery item
1. Select the Gallery item to delete.
2. Click the Delete button, .

A delete confirmation dialog box appears.
3. Click Yes.
To find similar Gallery items
1. Right-click the Gallery item, and then choose Open Folder.
2. If the item is contained in more than one folder, choose the folder to open.

The folder containing the selected item opens in MimioStudio Gallery.

Exporting a Gallery Folder to a Gallery File
Entire Gallery folders can be exported and imported into the MimioStudio Gallery as
Gallery (MCF) files. You can then share Galleries that you have created with other
MimioStudio users.

MimioStudio does not support network or shared galleries.

To export a Gallery folder to a Gallery file
1. Select the Gallery folder to export.
2. Click the Export Content Pack button, .
3. From the Save As dialog box, enter a name for the file in the File Name box.
4. Select a location to save the file to.
5. Click Save.

Working with Saved Annotation Snapshots
MimioStudio automatically saves a snapshot of the annotated screen each time you exit
Screen Annotation mode. These snapshots are saved in the Screen Annotations folder in
MimioStudio Gallery.

For information about creating Screen Annotation snapshots, see Marking Up the Display
Using Screen Annotations.
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Viewing Screen Annotation Snapshots
You can view your saved screen annotations from the Screen Annotations folder in
MimioStudio Gallery.

To view Screen Annotation snapshots
1. Start MimioStudio Gallery.
2. Select the Screen Annotations folder.
To select a snapshot

Do one of the following:
l Click on the snapshot to select.
l To select multiple snapshots, press CTRL and select each snapshot.
l To select multiple snapshots that are close to each other, drag a selection rectangle
over the snapshots.

l To select a range of snapshots, select the first snapshot and then press SHIFT and
select the last snapshot.

l To select all snapshots, right-click, and then choose Select All.

Renaming an Annotation Snapshot
Screen Annotation snapshots are saved in chronological order, using the date and time that
the snapshot was created as the name of the snapshot. You can rename a snapshot any time
after it has been saved.

To rename a snapshot
1. Select the snapshot to rename.
2. Right-click and choose Properties.
3. Enter a name for the snapshot in the Name box and click OK.

Adding Keywords to an Annotation Snapshot
You can add keywords to any snapshot so that you can use the search bar in MimioStudio
Gallery to find that snapshot later.

To add keywords to a snapshot
1. Select the snapshot to add keywords to.
2. Right-click and choose Properties.
3. Enter each keyword on a separate line in the Keywords box and click OK.

Searching for an Annotation Snapshot
You can search for a specific snapshot using the search bar in MimioStudio Gallery. You
can search for a snapshot using a keyword or part of the snapshot name.

To search for a specific snapshot
1. Select the Screen Annotations folder in the Gallery.
2. Enter text to search for in the Search box.

All snapshots associated with the text appear in the preview area of the Gallery.
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Importing an Annotation Snapshot
You can import a snapshot into an open Notebook.

To import a snapshot
1. Open a MimioStudio Notebook.
2. Select the snapshot to import.
3. Drag the selected snapshot into the target Notebook.

Pasting an Annotation Snapshot Into Another Application
Annotation snapshots can be used in other applications such as Microsoft Word or
PowerPoint.

To paste a snapshot into another application
1. Select the snapshot to copy.
2. Click the Copy button, .
3. Navigate to the target application.
4. Right-click, and then choose Paste.

Alternatively, you can drag the selected snapshot into the target application.

Printing Annotation Snapshots
You can print a snapshot directly from the Screen Annotations folder in MimioStudio
Gallery.

To print a snapshot
1. Select the snapshot to print.
2. Right-click and choose Print.

Deleting Annotation Snapshots
You can delete snapshots from the Screen Annotations folder.

To delete a snapshot
1. Select the snapshot to delete.
2. Click the Delete button, .

A delete confirmation dialog box appears.
3. Click Yes.

Delivering Interactive Notebook Lessons and Presentations
MimioStudio Notebook can be used to deliver lessons and presentations that were created
in or imported into a MimioStudio Notebook.

Using Fullscreen View
For presenting information, the Fullscreen view can be used to fill the entire screen with the
current page.
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The MimioStudio Notebook standard toolbar and all MimioStudio Tools are available in
Fullscreen view.

To access the Fullscreen view

Click the Fullscreen button, .

The current page fills the entire screen and the MimioStudio Notebook standard toolbar
remains visible.

Navigating Through a Presentation
To navigate through a Notebook presentation

Use the MimioStudio Notebook standard toolbar to navigate through the Notebook
presentation.

Button Action

Use this button to enter or exit the Fullscreen view.

Use this button to insert a new page

Use this button to return to the previous page in the Notebook.

Use this button to advance to the next page in the Notebook.

Working with Multimedia Objects
You can play, pause, fast forward, and rewind movie, animation, and sound objects you
added to your presentation.

To play video or audio
Click anywhere on the movie, animation, or sound object to play.

To show and hide the video and audio controls
1. While the video or audio is playing, click once anywhere on the object to view the

object controls.

2. Click the object again to hide the controls.
To pause, fast forward, or rewind video or audio

Do one of the following:

l To pause the video or audio, click .

l To fast forward the video or audio, drag the slider to the right.
l To rewind the video or audio, drag the slider to the left.
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MimioTeach
Using MimioTeach with a projector, you can deliver lessons and presentations directly from
your whiteboard. Using MimioStudio Interactive mode, you control the movement of the
cursor on your screen with the MimioTeach stylus, much like you would with a mouse at
your computer.

What's Included
The MimioTeach package contains the following items:

1 MimioTeach bar 4 USB cable

2 USB power adapter 5 Mounting plates

3 MimioHub 6 MimioTeach stylus

If you are missing any of the items above, contact Customer Support.

About MimioTeach
You can use the MimioTeach bar and stylus in MimioStudio Interactive mode to deliver
lessons and presentations.

You can also use the MimioTeach bar with MimioCapture to capture notes from your
whiteboard into MimioStudio Notebook. For more information about using MimioTeach
with MimioCapture, see MimioCapture.
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The following figure shows the major components of the MimioTeach.

1 Start Tools (button B) 5 USB/Power connector

2 Hover/Right-click (button A) 6 Launch

3 MimioHub dock 7 Calibrate

4 Power/Status light

Status Lights
The status light visually shows the status of the MimioTeach bar.

Off Not receiving power; USB/power cable is not connected or MimioTeach is turned
off.

Solid Green MimioTeach is connected and receiving power; MimioStudio software is running.

Flashing Green
MimioTeach is connected or connecting, and receiving power; MimioStudio
software is not running.

Solid Amber MimioTeach cannot find an available MimioHub.

Flashing Amber MimioTeach is searching for an available MimioHub.
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About MimioStudio Tools
With the various presentation tools found in MimioStudio Tools you can focus your
audience on a specific area of the screen by displaying only certain parts of the screen. You
can also annotate the screen with the drawing tools available in MimioStudio Tools using
the Screen Annotation feature.

For more information about MimioStudio Tools, see Marking Up the Display Using Screen
Annotations.
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The following table describes the major components of MimioStudio Tools.

Selection tool Zoom

Pen Brush

Text Highlighter

Line Arrow End

Arrow Start Arrow Both

Rectangle Ellipse

Triangle Right Triangle

Five Pointed Star Hexagon

Pentagon Shape Recognition

Eraser Insert file

Screen clipping Color picker

More colors Object Fill

Outline and Fill color Thickness slider

Color palette Solid Line

Dash Line Square Dot Line

Transparency Gallery

Applications (see below) Right-click

Interactive Mouse

Screen Annotation

From the Applications tool, you can access the following:
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Reveal
Spotlight

Text Tools

Class Manager
Control
 Quick Collaborate

Quick Vote

View

Calculator
Web Browser

Getting Started
Review the following topics to install and start using your MimioTeach.

n Setting Up the MimioTeach Stylus
n Setting Up the MimioTeach Bar
n Setting Up Interactive Mode

Setting Up the MimioTeach Stylus
The MimioTeach stylus is powered by a rechargeable lithium-ion battery. The battery
recharges whenever the stylus is docked on the MimioTeach bar.

To set up the MimioTeach stylus
1. Turn the top of the stylus counter-clockwise to separate the top from the body of the

stylus.

2. Remove the plastic strip from the stylus.

3. Replace the top onto the body of the stylus and turn clockwise to attach.
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Setting Up the MimioTeach Bar
The MimioTeach bar comes pre-linked to the included MimioHub. You can also use this
MimioHub to connect other MimioClassroom devices to your computer, such as
MimioVote.

When not in use, the MimioHub can be stored in the MimioHub dock on the back of
the MimioTeach bar.

MimioTeach is powered using the included USB cable and power adapter.

Optionally, MimioTeach can be powered using three AAA batteries. For information
about using batteries to power the MimioTeach bar, see Inserting the Batteries.

To set up the MimioTeach bar
1. Plug the USB cable into the USB port on the power adapter.

2. Plug the other end of the USB cable into the USB port on the MimioTeach bar.

3. Plug the power adapter into a power outlet.

4. Place the MimioTeach bar along the left edge of the whiteboard as shown.

40



Getting Started

The MimioTeach bar attaches securely to any magnetic whiteboard. See Mounting
MimioTeach to a Non-Magnetic Whiteboard for information about mounting the bar to
a non-magnetic whiteboard.

5. Plug the MimioHub into an available USB port on your computer.

If you do not want to connect the MimioTeach bar to your computer wirelessly, you
can link the bar to your computer using the included USB cable without the power
adapter. The bar will be powered by USB through your computer.

Setting Up Interactive Mode
Using MimioStudio Interactive mode, you can deliver lessons and presentations directly
from your whiteboard.

To use Interactive mode you need a projector, a MimioTeach-enabled whiteboard, and a
MimioTeach stylus. Combined, these devices make for a powerful tool for delivering lessons
and presentations.

Projecting Your Desktop
If you are presenting from a MimioStudio Notebook or another application, such as a
PowerPoint presentation, you can open the application before or after Interactive mode is
enabled and calibrated.

To start Interactive mode
1. Project your desktop image onto your whiteboard.

Refer to your projector’s documentation for instructions on how to project your desktop
image.

2. Adjust the projected image to have a 2-inch to 3-inch buffer between the edge of your
projection and your MimioTeach.
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3. Click the MimioTeach stylus anywhere on the whiteboard.
Interactive mode starts and the calibration screen appears.

To exit Interactive mode
Do one of the following:
l Press the Interactive button, , twice on the MimioTeach bar.

l Start MimioStudio Tools, click Interactive , and then click Exit.

l Start MimioStudio Settings, select Interactive, and then click Disable.
See Customizing MimioStudio for information on how to access MimioStudio
Settings.

Calibrating Interactive Mode
Each time Interactive mode is enabled, you are prompted to calibrate using the MimioTeach
stylus.

When using a permanently installed whiteboard and projector, you do not need to
recalibrate Interactive mode after the first session. See Adjusting the Interactive Settings.

To calibrate Interactive mode
1. If the calibration screen does not appear when you start Interactive mode, do one of the

following:
l Press the Interactive button, , on your MimioTeach bar.

l Start MimioStudio Tools, click the Interactive button, , and then click
Recalibrate.

l Start MimioStudio Settings, select Interactive, and then click Calibrate.
2. Press the MimioTeach stylus down on the whiteboard at the center of each of the nine

calibration targets.
Make sure to hold the stylus perpendicular to the writing surface as you click.
The calibration target disappears and the next calibration target appears.
When the calibration screen disappears, Interactive mode is enabled.

Using MimioTeach
You can use the MimioTeach bar and stylus in MimioStudio Interactive mode to deliver
lessons and presentations. In MimioStudio Interactive mode, you control the movement of
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the cursor on your screen with the MimioTeach stylus, much like you would with a mouse
at your computer.

You can also use the various presentation tools found in MimioStudio Tools to focus your
audience on a specific area of the screen by displaying only certain parts of the screen. And,
you can annotate the screen with the drawing tools available in MimioStudio Tools using
the Screen Annotation feature.

Using the MimioTeach Stylus
In Interactive mode, the MimioTeach stylus can be used to control your desktop and interact
with applications on your computer from your whiteboard.

The following table describes how to use the MimioTeach stylus to control your desktop
from the whiteboard.

To execute Do this

Left mouse click Click in the projected area at the desired location with the tip of the stylus.

Double left mouse
click

Quickly click twice in the projected area at the desired location with the tip of
the stylus.

Right mouse click
Press the B button on the stylus, and then click in the projected area at the
desired location with the tip of the stylus.

Hover

1. Hold the stylus at the desired location, staying as close to the
whiteboard as possible without touching it.

2. Press the B button on the stylus.
3. Move the stylus to the desired location.
4. Release the B button on the stylus.

To change the functions of the MimioTeach stylus buttons, see Adjusting the Interactive
Settings.

Focusing Attention Using the Reveal and Spotlight Tools
The Reveal tool and the Spotlight tool help you to focus your audience on a specific area of
the screen by keeping parts of the screen hidden.

Using the Reveal Tool
The Reveal tool creates a shade that you can raise, lower, move left, and move right over
the screen image, as if you are moving a shade up, down, or across the screen. You can then
expose bullet points or other information progressively.
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To use the Reveal tool
Do one of the following:
l From MimioStudio Tools, click the Applications button, , and then choose

Reveal.
l (Interactive mode only) Press the Launch button, , on the MimioTeach bar, and

then click Reveal in the Launch window.

To adjust the revealed area
Click inside the shaded area and drag down, up, left, or right to reveal more or less of
the displayed area.

To adjust the transparency of the Reveal tool
1. Click , and then point to Transparent.
2. From the Transparent list, choose a percentage.

A transparency of 0% means that the shaded area will be completely opaque.

Using the Spotlight Tool
The Spotlight tool masks the entire screen except for a small area, the spotlight. You can
then focus audience attention on a specific area of the screen. The spotlight area can be
reshaped, resized, and moved around the screen.
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To use the Spotlight tool
1. Do one of the following:

l From MimioStudio Tools, click the Applications button, , and then choose
Spotlight.

l (Interactive mode only) Press the Launch button, , on the MimioTeach bar, and
then click Spotlight in the Launch window.

2. Click the shaded area outside of the spotlight border and drag the spotlight to
the desired location.

To adjust the shape of the spotlight
1. Click , and then point to Shape.
2. From the Shape list, choose a shape for the spotlight.
To resize the spotlight
1. Click , and then point to Size.
2. From the Size list, choose a spotlight size.

You can also resize the spotlight by dragging the colored border of the spotlight until
the spotlight is the desired size.

To adjust the spotlight transparency
1. Click , and then point to Transparent.
2. From the Transparent list, choose a transparency percentage.

A transparency of 0% means that the shaded area will be completely opaque.

Marking Up the Display Using Screen Annotations
Screen Annotation mode allows you to annotate applications, web pages, and images. When
in Annotation mode, a green border with a faded edge appears around your desktop.

When you exit from Screen Annotation mode, all annotations are cleared from the
whiteboard and automatically archived in the Screen Annotations folder in MimioStudio
Gallery.

Enabling Screen Annotation Mode
To enable Screen Annotation mode
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1. Do one of the following
l From MimioStudio Tools, click the Screen Annotation button, , to freeze your
current desktop image.

l (Interactive mode Only) Press the Launch button, , on the MimioTeach bar, and
then click Screen Annotation in the Launch window.

A green border with a faded edge appears around your desktop.
2. Annotate the screen using MimioStudio Tools.

All object, drawing, and manipulation features in MimioStudio Tools are available in
Screen Annotation mode.

To exit Screen Annotation mode
Do one of the following:

l From MimioStudio Tools, click the Mouse button, , to “unfreeze” the screen.

l (Interactive mode only) Press the Launch button, , on the MimioTeach bar, and
then click Screen Annotation in the Launch window.

To disable the Annotation mode border
1. Right-click  in the notification area and choose Settings.

2. Select Notebook from the MimioStudio Settings dialog box.
3. Under General, clear the Enable fullscreen border (Screen Annotation only) check

box.
4. Click OK to save the settings.

Annotating the Screen Using MimioStudio Tools
MimioStudio Tools are used to annotate the screen. All object, drawing, and manipulation
features in MimioStudio Tools are available in Screen Annotation mode.

Once you select a drawing tool, that tool remains selected until you select a different
drawing tool or the selection tool.

See Manipulating Objects for a complete description of manipulating objects.

All of the functions and features of the MimioStudio drawing tools that are available in
MimioStudio Notebook are available in Screen Annotation mode.

To use the freehand pen

1. Click the Pen button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
3. (Optional) To adjust the line color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
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5. Place the cursor where you want the ink stroke to start on the page.
6. Drag the cursor to draw ink strokes.
To use the freehand brush

1. Click the Brush button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
3. (Optional) To adjust the line color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
5. Place the cursor where you want the brush stroke to start on the page.
6. Drag the cursor to draw brush strokes.
To highlight a portion of the display
1. Click the Highlighter button, .
2. (Optional) To adjust the highlighter width, drag the Thickness slider.
3. (Optional) To change the color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. Place the cursor where you want the highlight stroke to start on the page.
5. Drag the cursor over the area you want to highlight.
To erase ink and highlighting

1. Click the Eraser button, .
2. (Optional) To adjust the eraser width, drag the Thickness slider.
3. Drag the cursor over the ink or highlighter strokes you want to erase.
To add a line or shape
1. Click the line type or shape you want to add.
2. (Optional) To adjust the line or outline width, drag the Thickness slider.
3. (Optional) To change the line or outline color, select the Outline Color box, and then

do one of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
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4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the
following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the line or shape, click the Transparency

button, , and then choose a transparency percentage.
7. Place the cursor where you want the line or shape to start on the page.
8. Drag the cursor to draw the line or shape.
To add formatted text
1. Click the Text button, .
2. Place the cursor where you want the text to start on the page.

For a fixed width text box, place the cursor where you want the text box to start on the
page and then drag to the desired width.

3. Select a font style, size, color, and an alignment option for the text.
4. Enter text in the text box.
To draw a shape

1. Click the Shape Recognition button, .
2. (Optional) To adjust the outline width, drag the Thickness slider.
3. (Optional) To change the outline color, select the Outline Color box, and then do one

of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the

following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
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5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the shape, click the Transparency button, ,

and then choose a transparency percentage.
7. Place the cursor where you want the shape to start on the page.
8. Drag the cursor to draw the shape.

The Shape Recognition tool can be used to draw circles, ellipses, triangles, rectangles,
squares, and lines.

Clearing All Annotations from the Display
When you exit Screen Annotation mode, all annotations are cleared from the display and all
annotations are automatically preserved as a snapshot of the display. See Working with
Saved Annotation Snapshots for information about reviewing and using the snapshots.

Inserting Text Into an Application Using MimioStudio Text Tools
You can enter text into any text-entry box or page using the MimioStudio Text Tools. The
Text Tool has two modes for entering text:

n On-Screen Keyboard allows you to enter text through an on-screen keyboard
application.
On-Screen Keyboard is only available if you have one of the following keyboard
applications installed: xvkbd, OnBoard, or GOK.

n Writing Pad allows you to enter text through a small on-screen writing pad. Your
handwriting is automatically converted into text and input into the current application.

In addition, Writing Pad also supports gesture recognition, which allows handwritten
shortcuts to be automatically recognized as commonly used keys.

To access MimioStudio Text Tools

1. From MimioStudio Tools, click the Applications button, , and then choose Text
Tools.

2. Right-click the Text Tools icon  or  in the notification area.
3. Choose the Text Tool that you want to use.

l Keyboard to enable the On-Screen Keyboard.
l Writing Pad to enable Writing Pad.

To disable MimioStudio Text Tools
Do one of the following:
l Click the Text Tools icon  or  in the notification area.

l From MimioStudio Tools, click the Applications button, , and then choose
Text Tools.
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Using the On-Screen Keyboard
You can enter text into any application using the On-Screen Keyboard.

On-Screen Keyboard is only available if you have one of the following keyboard
applications installed: xvkbd, OnBoard, or GOK.

To use the On-Screen Keyboard
1. Start the On-Screen Keyboard.
2. Click in the text-entry box or on the page where you want to enter the text.
3. Using your mouse or MimioTeach stylus, press the virtual keys on the on-screen

keyboard.
The text is entered into the text-entry box or on the page that you selected.

Using Writing Pad
With Writing Pad you can enter text through a small on-screen writing pad using the
MimioTeach stylus while in Interactive mode. You can also use Writing Pad with your
mouse or other input device from your computer.

To use Writing Pad
1. Start Writing Pad.

The on-screen writing pad appears.
2. Click in the text-entry box or on the page where you want to enter the text.
3. Using your mouse or MimioTeach stylus, write within the yellow space of the on-

screen writing pad.
Your handwriting is automatically converted to text and entered into the text-
entry box or on the page that you selected.

4. Use the on-screen buttons for commonly used keys.

Button Description

Backspace

Enter

Tab

Space

Writing Pad also supports gesture recognition for commonly used keys. See Using Gesture
Recognition.

Using Gesture Recognition
With gesture recognition, handwritten shortcuts are automatically recognized as commonly
used keys. Writing Pad supports gesture recognition.

The following table describes how to use gestures to perform common functions.
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To press Do this

Backspace Draw a line from right to left.

Enter Draw a connected line from top to bottom

and then from right to left.

Tab
Draw a connected line from bottom to top

and then from left to right.

Space bar
Draw a connected line from top to bottom

and then from left to right.

Using the Web Browser and Calculator Tools
MimioStudio Tools includes shortcuts for accessing a Web browser and a calculator.

To use the tools
1. Start MimioStudio Tools.
2. Click the Applications button, , choose More Tools, and then choose one of the

following tools:
l  Calculator
l  Web Browser

Caring for MimioTeach
Review the following topics for information about cleaning, inserting the batteries, and
permanently mounting your MimioTeach.

n Cleaning MimioTeach
n Inserting the Batteries
n Mounting MimioTeach to a Non-Magnetic Whiteboard

Cleaning MimioTeach
MimioTeach is designed to give you long and trouble-free service while requiring very little
maintenance.

You can easily clean your MimioTeach using the following items:
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n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the MimioTeach bar and stylus
1. Disconnect the USB cable from the MimioTeach bar.
2. Use the lint-free cloth to wipe the exterior of the MimioTeach bar and stylus.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Avoid using liquids on any exposed charging contacts. Do not allow liquid into
any openings on the equipment.

4. Reconnect the USB cable.

Inserting the Batteries
MimioTeach is powered using the included USB cable and power adapter. Optionally,
MimioTeach can be powered using three AAA batteries.

To insert the batteries
1. Press down and slide off the battery compartment cover.
2. Insert three AAA batteries into the battery compartment.
3. Replace the battery compartment cover.

Remove the batteries if the MimioTeach bar will not be used for a long period of time.

Mounting MimioTeach to a Non-Magnetic Whiteboard
The MimioTeach bar attaches securely to any magnetic whiteboard. If you do not have a
magnetic whiteboard, you can mount the MimioTeach bar to your whiteboard using the
included metal plates.

If you are installing both MimioTeach and MimioCapture, you must mount
MimioCapture before mounting MimioTeach. This will ensure proper placement of the
MimioTeach bar. See Mounting MimioCapture to a Non-Magnetic Whiteboard for
information on mounting MimioCapture.

To mount MimioTeach to a non-magnetic whiteboard
1. Place the metal plates against the back of the MimioTeach bar as shown.

Make sure that the recess on each plate is inserted into the recess on the back of the
MimioTeach bar.

2. Remove the paper backing from the adhesive strips to expose the adhesive.
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3. Press the MimioTeach bar firmly along the left edge of the whiteboard as shown.
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Mimio Interactive
Using Mimio Interactive with a projector, you can deliver lessons and presentations directly
from your whiteboard. Using MimioStudio Interactive mode, you control the movement of
the cursor on your screen with the Mimio Interactive Mouse, much like you would with a
mouse at your computer.

What's Included
The Mimio Interactive package contains the following items:

1 Mimio Interactive bar 4 Mimio mouse

2 Mounting brackets 5 AA battery

3 USB cable

If you are missing any of the items above, contact Customer Support.
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Mimio Interactive

About Mimio Interactive
You can use the Mimio Interactive bar and mouse in MimioStudio Interactive mode to
deliver lessons and presentations.

You can also use the Mimio Interactive bar with Mimio Capture Kit to capture notes from
your whiteboard into MimioStudio Notebook. For more information about using Mimio
Interactive with Mimio Capture Kit, see Mimio Capture Kit.

The following figure shows the major components of Mimio Interactive.

1 A button (right-click) 7 Print page (Spotlight tool)

2 B button (hover) 8 Resize window (Reveal tool)

3 Power button/status light 9 Interactive

4 Learning button 10 Data transmission status light

5 New page (MimioStudio Tools) 11 Memory status light

6 Copy page (Annotation mode)
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Status Lights
The status lights visually show the status of the Mimio Interactive bar.

Power Status Lights

Off Not receiving power; USB/power cable is not connected, batteries need replaced,
or Mimio Interactive is turned off.

Solid Green Mimio Interactive is receiving power.

Solid Amber Mimio Interactive is receiving power; one to five hours of battery life remaining.

Flashing Amber Mimio Interactive is receiving power; less than one hour of battery life remaining.

Data Transmission Status Lights

Off Mimio Capture Kit pen or Mimio Interactive mouse is not in use.

Solid Green Mimio Capture Kit pen or Mimio Interactive mouse is in use.

Solid Amber Mimio Capture Kit pen or Mimio Interactive mouse battery is low.

Memory Status Lights

Off Mimio Interactive bar memory is empty.

Flashing Green Data is being downloaded from the Mimio Interactive bar to your computer.

Solid Green Mimio Interactive bar memory is less than 80% full.

Solid Amber Mimio Interactive bar memory is between 80% and 90% full.

Flashing Amber Mimio Interactive bar memory is over 90% full.

About Mimio Wireless
You can use the Mimio Wireless module and wireless receiver to connect the Mimio
Interactive bar wirelessly to your computer.

The following figure shows the major components of Mimio Wireless.
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1 Power button/status light 6 Resize window (Reveal tool)

2 Learning button 7 Interactive

3 New page (MimioStudio Tools) 8 Link status light

4 Copy page (Annotation mode) 9 Data transmission status light

5 Print page (Spotlight tool)

Status Lights
The status lights visually show the status of the Mimio Interactive bar.

Power Status Lights

Off Not receiving power; USB/power cable is not connected, batteries need
replaced, or Mimio Interactive is turned off.

Solid Green Mimio Interactive is receiving power.

Solid Amber
Mimio Interactive is receiving power; one to five hours of battery life
remaining.

Flashing Amber
Mimio Interactive is receiving power; less than one hour of battery life
remaining.

Link Status Lights

Solid Green Mimio Interactive is connected to the wireless receiver.

Flashing Green Mimio Interactive is establishing a connection to the wireless receiver.
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Solid Amber Mimio Interactive cannot find an available wireless receiver.

Data Transmission Status Lights

Flashing Green
(slowly)

Mimio Capture Kit pen or Mimio Interactive mouse is not in use.

Flashing Green
(quickly)

Mimio Capture Kit pen or Mimio Interactive mouse is in use.

Solid Amber Mimio Capture Kit pen or Mimio Interactive mouse battery is low.

About MimioStudio Tools
With the various presentation tools found in MimioStudio Tools you can focus your
audience on a specific area of the screen by displaying only certain parts of the screen. You
can also annotate the screen with the drawing tools available in MimioStudio Tools using
the Screen Annotation feature.

For more information about MimioStudio Tools, see Marking Up the Display Using Screen
Annotations.
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The following table describes the major components of MimioStudio Tools.

Selection tool Zoom

Pen Brush

Text Highlighter

Line Arrow End

Arrow Start Arrow Both

Rectangle Ellipse

Triangle Right Triangle

Five Pointed Star Hexagon

Pentagon Shape Recognition

Eraser Insert file

Screen clipping Color picker

More colors Object Fill

Outline and Fill color Thickness slider

Color palette Solid Line

Dash Line Square Dot Line

Transparency Gallery

Applications (see below) Right-click

Interactive Mouse

Screen Annotation

From the Applications tool, you can access the following:
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Reveal
Spotlight

Text Tools

Class Manager
Control
 Quick Collaborate

Quick Vote

View

Calculator
Web Browser

Getting Started
Review the following topics to install and start using your Mimio Interactive.

n Setting Up the Mimio InteractiveMouse
n Setting Up the Mimio Interactive Bar
n Setting Up Mimio Wireless
n Setting Up Interactive Mode

Setting Up the Mimio Interactive Mouse
The Mimio Interactive Mouse is powered by one AA battery.

To set up the Mimio Interactive Mouse
1. Press down and slide off the battery compartment cover.

2. Insert one AA battery into the battery compartment.

3. Replace the battery compartment cover.

Setting Up the Mimio Interactive Bar
Mimio Interactive is powered through your computer using the included USB cable.

Optionally, Mimio Interactive can be powered using four AA batteries. For information
about using batteries to power the Mimio Interactive bar, see Inserting the Batteries.

To set up the Mimio Interactive bar
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1. Unfold the Mimio Interactive bar.

2. Plug the USB cable into the USB port on the Mimio Interactive bar.

3. Plug the other end of the USB cable into an available USB port on your computer.
4. Place the Mimio Interactive bar along the left edge of the whiteboard as shown.
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The Mimio Interactive bar attaches to any whiteboard using the suction cups on the
back of the bar.
If the Mimio Interactive bar will be used for extended periods of time or will be used
repeatedly in any one location, you should mount the bar using the included brackets.
See Mounting the Mimio Capture Kit for information about mounting the bar using the
brackets.

Setting Up Mimio Wireless
The Mimio Wireless module comes pre-linked to the included wireless receiver.

Mimio Interactive bar is powered using the included power adapter.

Optionally, Mimio Interactive can be powered using four AA batteries. For information
about using batteries to power the Mimio Interactive bar, see Inserting the Batteries.

To set up Mimio Wireless
1. Press the release button on the back of the Mimio Interactive bar, and then slide the

linkUSB module down to remove.

2. Slide the Mimio Wireless module onto the Mimio Interactive bar.
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3. Plug the power adapter into the power connector on the bottom of the Mimio
Interactive bar.

4. Plug the other end of the power adapter into a power outlet.
5. Place the Mimio Interactive bar along the left edge of the whiteboard as shown.
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The Mimio Interactive bar attaches to any whiteboard using the suction cups on the
back of the bar.

6. Plug the wireless receiver into an available USB port on your computer.

If the Mimio Interactive bar will be used for extended periods of time or will be
used repeatedly in any one location, you should mount the bar using the included
brackets. See Mounting the Mimio Capture Kit for information about mounting the
bar using the brackets.

Setting Up Interactive Mode
Using MimioStudio Interactive mode, you can deliver lessons and presentations directly
from your whiteboard.

To use Interactive mode you need a projector, a Mimio Interactive-enabled whiteboard, and
a Mimio Interactive Mouse. Combined, these devices make for a powerful tool for
delivering lessons and presentations.
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Projecting Your Desktop
If you are presenting from a MimioStudio Notebook or another application, such as a
PowerPoint presentation, you can open the application before or after Interactive mode is
enabled and calibrated.

To start Interactive mode
1. Project your desktop image onto your whiteboard.

Refer to your projector’s documentation for instructions on how to project your desktop
image.

2. Adjust the projected image to have a 2-inch to 3-inch buffer between the edge of your
projection and your Mimio Interactive.

3. Click the Mimio Interactive Mouse anywhere on the whiteboard.
Interactive mode starts and the calibration screen appears.

To exit Interactive mode
Do one of the following:

l Press the Interactive button, , twice on the Mimio Interactive bar.

l Start MimioStudio Tools, click Interactive , and then click Exit.

l Start MimioStudio Settings, select Interactive, and then click Disable.
See Customizing MimioStudio for information on how to access MimioStudio
Settings.

Calibrating Interactive Mode
Each time Interactive mode is enabled, you are prompted to calibrate using the Mimio
Interactive Mouse.

When using a permanently installed whiteboard and projector, you do not need to
recalibrate Interactive mode after the first session. See Adjusting the Interactive Settings.

To calibrate Interactive mode
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1. If the calibration screen does not appear when you start Interactive mode, do one of the
following:

l Press the Interactive button, , on your Mimio Interactive bar.

l Start MimioStudio Tools, click the Interactive button, , and then click
Recalibrate.

l Start MimioStudio Settings, select Interactive, and then click Calibrate.
2. Press the Mimio Interactive Mouse down on the whiteboard at the center of each of the

nine calibration targets.
Make sure to hold the stylus perpendicular to the writing surface as you click.
The calibration target disappears and the next calibration target appears.
When the calibration screen disappears, Interactive mode is enabled.

Using Mimio Interactive
You can use the Mimio Interactive bar and stylus in MimioStudio Interactive mode to
deliver lessons and presentations. In MimioStudio Interactive mode, you control the
movement of the cursor on your screen with the Mimio Interactive Mouse, much like you
would with a mouse at your computer.

You can also use the various presentation tools found in MimioStudio Tools to focus your
audience on a specific area of the screen by displaying only certain parts of the screen. And,
you can annotate the screen with the drawing tools available in MimioStudio Tools using
the Screen Annotation feature.

Using the Mimio Interactive Mouse
In Interactive mode, the Mimio Interactive Mouse can be used to control your desktop and
interact with applications on your computer from your whiteboard.

The following table describes how to use the Mimio Interactive Mouse to control your
desktop from the whiteboard.

To execute Do this

Left mouse click Click in the projected area at the desired location with the tip of the Mimio
Interactive Mouse.

Double left mouse
click

Quickly click twice in the projected area at the desired location with the tip of
the Mimio Interactive Mouse.

Right mouse click
1. Hold the Mimio Interactive Mouse at the desired location, staying as close to

the whiteboard as possible without touching it.

2. Press the A (concave) button on the Mimio Interactive Mouse.

Hover

1. Hold the Mimio Interactive Mouse at the desired location, staying as
close to the whiteboard as possible without touching it.

2. Press the B (convex) button on the Mimio Interactive Mouse.
3. Move the Mimio Interactive Mouse to the desired location.
4. Release the B button on the Mimio Interactive Mouse.
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To change the functions of the Mimio Interactive Mouse buttons, see Adjusting the
Interactive Settings.

Focusing Attention Using the Reveal and Spotlight Tools
The Reveal tool and the Spotlight tool help you to focus your audience on a specific area of
the screen by keeping parts of the screen hidden.

Using the Reveal Tool
The Reveal tool creates a shade that you can raise, lower, move left, and move right over
the screen image, as if you are moving a shade up, down, or across the screen. You can then
expose bullet points or other information progressively.

To use the Reveal tool
Do one of the following:
l From MimioStudio Tools, click the Applications button, , and then choose

Reveal.

l (Interactive mode only) Press the Resize window button, , on the Mimio
Interactive bar.

To adjust the revealed area
Click inside the shaded area and drag down, up, left, or right to reveal more or less of
the displayed area.

To adjust the transparency of the Reveal tool
1. Click , and then point to Transparent.
2. From the Transparent list, choose a percentage.

A transparency of 0% means that the shaded area will be completely opaque.
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Using the Spotlight Tool
The Spotlight tool masks the entire screen except for a small area, the spotlight. You can
then focus audience attention on a specific area of the screen. The spotlight area can be
reshaped, resized, and moved around the screen.

To use the Spotlight tool
1. Do one of the following:

l From MimioStudio Tools, click the Applications button, , and then choose
Spotlight.

l (Interactive mode only) Press the Print page button, , on the Mimio Interactive
bar.

2. Click the shaded area outside of the spotlight border and drag the spotlight to
the desired location.

To adjust the shape of the spotlight
1. Click , and then point to Shape.
2. From the Shape list, choose a shape for the spotlight.
To resize the spotlight
1. Click , and then point to Size.
2. From the Size list, choose a spotlight size.

You can also resize the spotlight by dragging the colored border of the spotlight until
the spotlight is the desired size.

To adjust the spotlight transparency
1. Click , and then point to Transparent.
2. From the Transparent list, choose a transparency percentage.

A transparency of 0% means that the shaded area will be completely opaque.

Marking Up the Display Using Screen Annotations
Screen Annotation mode allows you to annotate applications, web pages, and images. When
in Annotation mode, a green border with a faded edge appears around your desktop.
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When you exit from Screen Annotation mode, all annotations are cleared from the
whiteboard and automatically archived in the Screen Annotations folder in MimioStudio
Gallery.

Enabling Screen Annotation Mode
To enable Screen Annotation mode
1. Do one of the following

l From MimioStudio Tools, click the Screen Annotation button, , to freeze your
current desktop image.

l (Interactive mode Only) Press the Copy page button, , on the Mimio
Interactive bar.

A green border with a faded edge appears around your desktop.
2. Annotate the screen using MimioStudio Tools.

All object, drawing, and manipulation features in MimioStudio Tools are available in
Screen Annotation mode.

To exit Screen Annotation mode
Do one of the following:

l From MimioStudio Tools, click the Mouse button, , to “unfreeze” the screen.

l (Interactive mode Only) Press the Copy page button, , on the Mimio
Interactive bar.

To disable the Annotation mode border
1. Right-click  in the notification area and choose Settings.

2. Select Notebook from the MimioStudio Settings dialog box.
3. Under General, clear the Enable fullscreen border (Screen Annotation only) check

box.
4. Click OK to save the settings.

Annotating the Screen Using MimioStudio Tools
MimioStudio Tools are used to annotate the screen. All object, drawing, and manipulation
features in MimioStudio Tools are available in Screen Annotation mode.

Once you select a drawing tool, that tool remains selected until you select a different
drawing tool or the selection tool.

See Manipulating Objects for a complete description of manipulating objects.

All of the functions and features of the MimioStudio drawing tools that are available in
MimioStudio Notebook are available in Screen Annotation mode.

To use the freehand pen

1. Click the Pen button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
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3. (Optional) To adjust the line color, do one of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
5. Place the cursor where you want the ink stroke to start on the page.
6. Drag the cursor to draw ink strokes.
To use the freehand brush

1. Click the Brush button, .
2. (Optional) To adjust the line width, drag the Thickness slider.
3. (Optional) To adjust the line color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the transparency of the line, click the Transparency button, ,

and then choose a transparency percentage.
5. Place the cursor where you want the brush stroke to start on the page.
6. Drag the cursor to draw brush strokes.
To highlight a portion of the display
1. Click the Highlighter button, .
2. (Optional) To adjust the highlighter width, drag the Thickness slider.
3. (Optional) To change the color, do one of the following:

l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. Place the cursor where you want the highlight stroke to start on the page.
5. Drag the cursor over the area you want to highlight.
To erase ink and highlighting

1. Click the Eraser button, .
2. (Optional) To adjust the eraser width, drag the Thickness slider.
3. Drag the cursor over the ink or highlighter strokes you want to erase.
To add a line or shape
1. Click the line type or shape you want to add.
2. (Optional) To adjust the line or outline width, drag the Thickness slider.
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3. (Optional) To change the line or outline color, select the Outline Color box, and then
do one of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the

following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the line or shape, click the Transparency

button, , and then choose a transparency percentage.
7. Place the cursor where you want the line or shape to start on the page.
8. Drag the cursor to draw the line or shape.
To add formatted text
1. Click the Text button, .
2. Place the cursor where you want the text to start on the page.

For a fixed width text box, place the cursor where you want the text box to start on the
page and then drag to the desired width.

3. Select a font style, size, color, and an alignment option for the text.
4. Enter text in the text box.
To draw a shape

1. Click the Shape Recognition button, .
2. (Optional) To adjust the outline width, drag the Thickness slider.
3. (Optional) To change the outline color, select the Outline Color box, and then do one

of the following:
l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.
4. (Optional) To adjust the fill color, select the Fill Color box, and then do one of the

following:
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l Select a color from the Color Palette.

l Click , and then select a color from the Color dialog box.

l Click , and then select a color from the desktop.

5. To change the line or outline style, click and choose one of the following:

l Solid

l Dash

l Square Dot
6. (Optional) To adjust the transparency of the shape, click the Transparency button, ,

and then choose a transparency percentage.
7. Place the cursor where you want the shape to start on the page.
8. Drag the cursor to draw the shape.

The Shape Recognition tool can be used to draw circles, ellipses, triangles, rectangles,
squares, and lines.

Clearing All Annotations from the Display
When you exit Screen Annotation mode, all annotations are cleared from the display and all
annotations are automatically preserved as a snapshot of the display. See Working with
Saved Annotation Snapshots for information about reviewing and using the snapshots.

Inserting Text Into an Application Using MimioStudio Text Tools
You can enter text into any text-entry box or page using the MimioStudio Text Tools. The
Text Tool has two modes for entering text:

n On-Screen Keyboard allows you to enter text through an on-screen keyboard
application.
On-Screen Keyboard is only available if you have one of the following keyboard
applications installed: xvkbd, OnBoard, or GOK.

n Writing Pad allows you to enter text through a small on-screen writing pad. Your
handwriting is automatically converted into text and input into the current application.

In addition, Writing Pad also supportsgesture recognition, which allows handwritten
shortcuts to be automatically recognized as commonly used keys.

To access MimioStudio Text Tools

1. From MimioStudio Tools, click the Applications button, , and then choose Text
Tools.

2. Right-click the Text Tools icon  or  in the notification area.
3. Choose the Text Tool that you want to use.

l Keyboard to enable the On-Screen Keyboard.
l Writing Pad to enable Writing Pad.

To disable MimioStudio Text Tools
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Do one of the following:
l Click the Text Tools icon  or  in the notification area.

l From MimioStudio Tools, click the Applications button, , and then choose
Text Tools.

Using the On-Screen Keyboard
You can enter text into any application using the On-Screen Keyboard.

On-Screen Keyboard is only available if you have one of the following keyboard
applications installed: xvkbd, OnBoard, or GOK.

To use the On-Screen Keyboard
1. Start the On-Screen Keyboard.
2. Click in the text-entry box or on the page where you want to enter the text.
3. Using your mouse or Mimio Interactive Mouse, press the virtual keys on the on-screen

keyboard.
The text is entered into the text-entry box or on the page that you selected.

Using Writing Pad
With Writing Pad you can enter text through a small on-screen writing pad using the Mimio
Interactive Mouse while in Interactive mode. You can also use Writing Pad with your
mouse or other input device from your computer.

To use Writing Pad
1. Start Writing Pad.

The on-screen writing pad appears.
2. Click in the text-entry box or on the page where you want to enter the text.
3. Using your mouse or Mimio Interactive Mouse, write within the yellow space of

the on-screen writing pad.
Your handwriting is automatically converted to text and entered into the text-
entry box or on the page that you selected.

4. Use the on-screen buttons for commonly used keys.

Button Description

Backspace

Enter

Tab

Space

Writing Pad also supports gesture recognition for commonly used keys. See Using Gesture
Recognition.
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Using Gesture Recognition
With gesture recognition, handwritten shortcuts are automatically recognized as commonly
used keys. Writing Pad supports gesture recognition.

The following table describes how to use gestures to perform common functions.

To press Do this

Backspace Draw a line from right to left.

Enter Draw a connected line from top to bottom

and then from right to left.

Tab
Draw a connected line from bottom to top

and then from left to right.

Space bar
Draw a connected line from top to bottom

and then from left to right.

Using the Web Browser and Calculator Tools
MimioStudio Tools includes shortcuts for accessing a Web browser and a calculator.

To use the tools
1. Start MimioStudio Tools.
2. Click the Applications button, , choose More Tools, and then choose one of the

following tools:
l  Calculator
l  Web Browser

Caring for Mimio Interactive
Review the following topics for information about cleaning, inserting the batteries, and
permanently mounting your Mimio Interactive.

n Cleaning Mimio Interactive
n Inserting the Batteries
n Mounting Mimio Interactive Permanently
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Cleaning Mimio Interactive
Mimio Interactiveis designed to give you long and trouble-free service while requiring very
little maintenance.

You can easily clean your Mimio Interactive using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the Mimio Interactive bar and Mouse
1. If necessary, disconnect the USB cable from the Mimio Interactive bar.
2. Use the lint-free cloth to wipe the exterior of the Mimio Interactive bar and Mouse.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Avoid using liquids on any exposed charging contacts. Do not allow liquid into
any openings on the equipment.

4. Reconnect the USB cable.

Inserting the Batteries
Mimio Interactiveis powered using the included USB cable and power adapter. Optionally,
Mimio Interactive can be powered using four AA batteries.

To insert the batteries
1. Press down and slide off the battery compartment cover.
2. Insert four AA batteries into the battery compartment.
3. Replace the battery compartment cover.

Remove the batteries if the Mimio Interactive bar will not be used for a long period of
time.

Mounting Mimio Interactive Permanently
The Mimio Interactive bar attaches to any whiteboard using the suction cups on the back of
the bar. If the Mimio Interactive bar will be used for extended periods of time or will be
used repeatedly in any one location, you should mount the bar using the included brackets.
To mount Mimio Interactive permanently
1. Snap the mounting brackets over the suction cups on the back of the Mimio Interactive

bar.
Make sure that the brackets clip into the recesses on the sides of the Mimio Interactive
bar.
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2. Remove the paper backing from the adhesive strips to expose the adhesive.

3. Press the Mimio Interactive bar firmly along the top left edge of the whiteboard as
shown.
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MimioCapture
(Model Number: ICD10)

MimioCapture is used with a MimioTeach-enabled whiteboard to record notes and drawings
from your whiteboard. Using MimioStudio Ink Capture mode, you make notes and drawings
on your whiteboard using the MimioCapture pens. Your notes are automatically captured in
a MimioStudio Notebook.

What's Included
The MimioCapture package contains the following items:
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1 MimioCapture charging tray 4 MimioCapture eraser

2 MimioCapture pens (4) 5 Expo dry erase markers (4)

3 Mounting plates 6 Magnetic pen holder

If you are missing any of the items above, contact Customer Support.

About MimioCapture
MimioCapture includes four pens and one eraser for making notes on your MimioTeach-
enabled whiteboard. The MimioCapture charging tray is used to charge the pens and eraser.
The MimioCapture pen holder attaches to your whiteboard and is used to store the pens and
eraser.

The following figure shows the major components of MimioCapture.

1 Power cord 4 MimioCapture pens

2 MimioCapture charging tray 5 Status lights

3 MimioCapture eraser 6 Magnetic pen holder

Status Lights
The status lights visually show the status of each MimioCapture pen and the MimioCapture
eraser.
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Off The MimioCapture pen or eraser is not receiving power. The status light is off when
the pen or eraser is in use.

Amber The MimioCapture pen or eraser has a low battery. The battery should be recharged.

Solid Green The MimioCapture pen or eraser is charging.

About MimioStudio Notebook
As you make notes on your whiteboard using MimioCapture, you can automatically save
those notes into MimioStudio Notebook. Once the information is in Notebook, you can
save the Notebook as a MimioStudio INK file or a variety of other formats.

For more information about using MimioStudio Notebook, see Working with MimioStudio .

Getting Started
MimioCapture seamlessly integrates with your MimioTeach and MimioStudio software.
Before you can begin capturing digital ink, you must first set up your MimioCapture pens,
MimioCapture eraser, and MimioStudio Notebook.

Setting Up the MimioCapture Charging Tray
The MimioCapture charging tray is powered through your computer. Optionally, the
MimioCapture charging tray can be powered using a USB power adapter.

To connect the power
1. Place the charging tray on a flat surface..
2. Plug the power cord into an available USB port on your computer.

Setting Up the Pen Holder
The MimioCapture pen holder holds the MimioCapture pens and eraser for easy access. The
pen holder attaches securely to any magnetic whiteboard.

To mount pen holder to a magnetic whiteboard
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1. Place the pen holder in the desired location on the whiteboard as shown.

The MimioCapture pen holder attaches securely to any magnetic whiteboard. See
Mounting the Pen Holder to a Non-Magnetic Whiteboard for information about
mounting the pen holder to a non-magnetic whiteboard.

2. Place the MimioCapture pens and eraser in the pen holder as shown.

Setting Up the MimioCapture Pens
MimioCapture comes with four colored MimioCapture pens and four Expo® dry erase
markers. Before you can start using MimioCapture, you must first set up your MimioCapture
Pens.

The MimioCapture pens are each powered by a rechargeable lithium-ion battery. The pens
charge whenever they are docked on the MimioCapture charging tray.

To set up the MimioCapture pens
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1. Pull the plastic strip from the top part of the pen to activate the rechargeable battery.

2. Press the button on the side of the pen and pull the top part of the pen from the pen
body.

3. Insert a colored Expo® dry erase marker into the matching colored pen body.

4. Replace the top part of the pen onto the pen body.

5. Place the pen cap onto the pen.
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Setting Up the MimioCapture Eraser
The MimioCapture eraser is powered by a rechargeable lithium-ion battery. The eraser
charges whenever the eraser is docked on the MimioCapture charging tray.

To set up the MimioCapture eraser
Pull the plastic strip from the top part of the eraser to activate the rechargeable battery.

Charging the Pens and Eraser
The MimioCapture pens and MimioCapture eraser recharge quickly whenever they are
docked on the MimioCapture charging tray.

Charge the pens and eraser for a full 24 hours before using for the first time.

To charge the pens and eraser
Place each pen and the eraser into the appropriate part of the MimioCapture charging
tray.
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The status lights turn solid green when the pen or eraser is charging.

Setting Up MimioStudio Notebook for Capture
To begin capturing digital ink, you must first do the following:

n Set the size of your whiteboard in MimioStudio Settings.
n Start MimioStudio Ink Capture mode.

Setting the Whiteboard Size
Before you begin capturing digital ink, you must first set the size of your whiteboard in
MimioStudio Settings. The default size is 96 inches by 48 inches.

To set the whiteboard size for a MimioCapture device
1. Right-click in the notification area of the taskbar, and then choose Settings.

The MimioStudio Settings dialog box appears.
2. Click Ink Capture.
3. If you have more than one MimioTeach bar connected to your computer, choose the

device to change the size for from the Device list.
4. Do one of the following:

l Choose a size from the Surface Size list.
l Choose Custom from the Surface Size list and enter the desired values into the
Width and Height boxes.

l Click Auto Size and touch a MimioCapture pen to the whiteboard at the location
shown in the Auto Size dialog box.
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Starting Ink Capture Mode
Using MimioStudio Ink Capture mode, you can make notes on your whiteboard and
instantaneously capture them into a MimioStudio Notebook.

To start Ink Capture mode
Touch the tip of any MimioCapture pen to the whiteboard.
A new Notebook opens automatically for capturing your notes.

Using MimioCapture
MimioCapture can be used along with MimioTeach, without a projector, to record notes and
drawings from your whiteboard. This is called capturing digital ink.

Capturing Digital Ink
When using Ink Capture mode, your notes are automatically captured in a MimioStudio
Notebook. You can use the buttons on the MimioTeach bar to insert a new Notebook page
or insert a copy of the current page into Notebook.

To capture digital ink
1. If your MimioTeach bar is not on, turn on your MimioTeach bar.
2. Write or draw on your whiteboard using the MimioCapture pens.

A new Notebook automatically opens on the connected computer and begins capturing
digital ink.

3. Add and copy pages as desired using the buttons on the MimioTeach bar.

Writing and Drawing Digital Ink
In Ink Capture mode, the MimioCapture pens and the MimioCapture eraser are used to draw
and erase ink on your whiteboard.

By default, the color recorded matches the color of the MimioCapture pen, regardless of the
color of the marker that is inserted.

The MimioTeach stylus is for use with Interactive mode only. The stylus does not work
with Ink Capture mode.

To draw digital ink
1. Choose one of the colored MimioCapture pens.
2. Draw on the whiteboard with the pen.

Keep the pen within 15 degrees of its perpendicular position to the whiteboard to
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ensure that the data is accurately captured.

To erase digital ink
Erase the ink from the whiteboard using the MimioCapture eraser.
Keep the eraser surface flat against the whiteboard to ensure that the data is accurately
erased.

Adding and Copying Notebook Pages
Using the Launch button on the MimioTeach bar, you can insert a new Notebook page or
insert a copy of the current page into Notebook.

The following figure shows the Launch button on the MimioTeach bar.

To add a page
1. Press the Launch button, , on the MimioTeach bar.

The MimioTeach bar beeps and a new page is added to the Notebook.
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To copy a page
1. Press and hold the Launch button, , on the MimioTeach bar.
2. When you hear two beeps, release the button.

A copy of the current page is added to the Notebook.

Caring for MimioCapture
Review the following topics for information about cleaning MimioCapture and mounting
the MimioCapture pen holder to a non-magnetic whiteboard.

n Cleaning MimioCapture
n Mounting the Pen Holder to a Non-Magnetic Whiteboard

Cleaning MimioCapture
MimioCapture is designed to give you long and trouble-free service, while requiring very
little maintenance.

You can easily clean your MimioCapture using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the MimioCapture
1. Disconnect the charging tray power cable.
2. Use the lint-free cloth to wipe the exterior of the MimioCapture charging tray, pen

holder, pens, and eraser.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Avoid using liquids on any exposed charging contacts. Do not allow liquid into
any openings on the equipment.

4. Reconnect the power cable.

Mounting the Pen Holder to a Non-Magnetic Whiteboard
The MimioCapture pen holder attaches securely to any magnetic whiteboard. If you do not
have a magnetic whiteboard, you can mount the MimioCapture pen holder to your
whiteboard using the included metal plates.
To mount pen holder to a non-magnetic whiteboard
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1. Place the metal plates against the back of the pen holder as shown.

Make sure that the recess on each plate is inserted into the recess on the back of the
pen holder.

2. Remove the paper backing from the adhesive strips to expose the adhesive.

3. Press the pen holder firmly against the whiteboard as shown and hold for 20 seconds.
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4. Remove the pen holder from the whiteboard.
The metal plates remain attached to the whiteboard.

5. Press each plate firmly against the whiteboard for 30 seconds.

6. Let stand for at least one hour, and then place the pen holder on the magnetic plates as
shown.
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7. Place the MimioCapture pens and eraser in the pen holder as shown.
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MimioCapture
(Model Number: ICD04)

MimioCapture is used with a MimioTeach-enabled whiteboard to record notes and drawings
from your whiteboard. Using MimioStudio Ink Capture mode, you make notes and drawings
on your whiteboard using the MimioCapture pens. Your notes are automatically captured in
a MimioStudio Notebook.

What's Included
The MimioCapture package contains the following items:

1 MimioCapture tray 4 Mounting plates

2 Expo dry erase markers (4) 5 Connector bar

3 MimioCapture pens (4) 6 MimioCapture eraser

If you are missing any of the items above, contact Customer Support.
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About MimioCapture
MimioCapture includes four pens and one eraser for making notes on your MimioTeach-
enabled whiteboard. The MimioCapture tray is used to store and charge the pens and eraser.
You can also perform some common actions using the buttons on the MimioCapture tray.

The following figure shows the major components of MimioCapture.

1 Connector bar port 4 Capture buttons

2 MimioCapture eraser 5 Status lights

3 MimioCapture pens 6 Charging tray

Status Lights
The status lights visually show the status of each MimioCapture pen and the MimioCapture
eraser.

Off The MimioCapture pen or eraser is not receiving power. The status light is off when
the pen or eraser is in use.

Amber The MimioCapture pen or eraser has a low battery. The battery should be recharged.

Solid Green The MimioCapture pen or eraser is charging.

About MimioStudio Notebook
As you make notes on your whiteboard using MimioCapture, you can automatically save
those notes into MimioStudio Notebook. Once the information is in Notebook, you can
save the Notebook as a MimioStudio INK file or a variety of other formats.

For more information about using MimioStudio Notebook, see Working with MimioStudio
Notebook.
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Getting Started
MimioCapture links directly to your MimioTeach for seamless integration with
MimioStudio software. Before you can begin capturing digital ink, you must first set up
your MimioCapture tray, MimioCapture pens, MimioCapture eraser, and MimioStudio
Notebook.

Setting Up the MimioCapture Tray
The MimioCapture tray is powered using the USB cable and power adapter that were
included with your MimioTeach. The MimioTeach bar connects to the MimioCapture tray
using the connector bar that was included with your MimioCapture.

To connect
1. Remove the MimioTeach bar from the whiteboard.
2. Unplug the USB cable from the MimioTeach bar.

3. Plug the USB cable into the USB port on the MimioCapture tray.

4. Place the MimioCapture tray along the bottom-left edge of the whiteboard as shown.

The MimioCapture tray attaches securely to any magnetic whiteboard. See Mounting
MimioCapture to a Non-Magnetic Whiteboard for information about mounting the tray
to a non-magnetic whiteboard.

5. Connect the connector bar to the MimioCapture tray as shown.
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6. Connect the other end of the connector bar to the MimioTeach bar as shown.

7. Reattach the MimioTeach bar along the left side of the whiteboard.

Setting Up the MimioCapture Pens
MimioCapture comes with four colored MimioCapture pens and four Expo® dry erase
markers. Before you can start using MimioCapture, you must first set up your MimioCapture
Pens.

The MimioCapture pens are each powered by a rechargeable lithium-ion battery. The pens
charge whenever they are docked on the MimioCapture tray.

To set up the MimioCapture pens
1. Pull the plastic strip from the top part of the pen to activate the rechargeable battery.

2. Press the button on the side of the pen and pull the top part of the pen from the pen
body.
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3. Insert a colored Expo® dry erase marker into the matching colored pen body.

4. Replace the top part of the pen onto the pen body.

5. Place the pen cap onto the pen.

Setting Up the MimioCapture Eraser
The MimioCapture eraser is powered by a rechargeable lithium-ion battery. The eraser
charges whenever the eraser is docked on the MimioCapture tray.

To set up the MimioCapture eraser
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Pull the plastic strip from the top part of the eraser to activate the rechargeable battery.

Charging the Pens and Eraser
The MimioCapture pens and MimioCapture eraser recharge quickly whenever they are
docked on the MimioCapture tray.

To charge the pens and eraser
Place each pen and the eraser into the appropriate part of the MimioCapture tray.

The status lights turn solid green when the pen or eraser is charging.

Setting Up MimioStudio Notebook for Capture
To begin capturing digital ink, you must first do the following:

n Set the size of your whiteboard in MimioStudio Settings.
n Start MimioStudio Ink Capture mode.

Setting the Whiteboard Size
Before you begin capturing digital ink, you must first set the size of your whiteboard in
MimioStudio Settings. The default size is 96 inches by 48 inches.

To set the whiteboard size for a MimioCapture device
1. Right-click in the notification area of the taskbar, and then choose Settings.

The MimioStudio Settings dialog box appears.
2. Click Ink Capture.
3. If you have more than one MimioTeach bar connected to your computer, choose the

device to change the size for from the Device list.
4. Do one of the following:

l Choose a size from the Surface Size list.
l Choose Custom from the Surface Size list and enter the desired values into the
Width and Height boxes.
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l Click Auto Size and touch a MimioCapture pen to the whiteboard at the location
shown in the Auto Size dialog box.

Starting Ink Capture Mode
Using MimioStudio Ink Capture mode, you can make notes on your whiteboard and
instantaneously capture them into a MimioStudio Notebook.

To start Ink Capture mode
Touch the tip of any MimioCapture pen to the whiteboard.
A new Notebook opens automatically for capturing your notes.

Using MimioCapture
MimioCapture can be used along with MimioTeach, without a projector, to record notes and
drawings from your whiteboard. This is called capturing digital ink.

Capturing Digital Ink
When using Ink Capture mode, your notes are automatically captured in a MimioStudio
Notebook. You can use the buttons on the MimioCapture tray to insert a new Notebook
page, insert a copy of the current page into Notebook, or print the current Notebook page.

To capture digital ink
1. If your MimioTeach bar is not on, turn on your MimioTeach bar.
2. Write or draw on your whiteboard using the MimioCapture pens.

A new Notebook automatically opens on the connected computer and begins capturing
digital ink.

3. Add, copy, and print pages as desired using the buttons on the MimioCapture tray.

Writing and Drawing Digital Ink
In Ink Capture mode, the MimioCapture pens and the MimioCapture eraser are used to draw
and erase ink on your whiteboard.

By default, the color recorded matches the color of the MimioCapture pen, regardless of the
color of the marker that is inserted.

The MimioTeach stylus is for use with Interactive mode only. The stylus does not work
with Ink Capture mode.

To draw digital ink
1. Choose one of the colored MimioCapture pens.
2. Draw on the whiteboard with the pen.

Keep the pen within 15 degrees of its perpendicular position to the whiteboard to
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ensure that the data is accurately captured.

To erase digital ink
Erase the ink from the whiteboard using the MimioCapture eraser.
Keep the eraser surface flat against the whiteboard to ensure that the data is accurately
erased.

Adding, Copying, and Printing Notebook Pages
When using MimioStudio in Capture mode, you can insert a new Notebook page, insert a
copy of the current page into Notebook, or print the current Notebook page.

Using the MimioCapture Bar to Add, Copy, and Print Notebook Pages
The buttons on the MimioCapture tray can be used to easily access features directly from
your whiteboard. Using the buttons on the MimioCapture tray, you can insert a new
Notebook page, insert a copy of the current page into Notebook, or print the current
Notebook page.

The following figure shows the MimioCapture tray buttons.

The following table describes the functions of the MimioCapture tray buttons.
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New page Inserts a new page into MimioStudio Notebook.

Copy page Inserts a duplicate of the current page into MimioStudio
Notebook.

Print page Prints the current page.

Using the MimioTeach Bar to Add and Copy Notebook Pages
Using the Launch button on the MimioTeach bar, you can insert a new Notebook page or
insert a copy of the current page into Notebook.

The following figure shows the Launch button on the MimioTeach bar.

To add a page
1. Press the Launch button, , on the MimioTeach bar.

The MimioTeach bar beeps and a new page is added to the Notebook.
To copy a page
1. Press and hold the Launch button, , on the MimioTeach bar.
2. When you hear two beeps, release the button.

A copy of the current page is added to the Notebook.
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Caring for MimioCapture
Review the following topics for information about cleaning, storing, and mounting your
MimioCapture to a non-magnetic whiteboard.

n Cleaning MimioCapture
n Mounting MimioCapture to a Non-Magnetic Whiteboard

Cleaning MimioCapture
MimioCapture is designed to give you long and trouble-free service, while requiring very
little maintenance.

You can easily clean your MimioCapture using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the MimioCapture
1. Disconnect the power cable and the connector bar.
2. Use the lint-free cloth to wipe the exterior of the MimioCapture tray, pens, and eraser.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Avoid using liquids on any exposed charging contacts. Do not allow liquid into
any openings on the equipment.

4. Reconnect the power cable and the connector bar.

Mounting MimioCapture to a Non-Magnetic Whiteboard
The MimioCapture tray attaches securely to any magnetic whiteboard. If you do not have a
magnetic whiteboard, you can mount the MimioCapture tray to your whiteboard using the
included metal plates.
To mount MimioCapture to a non-magnetic whiteboard
1. Place the metal plates against the back of the MimioCapture tray as shown.

Make sure that the recess on each plate is inserted into the recess on the back of the
MimioCapture tray.

2. Remove the paper backing from the adhesive strips to expose the adhesive.
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3. Press the MimioCapture tray firmly along the bottom-left edge of the whiteboard as
shown.
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Mimio Capture Kit
Mimio Capture Kit is used with a Mimio Interactive-enabled whiteboard to record notes and
drawings from your whiteboard. Using MimioStudio Ink Capture mode, you make notes and
drawings on your whiteboard using the Mimio Capture Kit pens. Your notes are
automatically captured in a MimioStudio Notebook.

What's Included
The Mimio Capture Kit package contains the following items:

1 Mimio Capture Kit pens (4) 6 Mimio Capture Kit pen holder

2 Mimio Capture Kit eraser 7 Mimio Capture Kit eraser holder

3 Expo markers (4) 8 N-Cell batteries (4)

4 Color caps (8) 9 AAA battery

5 Mimio Capture Kit pen caps (4)

If you are missing any of the items above, contact Customer Support.
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About Mimio Capture Kit
Mimio Capture Kit includes four pens and one eraser for making notes on your Mimio
Interactive-enabled whiteboard. The pen holder and eraser holder are used to store the pens
and eraser.

The following figure shows the major components of Mimio Capture Kit.

1 Mimio Capture Kit eraser 3 Mimio Capture Kit pens

2 Mimio Capture Kit eraser holder 4 Mimio Capture Kit pen holder

About MimioStudio Notebook
As you make notes on your whiteboard using Mimio Capture Kit, you can automatically
save those notes into MimioStudio Notebook. Once the information is in Notebook, you
can save the Notebook as a MimioStudio INK file or a variety of other formats.

Your Mimio Interactive bar can capture and store ink while disconnected from your
computer. See Downloading Digital Ink for more information about capturing and
downloading digital ink for an offline session.

For more information about using MimioStudio Notebook, see Working with MimioStudio
Notebook.

Getting Started
Mimio Capture Kit links directly to your Mimio Interactive for seamless integration with
MimioStudio software. Before you can begin capturing digital ink, you must first set up
your Mimio Capture Kit pens, Mimio Capture Kit eraser, and MimioStudio Notebook.

Setting Up the Mimio Capture Kit Pens
Mimio Capture Kit comes with four Mimio Capture Kit pens, four Expo® dry erase markers,
and eight color caps. Before you can start using Mimio Capture Kit, you must first set up
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your Mimio Capture Kit pens.

The Mimio Capture Kit pens are each powered by one N-cell battery.

To set up the Mimio Capture Kit pens
1. Gently turn and pull the top part of the Mimio Capture Kit pen to separate the top part

of the pen from the pen body.

2. Press the colored nodes on each side of the pen and pull to remove the color cap.

3. Insert one N-cell battery into the Mimio Capture Kit pen.

4. Replace the color cap making sure to align the spring on the color cap with the battery.

107



Mimio Capture Kit

5. Insert an Expo® dry erase marker that matches the color of the color cap into the pen
body.

6. Align the arrow on the pen body with the arrow on the top part of the pen.

7. Push the two parts of the pen together, and then twist to lock in place.

8. Place the pen cap onto the pen.

Setting Up the Mimio Capture Kit Eraser
The Mimio Capture Kit eraser is powered by one AAA battery.

To set up the Mimio Capture Kit eraser
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1. Lightly press both sides of the eraser and lift to remove the battery compartment cover.

2. Insert the battery into the battery compartment.

3. Replace the battery compartment cover.

Setting Up MimioStudio Notebook for Capture
To begin capturing digital ink, you must first do the following:
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n Set the size of your whiteboard in MimioStudio Settings.
n Start MimioStudio Ink Capture mode.

Setting the Whiteboard Size
Before you begin capturing digital ink, you must first set the size of your whiteboard in
MimioStudio Settings. The default size is 96 inches by 48 inches.

To set the whiteboard size for a Mimio Interactive device
1. Right-click in the notification area of the taskbar, and then choose Settings.

The MimioStudio Settings dialog box appears.
2. Click Ink Capture.
3. If you have more than one Mimio Interactive bar connected to your computer, choose

the device to change the size for from the Device list.
4. Do one of the following:

l Choose a size from the Surface Size list.
l Choose Custom from the Surface Size list and enter the desired values into the
Width and Height boxes.

l Click Auto Size and touch a Mimio Capture Kit pen to the whiteboard at the
location shown in the Auto Size dialog box.

Starting Ink Capture Mode
Using MimioStudio Ink Capture mode, you can make notes on your whiteboard and
instantaneously capture them into a MimioStudio Notebook.

Your Mimio Interactive bar can capture and store ink while disconnected from your
computer. However, you need to supply power to your Mimio Interactive bar using
batteries or a wall adapter. See Downloading Digital Ink for more information about
capturing and downloading digital ink for an offline session.

To start Ink Capture mode
Touch the tip of any Mimio Capture Kit pen to the whiteboard.
A new Notebook opens automatically for capturing your notes.

Using Mimio Capture Kit
Mimio Capture Kit can be used along with Mimio Interactive, without a projector, to record
notes and drawings from your whiteboard. This is called capturing digital ink.

Capturing Digital Ink
When using Ink Capture mode, your notes are automatically captured in a MimioStudio
Notebook. You can use the buttons on the Mimio Interactive bar to insert a new Notebook
page, insert a copy of the current page into Notebook, or print the current Notebook page.

Your Mimio Interactive bar can capture and store ink while disconnected from your
computer. See Downloading Digital Ink for more information about capturing and
downloading digital ink for an offline session.

To capture digital ink
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1. If your Mimio Interactive bar is not on, turn on your Mimio Interactive bar.
2. Write or draw on your whiteboard using the Mimio Capture Kit pens.

A new Notebook automatically opens on the connected computer and begins capturing
digital ink.

3. Add, copy, and print pages as desired using the buttons on the Mimio Interactive bar.

Writing and Drawing Digital Ink
In Ink Capture mode, the Mimio Capture Kit pens and the Mimio Capture Kit eraser are
used to draw and erase ink on your whiteboard.

By default, the color recorded matches the color of the color cap on the Mimio Capture Kit
pen, regardless of the color of the marker that is inserted.

The Mimio Interactive Mouse is for use with Interactive mode only. The Mouse does
not work with Ink Capture mode.

To draw digital ink
1. Choose one of the Mimio Capture Kit pens.
2. Draw on the whiteboard with the pen.

Keep the pen within 15 degrees of its perpendicular position to the whiteboard to
ensure that the data is accurately captured.

To erase digital ink
Erase the ink from the whiteboard using the Mimio Capture Kit eraser.
Keep the eraser surface flat against the whiteboard to ensure that the data is accurately
erased.

Adding, Copying, and Printing Notebook Pages
When using Ink Capture mode, the buttons on the Mimio Interactive bar can be used to
easily access features directly from your whiteboard. Using the buttons on the Mimio
Interactive bar, you can insert a new Notebook page, insert a copy of the current page into
Notebook, or print the current Notebook page.

The following figure shows the Mimio Interactive bar buttons.
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The following table describes the functions of the Mimio Interactive bar buttons.

New page Inserts a new page into MimioStudio Notebook.

Copy page Inserts a duplicate of the current page into MimioStudio
Notebook.

Print page Prints the current page.

Resize window Minimizes or Maximizes the MimioStudio Notebook window.

Interactive Exits Ink Capture mode and starts Interactive mode.

Downloading Digital Ink
You can use your Mimio Interactive bar to record and save Digital Ink even when not
connected to your computer. You can then download the Digital Ink to MimioStudio
Notebook for printing, distributing, or editing.

When your Mimio Interactive bar is not connected to your computer through the USB
cable, the Mimio Interactive bar must be powered by batteries or a power adapter.

To download digital ink
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1. Connect the Mimio Interactive bar to your computer.
2. Do one of the following:

l If configured to automatically download digital ink (default), open a new
MimioStudio Notebook.
The ink download process begins automatically.

l If configured to manually download digital ink, open a new MimioStudio Notebook
and double-click Download Ink on the status bar.

Caring for Mimio Capture Kit
Review the following topics for information about cleaning, storing, and mounting your
Mimio Capture Kit.

n Cleaning the Mimio Capture Kit
n Mounting the Mimio Capture Kit

Cleaning the Mimio Capture Kit
Mimio Capture Kit is designed to give you long and trouble-free service, while requiring
very little maintenance.

You can easily clean your Mimio Capture Kit using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the Mimio Capture Kit
1. Use the lint-free cloth to wipe the exterior of the Mimio Capture Kit pens, and eraser.
2. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Do not allow liquid into any openings on the equipment.

Mounting the Mimio Capture Kit
The Mimio Capture Kit pen and eraser holders attach securely to any whiteboard.
To mount the Mimio Capture Kit pen holder
1. Remove the paper backing from the adhesive strips on the back of the pen holder to

expose the adhesive.

2. Hold the Mimio Capture Kit pen holder vertically, and press firmly against the
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whiteboard as shown.

3. Insert the Mimio Capture Kit pens into the pen holder when not in use.

To mount the Mimio Capture Kit eraser holder
1. Remove the paper backing from the adhesive strips on the back of the eraser holder to

expose the adhesive.

114



Caring for Mimio Capture Kit

2. Press the Mimio Capture Kit eraser holder firmly against the whiteboard as shown.

3. Insert the Mimio Capture Kit eraser into the eraser holder when not in use.
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MimioVote
MimioVote is a wireless, interactive, student response system. Using MimioVote, you can
easily and quickly gather student responses. This quick feedback from students allows you
to make sure each student is keeping up and adjust your lesson accordingly.

What's Included
The MimioVote package contains the following items:

1 Carrying case 4 MimioVote unit (24 or 32)

2 Power cable 5 Charging station

3 MimioHub

If you are missing any of the items above, contact Customer Support.

About MimioVote
Your MimioVote system comes with a charging station and either 24 or 32 MimioVote
units. You can combine two MimioVote systems for a total of up to 64 units.

About the MimioVote Station
The MimioVote station is used to recharge and store all of your MimioVote units.
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You can place any MimioVote unit into any slot on the MimioVote station. The number
assigned to each unit is automatically determined by the number of the slot that the unit is
inserted into. There is no need to match a particular unit to a particular slot on the
MimioVote station. Once a unit is inserted into the MimioVote station, the unit number
appears in the unit display.

The following figure shows the major components of the MimioVote station.

1 MimioVote unit slot

2 Status light

3 Power connector

Status Lights

The status light visually shows the status of the MimioVote station.

Off Not receiving power; Power cable is not
connected.

Solid Green MimioVote is connected and receiving power;
MimioStudio software is running.

Flashing Green
MimioVote is connected or connecting, and
receiving power; MimioStudio software is not
running.

Solid Amber MimioVote cannot find an available MimioHub.

Flashing Amber MimioVote is searching for an available
MimioHub.
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About the MimioVote Units
The MimioVote system includes either 24 or 32 MimioVote units. The MimioVote units
slide into the MimioVote station to recharge or to store.

When conducting activities, the buttons on the MimioVote unit light up depending on
what answers are available to the student. The available answers are determined by the
teacher when the question is created. For example, if the question is a True/False question,
only the  and  buttons are illuminated on the MimioVote unit. The A, B, C, D, and E
buttons will not light up and will not register a response if pressed.

By default, each button on the MimioVote unit is illuminated with a different color light.
You can choose to turn off the colors and have all the buttons illuminated with a white
light. For information about changing the button colors, see Adjusting the Vote Settings.

The following figure shows the major components of the MimioVote unit.

1 Previous 5 Multiple choice buttons

2 Display 6 True/False buttons

3 Next 7 Submit

4 Help

About the Software
MimioStudio software includes several features especially for use with your MimioVote
system. MimioStudio Notebook and Gallery include everything you need to create activities
to conduct with your students. The MimioStudio Vote Toolbar and MimioStudio Quick
Vote include all the tools you need for conducting activities and gathering student
responses. And, the MimioStudio Gradebook stores the information and results for all of
your class activities.
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About MimioStudio Notebook
You can use MimioStudio Notebook to create any type of MimioVote activity. Activities
are created by adding question objects to Notebook pages. The Questions and Results folder
in MimioStudio Gallery includes a wide variety of pre-designed question objects to make
creating activities in Notebook quick and easy.

For more information about using MimioStudio Notebook and Gallery, see About
MimioStudio.

About the Vote Toolbar
The Vote Toolbar includes all the tools you need for taking attendance, conducting class
activities, gathering student responses, and viewing results. The Vote Toolbar is available in
MimioStudio Notebook.

The following table describes the major features of the Vote Toolbar in MimioStudio
Notebook.

Choose Class Select class Number responded

Take attendance View help requests

Start/stop polling Start self-paced activity

View results Print self-paced activity

Timer display

About MimioStudio Quick Vote
You can use MimioStudio Quick Vote to ask questions that are not a part of a
NotebookMimioVote activity. You can use Quick Vote to add a question at any time
during a Teacher-Led activity.

The following table describes the major features of MimioStudio Quick Vote.

Choose Class Select class Timer display

Take attendance Number responded

Select question type
and start/stop polling

View help requests

View results Settings
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About MimioStudio Gradebook
MimioStudio Gradebook stores the results for all of your class activities. Student responses
gathered using the MimioVote system are automatically saved to the Gradebook along with
complete information for each question. You can also manually add activities that were not
conducted using the MimioVote system, making it easy to keep all your grades in one
location.

The following views are available in Gradebook, giving you easy access to the information
you want to view:

All Classes View

The All Classes view displays a list of all of your saved classes, the number of students in
each class, and the average grade for all students in the class.

The All Classes view is displayed when no class is selected.

Date View

The Date view displays a list of all students in the selected class and all dates on which any
activities were conducted. Each date column shows the average grade for each student, for
all activities that were conducted on that date.

From the Date view, you can also view the Class pane. The Class pane displays the name of
the class, number of students in the class, and the number of activities that have been
conducted with the selected class.

The Date view is displayed when a class is selected.

Activity View

The Activity view displays a list of all students in the selected class. The Attendance
column shows the attendance status for each student on the selected date. The activity
columns show the grade that each student received for each activity conducted on the
selected date.

From the Activity view, you can also view the Activity pane. The Activity pane displays
the name of the activity, activity type, total number of question, and the weight of the
activity.

The Activity view is displayed when a class and date are selected.

Activity Detail View

The Activity Detail view displays a list of all students in the selected class. The Average
column shows the grade for each student for the selected activity. Each question column
shows the response that each student provided.

The response icon indicates the student response or the question type.
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Multiple choice

True/Yes

False/No

Numeric

Short Answer

Essay

The color of the response icon indicates the status of the student response.

Correct Incorrect
Partially
Correct

Opinion Ungraded

The Activity pane displays the name, type, and weight of the selected activity.

From the Activity Detail view, you can also view the Question pane and the Student
Response pane. The Question pane displays the question text, the available and correct
answers, the question snapshot, and the question weight. The Student Response Pane
displays the student name and the student response for the selected question.

The Activity Detail view is displayed when a class, date, and activity are selected.

In addition, you can view the Student pane from Date view, Activity view, or Activity
Detail view. The Student pane displays the name, student ID number, MimioVote unit
number, and address for the selected student.

Getting Started
Setting up the MimioVote system is quick and easy. You can link your MimioVote system
to your computer using the included MimioHub. Or, if you have MimioTeach, you can link
the MimioVote system to your computer using the MimioHub that you already have
installed.

Setting Up MimioVote
Once you have installed the MimioStudio software on your computer, you can quickly set
up MimioVote.

Each MimioVote unit is powered by a rechargeable lithium-ion battery. The battery
recharges whenever the unit is docked in the MimioVote station. Charging the battery
for the first time will take approximately six hours; when fully discharged, recharging
the battery will take approximately twelve hours.

To set up MimioVote
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1. Pull the plastic strip from each MimioVote unit to activate the rechargeable battery.

2. Insert each MimioVote unit into a slot on the MimioVote station.

3. Plug the power cord into the power connector on the back of the MimioVote station.

4. Plug the other end of the power cord into a power outlet.

5. Plug the MimioHub into an available USB port on your computer.
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If you already have a MimioHub installed on your computer, a dialog box appears
asking if you want to connect the MimioHub to the MimioVote system. Click Yes
to link the MimioVote system to your existing MimioHub.

Adding a Second MimioVote System
Each MimioVote system includes either 24 or 32 MimioVote units. For larger classes, you
can combine two MimioVote systems for a total of up to 64 units.

You can use the same MimioHub to connect all of your MimioClassroom devices to
your computer.

To add a second MimioVote system
1. Set up the MimioVote station and units as described in Setting Up MimioVote.

Once the power is connected to the MimioVote system, the previously installed
MimioHub will detect the new system.

2. When prompted by the software, click Yes to connect the new system to the
MimioHub.
The second system is connected to your computer and the appropriate numbers are
assigned to each MimioVote unit automatically.

If you do not see the prompt, or you want to connect the system at a later time, see
Adjusting the Classroom Devices Settings for information about connecting
available devices to your computer.

Using MimioStudio Gradebook
You can use MimioStudio Gradebook to store information for all of your classes, students,
and class activities. Student responses gathered using the MimioVote system are
automatically saved to the Gradebook along with complete information for each question.
You can also manually add activities that were not conducted using the MimioVote system,
making it easy to keep all your grades in one location.

Several ways to access MimioStudio Gradebook are shown in the following table.

To start from the Do this

Desktop Double-click  on the desktop.

Notification area Right-click , and then choose Gradebook.

Application menu Point toMimioStudio, and then chooseMimioStudio Gradebook.

Setting Up the Gradebook
Before you begin using your MimioVote system to conduct activities, you must first set up
MimioStudio Gradebook. You can add as many classes as you want to Gradebook, and then
add students to each of your classes.

124



Using MimioStudio Gradebook

Creating a Class
You can create as many classes as you want in Gradebook. Once you have created a class,
you can add students to the class by manually entering all student names and information,
or you can import a list of students.

To create a class

1. Click  on the Gradebook toolbar.
The Add Class dialog box appears.

2. Enter a name for the class in the Name box, and then click Add.
The class is added to your class list.

Adding Students
The number of students you can have in each class depends on the number of MimioVote
units you have. You can combine two MimioVote systems for up to 64 units.

Each student that you add to a class is automatically assigned a MimioVote unit number.

To add a student to a class
1. Select the class to add a student to.

2. Click  on the Gradebook toolbar.
The Add Student dialog box appears.

3. Enter the name, student ID number, and address for the student.
The MimioVote handset ID is assigned automatically.

4. Click Add.
The student is added to the class.

Importing a List of Students
You can add students to a class manually by entering all student names and information, or
you can import an existing list of students into a class.

You can import students from a Unicode text file (TXT) or a Comma separated value file
(CSV). Each student must have at least a first or last name assigned to them in order to be
imported.

The following fields are supported for importing into Gradebook.

n StudentID
n FirstName
n MiddleName
n LastName
n Gender
n Birthdate

n Address
n City
n State
n Zipcode
n Country

Each student that you add to a class is automatically assigned a MimioVote unit number.

To import a class list
1. In Gradebook, select the class you want to import the student list into.
2. From the File menu, choose Import, and then choose Students.
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The Open dialog box appears.
3. Navigate to and select the file you want to import, and then click Open.

The students are added to the selected class.

Adding Activities
You can keep track of all of your student scores using Gradebook. Scores for all MimioVote
activities are automatically saved to the Gradebook. You can also manually enter activities
that were not performed using MimioVote.

To add an activity
1. Select the class to add the activity to.
2. Click  on the Gradebook toolbar.
3. In the Add Activity dialog box, do the following:

a. Enter a name for the activity in the Name box.
b. Choose the type of activity to add from the Type list.
c. Choose the month, date, and year that the activity was performed.
d. Enter the number of points the activity is worth in the Points box.
e. Click Add.
The activity is added and displayed in the Gradebook.

4. Enter a grade for each student in the Average column.

Modifying the Gradebook
You can modify the information in the MimioStudio Gradebook in the following ways:

n Editing Student Information
n Removing a Student
n Editing Activities
n Editing Questions
n Editing Student Responses
n Grading Essay Questions

Editing Student Information
You can edit any information for an existing student, including the student name, student
ID number, MimioVote unit ID number, and address.

To edit student information
1. Select the student to edit.
2. Click Edit Student on the Student pane.

The Edit Student dialog box appears.
3. Make any desired changes to the student information.
4. Click OK to save your changes.
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Removing a Student
You can delete a student from a class at any time. Deleting a student permanently removes
the student from the class and removes all of their activity results from the Gradebook.

To remove a student from a class
1. Select the class that contains the student you want to remove.
2. Select the student to remove.
3. Choose Delete from the Edit menu.
4. Follow the instructions in the Confirm Delete dialog box, and then click OK.

The selected student and all information for the selected student is permanently deleted
from the Gradebook.

Editing Activities
You can edit the name, type, and weight for an activity at any time.

To edit an activity
1. Select the activity to edit.
2. Click Edit Activity on the Activity pane.

The Edit Activity dialog box appears.
3. In the Edit Activity dialog box, you can do any of the following:

l Enter a new name for the activity in the Name box.
l Choose a different activity type from the Type list.
l Enter a new weight for the activity in the Weight box.

4. Click OK to save your changes.

Editing Questions
Each time you stop polling for a question, a copy of the question, along with the correct
answer, is saved to the Gradebook. You can edit the question text, correct answer, question
type, and question weight at any time in Gradebook.

For example, if the answer that was selected as the correct answer in the question object is
incorrect, you can change the answer in the Gradebook to automatically update the student
scores.

Changing the answer for a question in the Gradebook does not automatically change
the answer in the question object in Notebook. To change the answer for subsequent
activities, you must make the correction to the question object in Notebook.

To edit a question
1. Select the question to edit.
2. Click Edit Question on the Question pane.
3. In the Edit Question dialog box, you can do any of the following:

l Edit the question or answer text under Question Information.
l Click the button to the left of the correct answer to change the correct answer for the
question.
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l Choose a different question type from the Type list.
l Enter a new weight for the question in the Weight box.

4. Click OK to save your changes.

Editing Student Responses
You can edit a student response to any question in a completed activity.

To edit a student response
1. Select the response to edit.
2. Click Edit Student Response on the Student Response pane.

The Edit Student Response dialog box appears.
3. In the Response box, edit the student response as needed.
4. Click OK to save your changes.

Grading Essay Questions
You can enter a grade for an essay question in a completed activity.

To grade an essay question
1. Select the essay question to grade.
2. Click Edit Student Response on the Student Response pane.

The Edit Student Response dialog box appears.
3. Under Score Student Response, do one of the following:

l Drag the Score slider to adjust the score for the essay question.
l Enter a score for the essay question in the Score box.

4. Click OK to save your changes.

Generating Reports
You can generate a variety of reports from MimioStudio Gradebook. Reports are generated
as HTML files and are displayed in your default Web browser.

You can generate the following types of reports:

n Class Grade Report- a grade report for all students in the selected class
n Class Activity Report - a detailed report for the selected activity
n Student Summary Report- a summary report of all activities for the selected student
n Student Activity Report - a detailed report for all selected activities for the selected

student

You can generate reports from the Class, Activity, and Student panes in Gradebook or from
the Report menu.

Exporting a List of Students
You can export a list of students from any class you have saved in Gradebook to a Unicode
tab-delimited text file (TXT).

To export a list of students
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1. Display the class that contains the students you want to export.
2. From the File menu, choose Export, and then choose Students.

The Export Students dialog box appears.
3. Select Export student information, and then click OK.

The Save As dialog box appears.
4. Enter a name for the file in the File name box, and then click Save.

Archiving Classes
You can archive your classes by exporting a class to a MimioStudio Gradebook Archive
(MVA) file. The archive file contains all student, activity, and results information. You can
use this file to backup your classes or to move classes from one Gradebook to another.

To archive a class
1. From the File menu, choose Export, and then choose Class.

The Export Class dialog box appears.
2. Select Export class information, and then click OK.

The Save As dialog box appears.
3. Enter a name for the archive file in the File name box, and then click Save.

Exporting Results
You can export class and activity results from the Gradebook to a Unicode tab-delimited
text file (TXT) or Comma separated values file (CSV) for use in another application. You
can export the following information:

n Class results - includes the class average for each student in the selected class.
n Class and activity results - includes the class average for each student as well as the

grade each student received for each activity
n Activity results - includes the grade for each student for the selected activity.
To export class results
1. From the File menu, choose Export, and then choose Class.

The Export Class dialog box appears.
2. Select Export class results, and then click OK.

The Save As dialog box appears.
3. Enter a name for the file in the File name box, and then click Save.
To export class and activity results
1. From the File menu, choose Export, and then choose Class.

The Export Class dialog box appears.
2. Select Export class and activity results, and then click OK.

The Save As dialog box appears.
3. Enter a name for the file in the File name box, and then click Save.
To export activity results
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1. From the File menu, choose Export, and then choose Activity.
The Export Activity dialog box appears.

2. Select Export activity and question results, and then click OK.
The Save As dialog box appears.

3. Enter a name for the file in the File name box, and then click Save.

Opening Archived Classes
You can open your archived class files at any time by importing the archive (MVD) file
into the Gradebook. Once imported, all classes in the archive file will appear along with
your current classes in the Gradebook.

To open archived classes
1. Choose Import Classes from the File menu.

The Open dialog box appears.
2. Navigate to and select the archive file to import, and then click Open.

Creating MimioVote Activities
You can create MimioVote activities in MimioStudio Notebook.

You can also use MimioStudio Quick Vote to ask questions that you did not
previously create in Notebook.

You can add the following types of questions to your activity:

n TF - True/False, Yes/No, or Agree/Disagree
n AB - Multiple choice, two possible answers
n ABC - Multiple choice, three possible answers
n ABCD - Multiple choice, four possible answers
n ABCDE - Multiple choice, five possible answers
n Numeric - One or more numeric answers (compatible with MimioMobile only)
n Short Answer - One or more alpha-numeric short answers (compatible with

MimioMobile only)
n Essay - A single alpha-numeric answer (compatible with MimioMobile only)

Creating Activities in Notebook
You can use MimioStudio Notebook to create any type of MimioVote activity. Activities
are created by adding question objects to Notebook pages. The Questions and Results folder
in MimioStudio Gallery includes a wide variety of pre-designed question objects to make
creating activities in Notebook quick and easy.

Each question object contains a single question, and each question must be on a
separate Notebook page.

Once you've added a question object to an activity, you can customize the object properties
to change the appearance or behavior of the question object.

To create an activity in Notebook
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1. Open a new or existing Notebook.
2. In MimioStudio Gallery, click the arrow next to the Questions and Results folder, and

then select the Questions folder.
3. Drag the desired question object from the Gallery into the Notebook.

Only one question object can be placed on each Notebook page.
4. Enter the question text in the Question box.
5. Do one of the following:

l For a multiple choice question, enter an answer choice for the question in each of
the Answer boxes.

l For a numeric question, enter a numeric answer for the question in the Answer box.
If there is more than one possible answer, separate each answer with a
carriage return.

l For a short answer question, enter an alpha-numeric answer for the question in the
Answer box.
If there is more than one possible answer, separate each answer with a
carriage return.

l For an essay question, you can choose to enter an example answer, a note, or no
answer in the Answer box.

6. If applicable, select the correct answer.
7. To add another question to the activity, do the following:

a. Click  to add a new page to the Notebook.
b. Repeat steps 3-6 to add a question to the new page.

Modifying Question Objects
MimioStudio Gallery includes a variety of pre-designed question objects for creating
MimioVote activities. Once you add a question object to a Notebook page, you can use the
question objects as is or you can choose to change the properties of the question object.
You can change the question type, animation for correct answers, and question weight.
To modify a question object

1. Click  at the bottom-right of the question object you want to modify.
The question object properties appear.

2. In the question object properties, you can do any of the following:
l To change the question type, select an available question type.
l To change the correct answer animation, select an available animation.
l To change the weight of the question, enter the weight for the question in the
weight, , box.

l To change the number of correct answers required for a numeric or short answer
question, enter the number of correct answers required in the number of correct

answers required, , box.
3. Click  to save your changes and display the question object.
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Importing Standard Assessments
You can import standard assessments into MimioStudio Notebook for use with MimioVote.

Only files that have been exported from ExamView® as Blackboard® (6.0-7.0) format can be
imported into Notebook.

For information about installing ExamView®, and downloading and exporting
ExamView® files, see the ExamView® documentation.

To import a standard assessment

1. Start MimioStudio Notebook, and then click .
The Open dialog box appears.

2. Navigate to and select the file to import, and then click Open.
The file is imported and displayed in Notebook.

Printing Activities
You can print an activity from Notebook to use as a self-paced activity. Normally, when
you print a Notebook presentation, each page of the Notebook prints on a separate page.
However, you can choose to print the activity so that multiple questions appear on a single
page.

When you choose to print an activity, an HTML file is created from the Notebook
activity. The HTML file contains all question and answer text, but no images. You can
choose to print or save the HTML file.

To print an activity
1. Open the activity to print.
2. Do one of the following:

l Click  on the Vote Toolbar.
l Choose Print Test from the File menu.
The Select Class dialog box appears.

3. Select the class to print the activity for from the Class list, and then click OK.
The activity is displayed as an HTML file in your default Web browser.

4. Choose Print from the File menu.
The Print dialog box appears.

5. Click Print.

Using the MimioVote Unit
Each MimioVote unit is assigned to one student per class. Students should use their
assigned MimioVote unit each time an activity is conducted.

Students can also use a mobile device with MimioMobile to participate in an activity.
For more information about MimioMobile, see MimioMobile.

By default, each button on the MimioVote unit is illuminated with a different color light.
You can choose to turn off the colors and have all the buttons illuminated with a white

For
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information about changing the button colors, see Adjusting the Vote Settings.

Answering Questions
Depending on the type of question being asked, the appropriate buttons are illuminated on
the MimioVote unit.

For example, when polling is started for a True/False question, only the and buttons
are illuminated on each MimioVote unit. The A, B, C, D, and E buttons are not illuminated
and will not register a response if pressed.

Answering Questions for Teacher-Led Activities
For teacher-led activities, questions are answered one at a time as they are displayed.

To answer a question
Press the button on the MimioVote unit that corresponds to the correct answer for the
displayed question.

Answering Questions for Self-Paced Activities
For self-paced activities, questions can be answered in any order. The current question
number is displayed on the MimioVote unit. For each question, the available answer
buttons are illuminated, as well as the next and previous buttons.

To answer questions in a Self-Paced activity
1. Press the button on the MimioVote unit that corresponds to the correct answer for the

first question.
The unit automatically advances to the next question. The current question number
appears in the unit display.

2. Repeat step 1 for each remaining question in the activity.
You can change your answer to any question at anytime before submitting your
answers. Use and  to move through the questions and review or change any
answers as desired. The currently selected answer button flashes.

3. When all questions in the activity have been answered, press .
You must answer every question before submitting the activity. The  button will not
become available until all questions have been answered.

Requesting Help
A student can request help or request to ask a question at anytime using the MimioVote
unit.

To request help
Press  on the MimioVote unit.

For information about viewing help requests, see Viewing Requests for Help.
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Using the Vote Toolbar
The Vote Toolbar includes all the tools you need for taking attendance, conducting class
activities, gathering student responses, and viewing results.

Taking Attendance
You can quickly take attendance and record the results using MimioVote.

To take attendance
1. Select the class to take attendance for from the Class list.
2. Click  on the Vote Toolbar.

A list of all students in the selected class is displayed in the Attendance window.
As each student indicates that they are present, the icon for that student is illuminated.
A student indicates they are present by pressing on their MimioVote unit.

3. Close the Attendance window to stop taking attendance and save the results to the
Gradebook.

Using the Timer
The timer on the Vote Toolbar displays the amount of time that has passed since you started
polling.

The timer automatically starts each time you start polling and automatically stops each
time you stop polling.

Conducting Activities
Using MimioVote, you can perform teacher-led or self-paced activities. Review the
following topics for information about conducting activities.

n Conducting a Teacher-Led Activity
n Asking Questions Using Quick Vote
n Conducting a Self-Paced Activity
n Viewing Question Results
n Viewing Session Results
n Viewing a List of Students that Have Not Responded

Conducting a Teacher-Led Activity
Once you have created an activity in Notebook,you can perform the activity with your
class. When performing a Teacher-Led activity, the questions are displayed one at a time for
the students.

You can ask questions that you did not previously create in Notebook at any time
during a Teacher-Led activity using MimioStudio Quick Vote

To conduct a teacher-led activity
1. Open the Notebook presentation that contains the activity you want to conduct.
2. Select the class that will participate in the activity from the Class list.
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3. Display the first question for the class.
4. Click  on the Vote Toolbar to start polling for the question.

In Notebook, you can also start and stop polling directly from the question object
by clicking .

When all students have responded, polling for the question stops and the results are
saved to the Gradebook.

5. To stop polling for a question before all students have responded, click .
Polling stops and the results are saved to the Gradebook.

6. Repeat steps 4-6 for each remaining question in the activity.
7. When all questions in the activity have been answered, close the presentation and the

Vote Toolbar to stop the activity.

Asking Questions Using Quick Vote
Using the MimioStudio Quick Vote, you can ask questions that you did not previously
create in Notebook at any time during a Teacher-Led activity.

To ask a question using Quick Vote
1. Do one of the following to start Quick Vote:

l Right-click , and then choose Quick Vote.
l (Interactive mode Only) Press the Launch button, , on the MimioTeach bar, and
then click Quick Vote.

2. Select the class that will participate in the activity from the Class list.
3. Click , and then choose the question type to start polling for the question.

When all students have responded, polling for the question stops.
4. To stop polling for a question before all students have responded, click .
5. Click the letter that corresponds to the correct answer for the question.

The results for the current question are saved to the Gradebook along with a screen
shot.

Conducting a Self-Paced Activity
Once you have created an activity in Notebook,you can perform the activity with your
class. When performing a Self-Paced activity, each student must have a printed copy of all
questions in the activity. For information about printing activities, see Printing Activities.

To conduct a self-paced activity
1. Open the Notebook presentation that contains the activity you want to conduct.
2. Select the class that will participate in the activity from the Class list.

3. Click .
The Self-Paced Test window appears.

4. (Optional) Use the and buttons to set the timer.
The timer displays the amount of time left for the activity.

If you do not set the timer, the timer displays the amount of time that has passed
since polling started.
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5. Click  to start polling for all questions.
Each student can move through the questions at their own pace using the and
buttons on their MimioVote unit.
When all students have submitted their responses or when the timer runs out, polling
for the activity stops and the results are saved to the Gradebook.

6. To stop polling for an activity before all students have submitted their response or
before the timer runs out, click .
All results for the activity are saved to the Gradebook.

Viewing Question Results
You can instantly view the results for a question as soon as you stop polling. There are a
variety of ways to view the results for a question.

To view the result for a question

1. Click , and then choose Question Results.
The Question Results window appears.

2. To modify the appearance of the results, click .
You can change the type and colors of the graph shown. You can also choose to
show the number or percentage of correct answers.

3. Click  to save your changes and view the results.

Viewing Activity Results
You can instantly view the results for an activity as soon as you stop polling. There are a
variety of ways to view the results for an activity.

To view the result for an activity

1. Click , and then choose Activity Results.
The Activity Results window appears.

2. To modify the appearance of the results, click .
3. Click  to save your changes and view the results.

Viewing a List of Students that Have Not Responded
While you are polling a class, the number of students that have responded to the current
question is displayed on the Vote Toolbar. You can quickly view a list of all students that
have not yet responded.

To view a list of students that have not responded

Click  on the Vote Toolbar.

A list of students that have not yet responded is displayed in a separate window.

Viewing Requests for Help
Using their MimioVote unit, a student can request help or request to ask a question at
anytime. For information on using the MimioVote unit to request help, see Requesting
Help.
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You can quickly view a list of all students that have requested help.

To view students requesting help

1. Click  on the Vote Toolbar. 
A list of students that have requested help is displayed in a separate window.

2. Click the icon for a student to remove that student from the list.

Caring For MimioVote
Review the following topics for information about cleaning and storing your MimioVote
system.
n Cleaning MimioVote
n Storing MimioVote

Cleaning MimioVote
The MimioVote is designed to give you long and trouble-free service, while requiring very
little maintenance.

You can easily clean your MimioVote using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the MimioVote station and units
1. Disconnect the power cable.
2. Use the lint-free cloth to wipe the exterior of the MimioVote station and each

MimioVote unit.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Avoid using liquids on any exposed charging contacts. Do not allow liquid into
any openings on the equipment.

4. Reconnect the Power cable.

Storing MimioVote
The MimioVote system comes with a carrying case for your MimioVote station and
MimioVote units. You can use this case to transport the system and to safely store your
MimioVote system when not in use.
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MimioView 340H
MimioView works seamlessly with MimioStudio software to display documents, three-
dimensional objects, and microscope slides for your entire class to view. You can use
MimioView to display still images or live video.

What's Included
The MimioView package contains the following items:

1 Microscope adapter

2 MimioView visual presenter

3 USB cable

If you are missing any of the items above, contact Customer Support.
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About MimioView
You can use the MimioView visual presenter to display documents, three-dimensional
objects, and microscope slides.

The MimioView visual presenter and lamps are each attached to the MimioView base by a
flexible, gooseneck. This allows you to precisely position the camera and each lamp for the
best possible view of the object you are displaying.

The following figure shows the major components of the MimioView visual presenter.

1 Camera head 5 View button

2 Auto focus 6 Status light

3 LED lamps 7 Kennsington lock slot

4 Auto tune, Rotate, and Freeze buttons 8 Type B USB port

Status Lights
The status light visually shows the status of the MimioView visual presenter.

Off Not receiving power; USB cable is not connected or computer is turned off.

Solid Green MimioView is connected and receiving power; MimioStudio software is
running.

Flashing Green
MimioView is connected and receiving power; MimioStudio software is not
running.
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About MimioStudio View
The View window displays the image captured by the MimioView visual presenter. From
the View window, you can rotate or zoom the image, mark up the image using
MimioStudio Tools, adjust the contrast and brightness settings, freeze the image, and so on.

The following table describes the major features of the MimioStudio View window.

Lamps on/off Copy selected portion of image

Auto tune Zoom in

Adjust brightness and contrast Zoom out

Rotate counter-clockwise 90 degrees Zoom to fit window

Rotate clockwise 90 degrees Open MimioStudio Tools

Freeze/Unfreeze image View full screen

Clear all markups

Getting Started
Review the following topics to install and start using MimioView.

n Installing MimioView
n Opening the View Window
n Closing the View Window

Installing MimioView
Once you have installed the MimioStudio software on your computer, you can quickly
install MimioView.

To install MimioView
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1. Remove the protective covering from the MimioView camera lens.

2. Plug the USB cable into the Type-B female USB port on the back of the visual
presenter base.

3. Connect the other end of the USB cable into an available USB port on your computer.

Opening the View Window
When you press the View button on the MimioView, the camera and lamps turn on and the
MimioStudio View window opens automatically.

To open the View window
Press  on the MimioView base.

The MimioStudio View window opens and the camera and lamps turn on.

Closing the View Window
You can close the MimioStudio View window from the View window or directly from the
MimioView visual presenter.

To close the View window
Do one of the following:
l Close the MimioStudio View window.
The camera and lamps turn off automatically.

l Press  on the visual presenter base.

The camera and lamps turn off and the MimioStudio View window closes.
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Using MimioView
You can use MimioView to display a still image or live video of documents, three-
dimensional objects, or microscope slides. You can also use MimioStudio Tools to mark up
the still image or live video displayed in the View window; you can then save the image to
a Notebook or the Gallery for later use.

Displaying an Image
You can use MimioView to display a still image or live video of documents, three-
dimensional objects, or microscope slides.

Displaying a Document
You can use MimioView to display a document, book, or other two-dimensional object.

To display a document
1. Place the document under the MimioView visual presenter.
2. Adjust the camera head so that the desired image is displayed in the View window.
3. Adjust the lamps to light the document as desired.
4. Press  on the MimioView base.

Displaying an Object
Using MimioView, you can display a three-dimensional object. The camera and lamps are
each attached to the MimioView base by a flexible, gooseneck. This allows you to precisely
position the camera and lamps for the best possible view of the object you are displaying.

To display a three-dimensional object
1. Place the object under the MimioView visual presenter.
2. Adjust the camera head so that the desired image is displayed in the View window.
3. (Optional) Press  to rotate the image to the desired orientation.
4. Adjust the lamps to light the object as desired.
5. Press  on the MimioView base.

Displaying a Microscope Slide
Using the included microscope adapter, you can display an image from a microscope with
the MimioView visual presenter.

The microscope adapter can be used with a 28 mm microscope eyepiece.

To display a microscope slide
1. Set up the microscope so that you have the desired view through the microscope

eyepiece.
2. Twist and lock the microscope adapter onto the MimioView visual presenter head.
3. Slowly and carefully slide the other end of the microscope adapter onto the microscope

eyepiece.
Use caution to make sure that the image stays in focus while attaching the
microscope adapter.
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The image from the microscope is displayed in the View window.
4. Make any adjustments necessary to the microscope to adjust the image.
5. Press  on the MimioView base.

Freezing the Image
The image captured by the MimioView visual presenter is displayed in the View window.
By default, a live image is displayed. However, you can choose to display a still image of
the object.

To freeze the image
Do one of the following:
l Press  on the MimioView base.

l Click  on the View toolbar.

The image is paused in the View window.

To return to displaying live video, press or click  a second time.

Adjusting the Image
MimioView includes features that make it easy to adjust the image displayed in the
MimioStudio View window without having to adjust the camera or the displayed object.

You can do the following to adjust the displayed image:

n Rotate the Image
n Zoom the Image
n Adjust the Settings

Rotating the Image
You can quickly rotate the image that is displayed in the View window directly from the
MimioView visual presenter or from the View window.

To rotate an image from the MimioView visual presenter
Press  on the MimioView.

The image displayed in the View window rotates clockwise 90 degrees.
To rotate an image from the View window
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Do one of the following:

l To rotate the image clockwise, click .

l To rotate the image counter-clockwise, click .

The image displayed in the View window rotates 90 degrees in the selected direction.

Zooming the Image
You can quickly zoom the image displayed in the View window.

You can also zoom the image displayed in the View window using the Zoom tool in
MimioStudio Tools.

To zoom the image
Do one of the following:
l To zoom in on the image, click  on the toolbar.

l To zoom out on the image, click  on the toolbar.

l To fit the image to the MimioStudio View window, click  on the toolbar.

If the area of the image that you want to display is not visible in the View window, use
the scroll bars to display the desired area of the image.

Adjusting the Settings
You can adjust the brightness and contrast settings automatically or manually.

To adjust the settings automatically
n Do one of the following:

l Press  on the MimioView base.

l Click  on the View toolbar.

To adjust the settings manually

1. Click  on the View toolbar.
The Advanced Settings toolbar appears.

2. Move the Brightness and Contrast sliders to the right or left to adjust the settings as
desired.

3. Click  to hide the Advanced Settings toolbar.

Annotating an Image
You can use MimioStudio Tools to annotate the image displayed in the View window.

You can also add objects to the View window from MimioStudio Gallery.

See Adding Objects with MimioStudio Tools for information about using MimioStudio
Tools.

The following object, drawing, and manipulation features in MimioStudio Tools are
available to use in the View window.
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Selection tool Zoom

Pen Brush

Text Highlighter

Line Arrow End

Arrow Start Arrow Both

Rectangle Ellipse

Triangle Right Triangle

Five Pointed Star Hexagon

Pentagon Shape Recognition

Eraser Insert file

Color picker More colors

Object Fill Thickness slider

Outline and Fill color Color palette

Solid Line Dash Line

Square Dot Line Transparency

Clearing All Annotations from the Image
You can quickly clear all annotations from the View window.

To clear all annotations

Click  on the View toolbar.

All annotations, including any added objects, are cleared from the View window.

Transferring an Image
You can transfer all or part of an image from the View window to a Notebook page, the
Gallery, or another application.

146



Caring For MimioView

To transfer an image

1. Click  on the View toolbar.
The Image area is displayed with a transparent mask.

2. Drag the cursor to draw a selection box around the area to copy.
The selected area is saved as an image to the clipboard.

3. Paste the image into the desired application.

Turning Off the Lamps
When you turn on MimioView, the camera and both lamps turn on. However, you can
choose to turn off the lamps and use the camera without the lamps.

To turn off the lamps

n Click  on the View toolbar.

To turn the lamps on again, click  a second time.

Caring For MimioView
Review the following topics for information about cleaning, storing, and mounting your
MimioView.

n Cleaning MimioView
n Mounting MimioView Permanently

Cleaning MimioView
The MimioView is designed to give you long and trouble-free service, while requiring very
little maintenance.

You can easily clean your MimioView using the following items:

n Lint-free cloth.
n Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner.

If you use glass cleaner, make sure it does not contain ammonia.

To clean the exterior of the MimioView
1. Disconnect the USB cable.
2. Use the lint-free cloth to wipe the exterior of the MimioView.
3. Remove dirt and smudges with one of the cleaning solutions mentioned above.

Do not allow liquid into any openings on the equipment.

4. Reconnect the USB cable.
To clean the camera lens

Use a clean, dry, lint-free cloth to gently wipe the surface of the lens.

Mounting MimioView Permanently
You can permanently mount your MimioView to a table or desk top using a standard VESA
mount and four screws (size M4).
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To mount MimioView permanently
1. Attach the VESA mount to the table or desktop.

For information about attaching the VESA mount to your table or desktop, see the
VESA documentation.

2. Attach the VESA base to the bottom of the MimioView as shown.

MimioView Safety Notices
Carefully read all recommendations and precautions for use before using this product.
n This product should not be used near water such as sinks, etc.
n Do not place this product near any heat sources such as radiators, warm air intakes, etc.
n Use only accessories specified by the manufacturer.
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MimioPad
(Model Number: ICD07)

With the new MimioPad teachers and students can collaborate using interactive whiteboard
lessons from up to 30 feet away from the computer. The MimioPad can be used alone with
MimioStudio classroom software or in conjunction with MimioTeach interactive system and
other MimioClassroom products. Anything you write and draw on the MimioPad appears
instantly on the whiteboard.

MimioPad can be used in teacher mode or student mode. When more than one MimioPad is
used in the same classroom, the first MimioPad turned on starts up in teacher mode,
providing complete desktop control. Each addtional MimioPad automatically starts up in
student mode. Teachers can pass desktop control to any MimioPad in student mode and
initiate group activities so that all students with a MimioPad can simultaneously participate
in an activity.

For information about the original MimioPad tablet, refer to MimioPad Model Number:
RCK-M01.

What's Included
The MimioPad package contains the following items:

1 MimioPad 4 Replacement pen tip

2 Pen 5 Shortcut key reference card

3 USB cable

If you are missing any of the items above, contact Customer Support.
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About MimioPad
Become familiar with the features of your MimioPad as shown in the following illustrations.

1 Active area 4 LCD display

2 Shortcut keys 5 Page up

3 Power button/Status light 6 Page down

Status Light
The status light visually shows the status of the MimioPad tablet.

Off Not receiving power; MimioPad is turned off.

Solid Green MimioPad is connected and MimioStudio software is running.

Flashing Green MimioPad is connected or connecting and MimioStudio software is not running.

Solid Amber MimioPad cannot find an available MimioHub.

Flashing Amber MimioPad is searching for an available MimioHub.

About the Feature Indicators
The feature indicators on the LCD display are described below.
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Connected The MimioPad is connected to your computer.

Pen connected The pen is within sensing distance of the MimioPad.

Teacher mode The MimioPad is in Teacher mode.

ID number
Shows the ID number of the MimioPad. Each connected
MimioPad is assigned a different ID number.

Battery indicator Shows how much charge is left in the MimioPad battery.

Getting Started
Your MimioPad is installed at the same time you install the MimioStudio software. Follow
these instructions to begin using your MimioPad.

Charging the MimioPad
The MimioPad battery is charged using the included USB cable. The Li-ion MimioPad
battery may contain some charge right out of the box. However, for best results, completely
charge the battery before using the MimioPad. The first time you charge the battery may
take up to 5 hours.

The following table describes the possible states of the battery indicator.

Battery Indicator Status Description

Battery indicator is solid Battery is fully charged

Battery segments rotate Battery is charging

Battery outline blinks Less than 30 minutes of battery life left

Battery segments and outline blink Charging error

No battery indicator displayed Battery not inserted

To charge the battery
1. Plug the USB cable into the pad and into your computer.
2. If the MimioPad is turned off, press the power button to turn the MimioPad on.
3. When the battery is fully charged, unplug the USB cable from the pad and your

computer.

Configuring MimioPad
The MimioPad connects to your computer using the standard MimioHub.

To configure MimioPad
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1. Plug the MimioHub into a USB port on your computer
2. Turn on the MimioPad.

Once the power is on, the MimioHub will detect the MimioPad.
3. When prompted by the software, click Yes to connect the MimioPad to the MimioHub.

The MimioPad is connected to your computer. If this is the first or only MimioPad
connected to this computer, the MimioPad is started in teacher mode and displays the
teacher mode icon.
If you do not see the prompt, see Adjusting the Classroom Devices Settings for
information about connecting available devices to your computer.

Replacing the MimioPad Battery
The MimioPad battery can easily be replaced if necessary. To replace the battery, you will
need a screwdriver.

To replace the battery
1. Using a screwdriver, remove the screw from the battery compartment cover.
2. Remove the battery compartment cover.
3. Remove the battery from the battery.
4. Insert the new battery.
5. Replace the battery compartment cover and replace the screw.

Using MimioPad

Using the Shortcut Keys
Shortcut keys are available across the top of the active area of the pad. These keys allow
you to quickly access features in the MimioStudio software.

Selection Tool Redo

Pen Tools

Highlighter Screen Annotation

Eraser Text Tool

Cut MimioVote

Copy MimioView

Paste Control

Undo Launch

For more information about these features, see MimioStudio, MimioVote, and MimioView.
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Using MimioStudio Collaborate
Using the MimioPad, you can conduct a group activity. The display automatically divides
into individual workspaces, depending on the number of MimioPad tablets connected to
your computer.

You can use Collaborate in one of two ways.

n Quick Collaborate - displays a blank page for each student
n Collaborate - displays the current Notebook page for each student

When you exit from Collaborate, each student workspace is automatically archived as a
separate MimioStudio Notebook page in the Collaborative Sessions folder in MimioStudio
Gallery.

The following table shows several ways to access Collaborate.

To start from Do this

Notification area Right-click , and then choose Quick Collaborate.

MimioStudio Tools Click the Applications button, , and then choose Quick
Collaborate.

MimioStudio Notebook

Do one of the following:

n Click the Collaborate button, .

n Choose Collaborate from the Tools menu.

Maximizing a Workspace
You can maximize a student workspace to highlight individual work for the class. You can
maximize a student workspace from the MimioPad or from MimioStudio.

To maximize a workspace
Double-click the student name at the bottom of the workspace to maximize the
workspace.
The selected workspace is displayed in full-screen mode.

Sharing Control
You can pass desktop control to any active MimioPad.
To share control

1. Click the Applications button, , and then choose Control.
2. Click the student tablet to pass control to.

Pairing an Additional MimioPad with the MimioHub
Each MimioPad connects to your computer using the standard MimioHub.
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You can use the same MimioHub to connect all of your MimioClassroom devices to
your computer.

To pair an additional MimioPad with the MimioHub
1. Turn on the MimioPad.

Once the power is on, the previously installed MimioHub will detect the MimioPad.
2. When prompted by the software, click Yes to connect the MimioPad to the MimioHub.

The second MimioPad is connected to your computer and the appropriate number is
assigned to the MimioPad automatically.

If you do not see the prompt, see Adjusting the Classroom Devices Settings for
information about connecting available devices to your computer.

Replacing the Lanyard with the Pen Tip
The MimioPad comes with a lanyard attached to the pen. You can remove the lanyard and
attach the included additional pen tip.

To replace the lanyard with the pen tip
1. Turn the lanyard attachment counter-clockwise to remove the lanyard from the pen.

2. Place the additional pen tip on the pen and turn clockwise to attach the lanyard.
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MimioPad is a 2.4 GHz wireless pad. To configure MimioPad for use, install the
MimioStudio software and plug the wireless receiver into your computer. Once connected,
you can use the MimioPad from anywhere in the room to interact with your computer. No
additional configuration is required.

For information about the new MimioPad tablet, refer to MimioPad Model Number
ICD07.

What's Included
The MimioPad package contains the following items:
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1 MimioPad 6 Wireless receiver

2 Extra pen tips (inside MimioPad battery
compartment)

7 Pen battery

3
Pen tip extractor (inside MimioPad
battery compartment)

8 Pad battery

4 Pen 9 Quick Start Guide

5 USB cable

If you are missing any of the items above, contact Customer Support.

About MimioPad
Become familiar with the features of your MimioPad as shown in the following illustrations.
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1 Active area 7 Page up/Page down
Volume up/Volume down

2 Shortcut keys 8 Wireless receiver storage

3 LCD display 9 Learning button

4 Power button 10
Battery compartment (extra pen tips and
pen tip extractor)

5 USB connection 11 Learning button/LED

6 Pen slot

About the Feature Indicators
The feature indicators on the LCD display are described below.

Power The power is on.

Battery Indicator Shows how much charge is left in the MimioPad battery.

Power Saving Mode
Power saving mode is on. The MimioPad enters power saving mode
when the pen is away from the active area for three seconds.

Connected The MimioPad is connected to your computer.

Wireless Activity The wireless receiver is active.

Pen Sensor Blinking: Pen tip is in range of active area; indicates hover mode.
Solid: Pen tip is touching active area; indicates left-click.

Pad Number
When more than one MimioPad is connected to a receiver, shows the
number of the connected MimioPad.

Getting Started

Setting Up the MimioPad
Your MimioPad is installed at the same time you install the MimioStudio software. Follow
these instructions to begin using your MimioPad.

To insert the battery
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1. Press down and slide off battery compartment cover.
2. Insert the battery.

3. Replace the battery compartment cover.

Charging the Battery
The MimioPad battery is charged using the included USB cable. The Li-ion MimioPad
battery may contain some charge right out of the box. However, for best results, completely
charge the battery before using the MimioPad. The first time you charge the battery may
take up to 10 hours. After the initial charge, recharging of the battery will take
approximately two hours.

To charge the battery
1. Plug the USB cable into the pad and into your computer.
2. When the battery is fully charged, unplug the USB cable from the pad and your

computer.

Setting Up the Pen
The pen uses one AAA battery.

To insert the pen battery
1. Twist the top of the pen counterclockwise.

2. Lift the battery cover, and insert battery as shown.

3. Replace battery cover and pen top.

Configuring MimioPad
Delete this text and replace it with your own content.

To configure MimioPad
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1. Plug the wireless receiver into a USB port on your computer.
2. Press and hold the power button on the pad for at least three seconds to turn on the

power.
3. Place the pen tip anywhere on the active area of the pad to wake up the pad.
4. Verify that the LCD display shows at least the following indicators.

Your MimioPad is now ready to use.

Using MimioPad

Using the Shortcut Keys
Shortcut keys are available across the top of the active area of the pad. These keys allow
you to quickly access features in the MimioStudio software.

Selection Tool Screen Clipping

Pen Screen Annotation

Highlighter Text Tool

Eraser Spotlight Tool

Cut Reveal Tool

Copy Notebook

Paste Tools

New Page Recorder

For more information about these features, see MimioStudio and MimioStudio Recorder.

Changing the Pen Tip
After a period of use, you may need to replace the pen tip. Extra pen tips and a pen tip
extractor are located inside the pad battery compartment.

To change the pen tip
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1. Squeeze the pen tip with the tip extractor, and then pull out to remove the tip.

2. Push the new tip into the pen, and then press the pen tip down on a hard surface to
secure.

Pairing an Additional MimioPad with the Wireless Receiver
To pair and additional MimioPad with the wireless receiver
1. Plug the wireless receiver into a USB port on your computer.
2. Turn on the power to the MimioPad.
3. Simultaneously, press the learning button on the back of the MimioPad and the learning

button on the wireless receiver.

The LCD screen on the MimioPad and the LED light on the wireless receiver will blink
during the process. When the learning process is complete, the number on the LCD will
show the number assigned to the additional pad (001 or greater).
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Using the MimioMobile app on a mobile device, teachers and students can collaborate
using interactive whiteboard lessons. The MimioMobile app can be used alone with
MimioStudio software or in conjunction with MimioTeach interactive system and other
MimioClassroom products.

The MimioMobile app is available for the following devices:

n iPad® 2 or later, running iOS 5 or later
n iPhone® 4 or later, running iOS 5 or later
n iPod touch® 4th generation or later, running iOS 5 or later
n Mobile device running Android™ 3.0 (Honeycomb) or later

MimioMobile can be used by both students and teachers. Teachers can pass desktop control
to any student mobile device and initiate group activities so that all students with a mobile
device can simultaneously participate in an activity. Students can also use a mobile device
with MimioMobile in place of a MimioVote unit.

Mobile devices with the MimioMobile app can be used in conjunction with the new
MimioPad tablet.
For information about the MimioPad tablet, see MimioPad.

Getting Started
Review the following sections for more information about getting started with
MimioMobile.

n Installing the Software
n Connecting Mobile Devices

Installing the Software
To start using MimioMobile, you must first do the following:

n Download and install MimioStudio software from the Mimio Web site at
www.mimio.com.

n Install the MimioMobile app on the teacher mobile device and on each student mobile
device. The MimioMobile app is available from the Apple App Store℠ and the Google
Play™ Store.

n Launch MimioStudio software and activate the software using one of the following
methods:
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l Connect a Mimio device
l Enter an activation code (provided with a Mimio hardware device)
l Start Evaluation mode

To activate the software using an activation code
1. Choose Activate Software from the Help menu.
2. Under Installed Software, select one of the following:

l MimioMobile - to activate MimioMobile
l MimioStudio - to activate MimioStudio

3. Click Activate Code.
The MimioStudio Activation dialog box appears.

4. Enter the activation code in the Activation Code box, and then click OK to activate
the software.

5. Click OK to close the dialog box.

Connecting Mobile Devices
Once you have installed MimioStudio software and the MimioMobile app, you can connect
the teacher and student mobile devices to your computer.

Connecting a Teacher Mobile Device
You can quickly connect a teacher mobile device to your computer using the MimioStudio
Mobile Settings or Preferences.
To connect the teacher mobile device
1. Start MimioStudio Settings.

2. Select Mobile.

3. Tap on your mobile device to start MimioMobile.
4. Under Connection Methods, tap QR scan.
5. Tap the QR code image on the mobile device to launch the camera.
6. Align the guides on the device screen with the QR code in MimioStudio to scan the

QR code.
The device connects to your computer and the desktop is displayed on your mobile
device.

Connecting Student Mobile Devices
You can connect student mobile devices using MimioStudio Class Manager.

To connect a student mobile device
1. Do one of the following to start Class Manager:

l From MimioStudio Tools, click the Applications button, , and then choose
Class Manager.

l From the notifications area, right-click , and then choose Class Manager.
2. Select the class to connect the device for, and then click Start Class.
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3. Tap on the student device to start MimioMobile.
4. Under Connection Methods, tap QR scan.
5. Tap the QR code image on the mobile device to launch the camera.
6. Align the guides on the device screen with the QR code in MimioStudio to scan the

QR code.
7. On the mobile device, tap the name of the student using the device.
8. Tap Yes to confirm the selection.

Using History Connect
When you connect a mobile device to a computer, your connections are saved in the
MimioMobile connection history. You can use this history to quickly reconnect your
mobile device.

Connections to Anonymous classes are not saved to the connection history.

To connect your mobile device using connection history

1. Tap on your mobile device to start MimioMobile.
2. Under Connection Methods, tap History.
3. Select the class or teacher computer to connect to.
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Using Manual Connect
You can connect your mobile device to your computer manually, without scanning the QR
code, by entering your network information.

To manually connect your mobile device

1. Tap on your mobile device to start MimioMobile.
2. Under Connection Methods, tap Manual.
3. Tap one of the following:

l Teacher - to connect the device as a Teacher device
l Student - to connect the device as a Student device

4. Enter the required information, and then tap Connect.
The required information to connect as a Teacher device can be found under the QR
code in MimioStudio Mobile Settings/Preferences.
The required information to connect as a Student device can be found under the QR
code in Class Manager.

Using MimioMobile
Review the following sections to learn more about using MimioMobile.

n Using the Shortcut Keys
n Using Class Manager
n Using MimioStudio Collaborate
n Sharing Control
n Using MimioStudio Vote

Using the Shortcut Keys
Shortcut keys are available across the top of the active area of the mobile device. These
keys are always available on a teacher device, but are only available on a student device
when the teacher has given the student desktop control. See Sharing Control for more
information about sharing desktop control.

The shortcut keys allow you to quickly access features in MimioStudio software.
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Selection Tool Redo

Pen Tools

Highlighter Screen Annotation

Eraser Text Tool

Cut MimioVote

Copy MimioView

Paste Control

Undo Launch

For more information about these features, see MimioStudio, MimioVote, and MimioView.

Using Class Manager
Using MimioStudio Class Manager, you can view the mobile device connection
information, connect student mobile devices, and take class attendance.

For information about connecting student devices, see Connecting Student Mobile Devices.

The following table shows several ways to access Class Manager.

To start from Do this

Notification area Right-click , and then choose Class Manager.

MimioStudio Tools Click the Applications button, , and then choose
Class Manager.

To view connection information
1. Select the class to view, and then click Start Class.
2. If connection information is necessary for troubleshooting, click Show Details under the

QR code.

Using MimioStudio Collaborate
Using a mobile device with MimioMobile, you can conduct a group activity. The display
automatically divides into individual workspaces, depending on the number of student
mobile devices connected to your computer.

You can use Collaborate in one of two ways.

n Quick Collaborate - displays a blank page for each student
n Collaborate - displays the current Notebook page for each student
The following table shows several ways to access Collaborate.
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To start from Do this

Notification area Right-click , and then choose Quick Collaborate.

MimioStudio Tools Click the Applications button, , and then choose Quick
Collaborate.

MimioStudio Notebook

Do one of the following:

n Click the Collaborate button, .

n Choose Collaborate from the Tools menu.
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Maximizing a Workspace
You can maximize a student workspace to highlight an individual workspace for the class.

To maximize a workspace
Double-click the student name at the bottom of the workspace to maximize the
workspace.
The selected workspace is displayed in full-screen mode.

Using the Collaborate Toolbar
When the teacher starts Collaborate, each student mobile device displays the Collaborate
toolbar. Students use the tools available in the toolbar to draw and write in their workspace.

Selection tool
You can select and move items using the selection tool.

Pen
You can select the line color and width.

Highlighter
You can select the line color and width.

Eraser
You can select the line width.

When the teacher exits from Collaborate, each student workspace is automatically archived
as a separate MimioStudio Notebook page in the Collaborative Sessions folder in
MimioStudio Gallery.

Sharing Control
You can pass desktop control to any active student mobile device.
To share control
1. Do one of the following:

l Click the Applications button, , and then choose Control.

l Tap on the teacher mobile device.
2. Select the student device to pass control to.

Using MimioStudio Vote
A student mobile device with MimioMobile can be used along with MimioStudio Vote.
The student mobile device can be used in place of a MimioVote voting unit. When the
teacher starts a Vote activity, the answer choices are displayed on the student mobile
device.

For more information about MimioStudio Vote, see Using the Vote Toolbar.
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MimioProjector
What's Included

The MimioProjector package contains the following items:

CR2025

3V

1

2
3

4

5

1 Remote control 4 Power cord

2 Remote control battery 5 Projector with lens cap

3 VGA cable

If you are missing any of the items above, contact Customer Support.
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About MimioProjector
The following figure shows the major components of the MimioProjector.

1

2

3

4

5

6

7

8

9

8

Front View

Back View

Bottom View

1 Focus ring 6 Input/Output connection ports

2 Lens 7 Power connector

3 Control panel 8 Elevator feet

4 Lamp cover 9 Elevator feet spacers

5 IR Receiver
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About the Control Panel
The following figure shows the components of the MimioProjector control panel.

MENU

POWER TEMP LAMP

RESYNC SOURCE

1

MENU

2

4

6

9

8

7

5

3

1 Navigation keys Navigate through menus and make selections.

2 Power button Turn the projector on and off.

3 Power status light Indicates the power status of the projector.

4 Lamp status light Indicates the projector lamp status.

5 Temperature status light Indicates the projector temperature status.

6 Source button Select an input signal.

7 Resync button
Automatically synchronize the PC analog timing
to the optimized condition.

8 Menu/Exit button Open the menu screen or exit a menu.

9 IR receiver
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About the Remote Control
The following figure shows the components of the MimioProjector remote control.

1

2

4

6

9

8

7

5

3

10

12

13

14

15

16

11
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1 Source Select an input signal.

2 Resync Automatically synchronize the
PC analog timing to the optimized
condition.

3 HDMI Switch to HDMI input.

4 Video
Switch to Composite Video or S-
Video input.

5 3D Turn on and off the 3D menu.

6 Menu Open the menu screen or exit a menu.

7 Freeze
Freeze or unfreeze the image on the
screen.

8 Blank Hide or show the screen image.

9 Power Turn the projector on or off.

10 PC Switch to VGA-A/VGA-B input.

11 Keystone / Adjust image until the sides are
vertical.

12 Aspect ratio Select the desired aspect ratio.

13 Navigation keys Navigate through menus and make
selections.

14 Volume up Increase the audio volume.

15 Volume down Decrease the audio volume.

16 Mute Mute the audio.
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About the Connection Ports
The following figure shows the connection ports available on the MimioProjector .

1 2 4 6 98753

10 11 12 13 14 15 16

1 Mini-USB 9 Audio output

2 HDMI 10 12V trigger relay (12V, 250mA)

3 VGA output 11 RS232

4 VGA in 1 12 VGA in 2

5 Audio in 1 (for VGA in 1) 13 Audio in 2 (for VGA in 2)

6 S-Video 14 Composite video input

7
Left/Right RCA audio input (for
composite video input)

15 3.5 mm microphone input

8 Left/Right RCA audio input (for S-Video) 16 Power

Getting Started
Review the following topics to install and start using your MimioProjector.

n Connecting the Projector
n Setting Up the Remote Control
n Turning On the Power

Connecting the Projector
You can connect MimioProjector to a computer or other video source..
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Connecting to a Computer
The following figure shows the connection methods available for connecting the
MimioProjector to a computer.

LAN

Power outlet Audio output

+12V output

Notebook

Computer

Monitor

1

2 3 4 7 8652

2

4

4

1 Power cord (included) 5 RS232 cable

2 Audio cable 6 HDMI cable

3 VGA to DVI-A cable 7 USB cable

4 VGA cable (included) 8 12V DC jack
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Connecting to a Video Source
The following figure shows the connection methods available for connecting the
MimioProjector to a video source.

Video output

DVD player, set-top box, 

HDTV receiver

Power outlet

Audio output S-Video output DVD player, set-top box, 

HDTV receiver

+12V output

1 2

3 4

5

6

7 8

3 9 5

65

1 Power cord (included) 6 VGA to HDTV (RCA) cable

2 Microphone cable 7 HDMI cable

3 Audio cable jack/RCA 8 12V DC jack

4 S-Video cable 9 Composite video cable

5 Audio cable
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Setting Up the Remote Control
Before using the remote control for the first time, remove the transparent insulation tape.

To set up the remote control
1. Press firmly and slide the battery holder out of the battery compartment.

2. Remove the battery from the battery holder.
3. Remove the transparent insulation tape.

3V
O
LT

S

CR
20
25

4. Replace the battery holder with the + polarity marking facing up as shown.

3V
O
LT

S

CR
20
25
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5. Slide the battery holder back into the battery compartment and press firmly.

M
3V

O
LT

S

CR
20
25
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Turning On the Power
The projector has an auto-off feature which automatically turns the projector off when no
input signal is received by the projector for a set amount of time.

For information about setting the amount of time the projector will stay on before
automatically turning off, see Auto Power Off on page 188.

To turn the projector on
1. Securely connect the power cord and signal cable.

When connected, the Power status light turns red.

2. Press on the control panel or on the remote control.
The Power status light turns blue.

3. Turn on the source that you want to display on the screen (computer, notebook, video
player, and so on).
The projector detects the source automatically and displays the source image.

4. If multiple sources are connected to the projector, press Source on the control panel or
on the remote control to switch between inputs.
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Turning Off the Power
To turn the projector off

1. Press on the control panel or on the remote control.
A confirmation message is displayed on the projector screen.

2. Press again to turn the projector off.
The Power status light turns red and blinks rapidly. The projector fans continue to run
for approximately one minute to ensure that the projector cools properly.
When the system is finished cooling, the fans turn off and the Power status light turns
solid red, indicating that the projector is in standby mode.

3. Unplug the power cord.
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Status Lights

Message
Lamp status

light
Red

Temperature
status light

Red

Power status
light
Red

Power status
light
Blue

Power plug
Flash ON to
OFF 100ms

Flash ON to
OFF 100ms

Flash ON to
OFF 100ms

--

Standby -- -- ON --

Power button ON -- -- -- ON

Cooling state -- --

0.5 second H
(ON)

0.5 second L
(OFF)
flashing

--

Power button OFF
Cooling completed; Standby
mode

-- -- ON --

Firmware download ON ON ON --

Thermal sensor error
The following message is
displayed:
1. Make sure air inlets and

outlets are not blocked.
2. Make sure the

environment temperature
is under 40 degrees C

-- ON -- ON

Fan lock error
The following message is
displayed:
The projector will switch off
automatically.

--

0.5 second H
(ON)

0.5 second L
(OFF)
flashing

-- ON

Lamp error
(lamp, lamp driver, color wheel)

ON -- -- ON
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Adjusting the Projected Image
You can adjust the size and focus of the projected image.

Resizing the Projected Image
The size of the projected image depends on the distance of the projector from the screen.
The following table describes the general guidelines for projector distance from the screen.

Screen Size (16:10) Projection Distance (A) Projection Distance (B)

Diagonal (inch) mm Inch mm Inch mm

70 1778 20.4 517 7.2 182

80 2032 23.5 596 10.3 262

87.2 2215 25.8 655 12.6 320

90 2286 26.7 677 13.5 343

100 2540 29.9 759 16.7 424

Projection Distance A(mm) =Screen size (mm) x 0.296. Tolerance is around 3.1%.
For example, Projection Distance (655 mm) = Screen Size (2215 mm) x 0.296.

Focusing the Projected Image
Use the focus ring to adjust the focus of the projected image. Turn the ring until the image
is clear.
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Changing the Projector Settings
You can adjust the projector image and change the projector settings using the projector
menus. The projector automatically detects the input source.

To change the projector settings
1. Press Menu on the control panel or on the remote control to display the projector main

menu.
2. Use the navigation keys to select the desired menu item.

3. If the menu item has an arrow icon, , press ► to display the submenu for that
setting, and then use the navigation keys to select the desired menu item.

4. Press ◄ or ► to adjust the selected setting.
5. Press Menu to return to the previous menu or to exit the menu screen.

Navigating the Projector Menu
The following table describes the structure of the projector menu and submenus.

Main Menu Submenu Settings

PICTURE Color Mode Brightest / PC / Movie / Game / User

Wall Color White / Light Yellow / Light Blue / Pink / Dark
Green

Brightness 0~100

Contrast 0~100

Sharpness 0~31

Saturation 0~100

Hue 0~100

Gamma 0~3

Color Temp. Low / Mid / High

Color Space AUTO / RGB / YUV
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Main Menu Submenu Settings

SCREEN Aspect Ratio AUTO / 4:3 / 16:9 / 16:10

Phase 0~31

Clock -50~50

H. Position -10~10

V. Position -10~10

Digital Zoom 1~10

V Keystone -20~20

Ceiling Mount Front / Front Ceiling / Rear / Rear Ceiling

SETTING Language English / Deutsch / Français / Italiano / Español /
Português / Polski / Русский / Svenska / Norsk /简
体中文 /日本語 /한국어 / Türkçe /繁體中 文

/Nederlands / يبرع

Menu Location

Closed Caption Off / CC1 / CC2 / CC3 / CC4

VGA Out (Standby) Off / On

Auto Screen(12V out) Off / On

Test Pattern Off / On

Security

Security Off / On

Change
Password

000000

Reset No / Yes

AUDIO Mute Off / On

Volume 0~32

Microphone Volume 0~32
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Main Menu Submenu Settings

OPTIONS Logo Default / User

Logo Capture

Auto source Off / On

Input
HDMI / VGA-A / VGA-B / S-Video /
COMPOSITE

Auto Power Off (min) 0~120

Lamp
Setting

Lamp
Hours
Used
(Normal)

Lamp
Hours
Used
(ECO)

Lamp Life
Reminder

Off / On

Lamp
Power
Mode

ECO / Normal / Extreme Dimming

Clear
Lamp
Hours

No / Yes

Dynamic Black Off / On

High Altitude Off / On

Dust Filter
Reminder

Filters
Remind
(Hour)

Cleaning
Up
Reminder

No / Yes

Information
Model Name / SNID / Source / Resolution /
Software Version / Color Space / Aspect Ratio
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Main Menu Submenu Settings

3D

3D AUTO / Off / On

3D Invert Off / On

3D Format Frame Packing / Side-by-Side (Half) / Top and
Bottom / Frame Sequential / Field Sequential

1080p @
24

96Hz /
144Hz

INTERACTIVE Interactive Settings Off / IR Camera

Adjusting the 3D Settings
You can adjust the 3D settings for your projector.

3D
You can choose how the projector handles 3D images.

n Auto - select the 3D image automatically whenever an HDMI 1.4a 3D timing
identification signal is detected

n Off - turn off 3D functionality
n On - turn on 3D functionality

3D Invert
If you see a discrete or overlapping image while using DLP 3D glasses, you may need to
turn on this feature to get the best picture. This feature adjusts the left/right image sequence.

3D Format
When using 3D mode, select the 3D format that matches the format used by the input
source.

n Frame Packing - supports HDMI 1.4a 3D input signals
n Side-by-Side (Half) - supports HDMI 1.4a 3D input signals
n Top and Bottom - supports HDMI 1.4a 3D input signals
n Frame Sequential - supports DLP Link 3D input signals from VGA / HDMI connector

and HQFS 3D input signals from Composite/S-video connector
n Field Sequential - supports HQFS 3D input signals from Composite/S-video connector

1080p @24
Use this feature to select 96 or 144 Hz refresh rate as using 3D glasses in the 1080p @ 24
frame packing.
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Adjusting the Interactive Settings
Use this setting to turn on and off the Interactive Pen function.

n IR Camera - the Interactive Pen function is on
n Off - the Interactive Pen function is off

Before turning on Interactive, unplug the mini-USB cable that connects your computer to
the projector. After turning on Interactive, plug the mini-USB cable back in.

Notes
l This feature is only available when displaying images from HDMI/VGA input.
l This feature is not available when using 3D or Dynamic Black.

An external IR camera is required to use the Interactive feature. The IR camera must be
connected to the projector before the projector is mounted.

To connect the IR camera
1. Remove the camera connector cover from the projector.

2. Plug the camera into the camera connector.

Adjusting the Options
From the Options menu, you can change many of the projector settings as well as view the
projector information.

Logo
You can select the image to display on projector startup.

n Default- displays the default screen on projector startup
n User - displays an image of your choice on projector startup

See Logo Capture on page 188 for information on selecting an image.
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Logo Capture
You can capture an image to display on projector startup.

Press ► to capture the image currently displayed on the screen.
Notes
l Ensure that the displayed image does not exceed the native resolution of the
projector (WXGA:1280x800).

l Logo Capture is not available when 3D is enabled.
l The aspect ratio should be set to Auto before using capturing an image.

Auto Source
Select how to handle searching for an input source when the projector loses signal from the
current input source.

n On - the projector searches for signals from other input sources when the current input
signal is lost

n Off - the projector searches only for a signal from the current input connection when the
current input signal is lost

Input
Use this option to select the input types that the projector will search for.

1. From the Options menu, select Input, and then press ►.
2. Select the input that you do not want the projector to search for, and then press ► to

clear the check box for the selected input type.

Auto Power Off
The projector has an auto-off feature which automatically turns the projector off when no
input signal is received by the projector for a set amount of time.

You can set the amount of time the projector will stay on before automatically turning off .

Lamp Setting

Lamp Hours Used (Normal)

View the amount of time the projector has been used in normal lamp power mode.

Lamp Hours Used (ECO)

View the amount of time the projector has been used in ECO lamp power mode.

Lamp Life Reminder

You can choose whether or not the projector displays a warning message when the lamp is
nearing end of life.
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Lamp Power Mode

The following lamp power modes are available:

n Normal - the projector lamp is at full brightness
n ECO - the projector lamp is dimmed to reduce power consumption, extending the life

of the lamp
n Extreme Dimming - the projector lamp is dimmed 30 percent to reduce power

consumption, extending the life of the lamp

Clear Lamp Hours

Reset the lamp hours counter after replacing the projector lamp.

Dynamic Black
Use Dynamic Black to display the image with the optimum contrast by automatically
providing signal compensation to suit the currently displayed image.

Notes
l This feature is only available when the color mode is set to Movie.
l This feature is not available when using 3D or Interactive.
l Lamp Power Mode cannot be used with this feature.

High Altitude
The fan power required varies depending on the altitude you are at. Set this option
appropriately to ensure that the projector cools properly.

n On - the built-in fans automatically run at a variable speed according to the internal
temperature of the projector

n Off - the built-in fans run at high speed
Select this option when using the projector at altitudes above 5000 feet/1524 meters.

Filters Remind
You can set a time to be reminded to perform filter maintenance.

n Filters Remind (Hour) - Set the number of hours that pass before you are reminded to
clean the dust filters. The dust filters should be cleaned after every 500 hours of use.
Clean the filters more frequently if the projector is used in a dusty environment.

n Cleaning Up Reminder - Once you have cleaned or replaced the dust filters, reset the
timer to be reminded then next time the filters require maintenance.
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Information
Display the following projector information:

n Model name
n SNID
n Source
n Resolution

n Software version
n Color space
n Aspect ratio

Adjusting the Picture
Many settings are available for adjusting the picture displayed by the projector..

Color Mode
The following optimized color modes are available for viewing various types of images.

n Brightest - for brightness optimization
n PC - for viewing meeting presentations
n Movie - for viewing video content
n Game - for viewing game content
n User - for storing your manually configured settings

Wall Color
Select the wall color that the image is projected onto.The projector settings automatically
adjust to show the correct image tone, compensating for color deviation due to wall color.

Brightness
Adjust the brightness of the image.

Press ◄ to darken image.
Press ► to lighten the image.

Contrast
The Contrast controls the difference between the lightest and darkest parts of the picture.
Adjusting the contrast changes the amount of black and white in the image.

Press ◄ to decrease the contrast.
Press ► to increase the contrast.

Sharpness
Adjust the sharpness of the image.

This setting is only supported when Movie is selected as the color mode.

Press ◄ to decrease the sharpness.
Press ► to increase the sharpness.
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Saturation
Adjust the color saturation of the image. The saturation ranges from black and white to fully
saturated color.

This setting is only supported when Movie is selected as the color mode.

Press ◄ to decrease the amount of saturation in the image.
Press ► to increase the amount of saturation in the image.

Hue
Adjust the red and green color balance.

This setting is only supported when Movie is selected as the color mode.

Press ◄ to increase the amount of green in the image.
Press ► to increase the amount of red in the image.

Gamma
Adjusts the representation of dark scenery. The greater the gamma value, the bright dark
scenery will appear.

Press ◄ to decrease the gamma value.
Press ► to increase the gamma value.

Color Temperature
At a higher color temperature, the image appears colder; at a lower color temperature, the
image appears warmer.

Color Space
Select the appropriate color matrix type; Auto, RGB, or YUV.

Adjusting the Screen
You can adjust the screen and display settings for the projector.

Aspect Ratio
The following aspect ratios are available for scaling the projected image.

n Auto - keeps the image the original width-to-height ratio and maximizes the image to
fit native horizontal or vertical pixels

n 4:3 - scales the image to fit the screen and displays using a 4:3 ratio
n 16:9- scales the image to fit the width of the screen and adjusts the height to display

the image using a 16:9 ratio
n 16:10 - scales the image to fit the width of the screen and adjusts the height to display

the image using a 16:10 ratio
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Phase
Change the signal timing of the display to match the timing of the graphics card for your
computer. If the image appears unstable or flickers, use this setting to correct it.

Press ◄ to decrease the signal timing.
Press ► to increase the signal timing.

Clock
Change the display data frequency to match the frequency of the graphics card for your
computer. Adjust this setting only if the image appears to flicker vertically.

Press ◄ to decrease the data frequency.
Press ► to increase the data frequency.

Horizontal Position
Adjust the horizontal position of the projected image.

The range for this setting depends on the input source.

Press ◄ to move the image left.
Press ► to move the image right.

Vertical Position
Adjust the vertical position of the projected image.

The range for this setting depends on the input source.

Press ◄ to move the image down.
Press ► to move the image up.

Digital Zoom
Use this setting to zoom the projected image.

Press ◄ to reduce the size of the image.
Press ► to magnify the image on the projection screen.

Vertical Keystone
Use this setting to adjust the vertical distortion of the image. If the image appears
trapezoidal, adjust this setting to make the image appear rectangular.

Press ◄ or ► to adjust the vertical distortion of the image.

Ceiling Mount
Select the location of the ceiling mounted projector.

n Front - the image is projected straight onto the screen.
n Front Ceiling - the image turns upside down (default).
n Rear - the image appears reversed.
n Rear Ceiling - the image appears reversed and upside down.
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Adjusting the General Settings
You can adjust many of the general settings for your projector.

Language
Select the language to use when displaying the projector menus.

Menu Location
Select the location for the projector menu to display.

Top left

Top right

Center

Bottom left

Bottom right

Closed Caption
The following closed caption options are available:

n Off
n CC1
n CC2
n CC3
n CC4.

VGA OUT (Standby)
You can enable VGA OUT connection to display the projector image on an additional
display.

Select On to enable VGA OUT connection.

Auto Screen (12V Out)
If you are using the projector with a powered screen, you can choose to automatically lower
and raise the screen when the projector is powered on and off.

n On - the screen lowers automatically when you turn the projector power on and raises
automatically when you turn the projector power off

n Off - the screen does not lower and raise automatically when you turn the projector
power on and off
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Test Pattern
You can display a test pattern to test the image settings.

n On - show the test pattern
n Off - hide the test pattern

Security
You can choose to require a password to be entered each time the projector is turned on.
The following security settings are available:

n On - the user must enter a password in order to power on the projector
n Off - the user is not required to enter a password in order to power on the projector

Setting the Password

If the password is entered incorrectly 3 times, the projector automatically shuts down. If you
forget your password, contact Mimio Customer Support for assistance.

To set the password for the first time
1. From the Security menu, select Change Password, and then press ►.
2. Use the navigation keys to enter 000000 as the current password, and then press ►.

If the password is entered incorrectly 3 times, the projector automatically shuts
down.

3. Use the navigation keys to enter a new password, and then select ENTER to confirm.
The password must be six digits.

4. Use the navigation keys to enter the new password again, and then select ENTER to
confirm.

To change the password
1. From the Security menu, select Change Password, and then press ►.
2. Use the navigation keys to enter the current password, and then press ►.

If the password is entered incorrectly 3 times, the projector automatically shuts
down.

3. Use the navigation keys to enter a new password, and then select ENTER to confirm.
The password must be six digits.

4. Use the navigation keys to enter the new password again, and then select ENTER to
confirm.

Reset
Resetting the projector resets all projector settings to the factory defaults.

Select Yes to reset the projector.
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Adjusting the Volume
You can adjust the projector volume settings.

Mute
You can choose to mute the projector audio.

You can also press Mute on the remote control to turn mute on and off.

Volume
Use this setting to increase or decrease the speaker volume.

Press ◄ to decrease the volume.
Press ► to increase the volume.
You can also use the volume buttons on the remote control to adjust the volume.

Microphone Volume
Use this setting to increase or decrease the microphone volume.

Press ◄ to decrease the volume.
Press ► to increase the volume.

Caring for MimioProjector

Replacing the Remote Control Battery
To ensure safe operation, please observe the following precautions :

n Use only CR2025 type battery.
Using the incorrect battery type may cause explosion.

n Avoid contact with water or liquid.
n Do not expose the remote control to moisture or heat.
n Do not drop the remote control.
n If the battery leaks while inserted in the remote control, carefully wipe the case clean

and install new battery.
n Dispose of used battery according to battery instructions.
To replace the battery
1. Press firmly and slide the battery holder out of the battery compartment.

2. Remove the old battery from the battery holder.
3. Insert a new battery into the battery holder with the + polarity marking facing up as
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shown.
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S
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4. Slide the battery holder back into the battery compartment and press firmly.

M
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Replacing the Lamp
The projector automatically detects the lamp life. When the lamp is nearing the end of life,
a warning is displayed on the screen.

When the warning appears, contact Mimio Customer Support to order a replacement lamp as
soon as possible. Make sure the projector is off and has cooled down for at least 60 minutes
before changing the lamp.

Notes
l MimioProjector uses an OSRAM P-VIP 240/0.8 E20.8 bulb.
l The screws on the lamp cover and the lamp cannot be removed.
l The projector cannot be turned on while the lamp cover is removed.
l Do not touch the glass area of the lamp. Oils from your skin can cause the lamp to
shatter. Use a dry cloth to clean the lamp module if the lamp is accidentally
touched.

To remove the lamp module
1. Press the power button to turn off the projector.
2. Allow the projector to cool down for at least 60 minutes.
3. Unplug the power cord.
4. Using a screwdriver, loosen the two screws on the lamp cover.
5. Lift and remove the lamp cover.
6. Using a screwdriver, loosen the two screws on the lamp module.
7. Pull the lamp handle up and slowly and carefully remove the lamp module.
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To insert the new lamp module
1. Slowly and carefully insert the lamp module into the lamp compartment and push the

lamp handle down.
2. Using a screwdriver, tighten the two screws on the lamp module.
3. Replace the lamp cover.
4. Using a screwdriver, tighten the two screws on the lamp cover.
5. Plug the power cord into a wall outlet.
6. Press the power button to turn on the projector.
7. Clear the lamp hours. See Clear Lamp Hours on page 189 for information about

clearing the lamp hours.

Cleaning the Dust Filters
The dust filters should be cleaned after every 500 hours of use. Clean the filters more
frequently if the projector is used in a dusty environment.

When the dust filters need to be cleaned, a warning is displayed on the screen.

When the warning appears, clean the dust filters as soon as possible. Make sure the
projector is off before cleaning the dust filters.

Notes
l The dust filters should be used in dusty environments.
l Properly maintaining the dust filters prevents overheating of the projector and
related damage.

To clean the dust filters
1. Press the power button to turn off the projector.
2. Unplug the power cord.
3. Pull the latch and slowly and carefully remove the dust filters from the projector.
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4. Use a vacuum to clean the dust filters.
5. Slide the dust filters back into the projector.
6. Plug the power cord into a wall outlet.
7. Press the power button to turn on the projector.
8. Reset the filter maintenance reminder.

See Filters Remind on page 189 for information about resetting the filters reminder.

Getting Help
Review this chapter if you encounter a problem with your projector.

If you are unable to solve a problem, this chapter also describes how to contact Mimio
Technical Support.

n General Troubleshooting
n Image Troubleshooting
n 3D Troubleshooting
n Sound Troubleshooting
n Remote Control Troubleshooting
n Contacting Mimio

General Troubleshooting
Review this section if you encounter a general problem with your projector.
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Projector stops responding to all controls
1. Press the power button to turn the projector off.
2. Unplug the power cord.
3. After 20 seconds, or longer, plug the power cord back in.
4. Press the power button to turn the projector on.

Lamp burns out or makes a popping sound
When the lamp reaches end of life, it burns out and may make a loud popping sound. The
projector will not turn on again until the lamp module is replaced. For information about
replacing the lamp, see Replacing the Lamp on page 196.

Image Troubleshooting
Review this section if you encounter a problem with the projector image.

No image is displayed
n Ensure all cables and power connections are correctly and securely connected as

described in Connecting the Projector on page 174.
n Ensure the pins of connectors are straight and not broken.
n Ensure that the projection lamp is securely installed.
n Ensure that the Blank feature is turned off.

A partial, scrolling, or incorrect image is displayed
n Press ReSync on the remote control.
If you are using a computer as the input source, do the following:
1. Verify that the display resolution setting for your computer is set at 1080p or lower.

Refer to the documentation for your computer for information about changing the
display resolution for your computer.

If you experience difficulty changing resolutions or your monitor freezes, restart all
equipment including the projector.

2. If you are using a notebook computer, press the keyboard buttons needed to toggle the
output setting.

Notebook Brand Function Keys

Acer [Fn]+[F5]

Asus [Fn]+[F8]

Dell [Fn]+[F8]

Gateway [Fn]+[F4]

IBM/Lenovo [Fn]+[F7]

HP/Compaq [Fn]+[F4]

NEC [Fn]+[F3]

Toshiba [Fn]+[F5]

Mac Apple System Preference -> Display -> Arrangement -> Mirror display
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The notebook computer display is not displaying an image
Some notebook computers may deactivate the screens when a second display device is in
use. Each has a different way to be reactivated. Refer to the documentation for your
computer for detailed information.

Image is unstable or flickering
n Adjust the Phase setting on the projector. See Phase on page 192 for information about

changing the Phase setting.
n Change the monitor color setting on your computer.

Image has vertical flickering bar
n Adjust the Clock setting on the projector. to make an adjustment. See Clock on page

192 for information about changing the Clock setting.
n Check and reconfigure the display mode of your graphic card to make it compatible

with the projector.

Image is out of focus
n Adjust the focus ring on the projector lens.
n Make sure the projection screen is within the required distance.

Image is stretched when displaying 16:9 DVD image
n When you play anamorphic DVD or 16:9 DVD, the best image is displayed when the

projector is set to use 16: 9 format.
n If displaying a 4:3 format DVD title, set the projector to use 4:3 format.

If the image is still stretched, verify that the format setting on your DVD player is set
correctly.

Image is too small or too large
n Move the projector closer to or further from the screen.
n Adjust the aspect ratio setting on the projector. See Aspect Ratio on page 191for

information about adjusting the aspect ratio.

Image is displayed with slanted sides
n If possible, reposition the projector so that the image is centered on the screen.
n Adjust the vertical keystone setting on the projector. See Vertical Keystone on page

192 for information about adjusting this setting.

Image is reversed
Verify that the ceiling mount setting on the projector is set correctly. See Ceiling Mount on
page 192for information about adjusting this setting.

3D Troubleshooting
Review this section if you encounter a problem with 3D mode.
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A blurry double image is displayed
Make sure the 3D feature is off. For information about turning off 3D, see 3D on page 186.

Two images are displayed side-by-side
Set the 3D format to Side-by-Side (Half). For information about changing the 3D format, see
3D Format on page 186.

Image not displayed in 3D
n Make sure your 3D glasses are powered on.
n Make sure the batteries in the 3D glasses have sufficient charge.
n Set the 3D format to Side-by-Side (Half).

For information about changing the 3D format, see 3D Format on page 186.

Sound Troubleshooting
Review this section if you encounter a problem with the projector sound.

n If you are playing sound from an external source, make sure you have the audio cable
securely connected to the source device and the audio input on the projector.

n Make sure no external speakers are connected.
n Make sure the volume is not set to the minimum.
n Make sure the Mute feature is off.

Remote Control Troubleshooting
Review this section if you encounter a problem with the projector remote control.

n Make sure the operating angle of the remote control is within ±30° both horizontally
and vertically of one of the IR receivers on the projector.

n Make sure there are no obstructions between the remote control and the projector.
n Move to within 7 m (±0°) of the projector.
n Make sure the battery is inserted correctly.
n Replace the battery.
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Compatibility Modes

VGA Analog

PC Signal

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

VGA 640x480 60 31.5

640x480 67 35.0

640x480 72 37.9

640x480 75 37.5

640x480 85 43.3

640x480 120 61.9

IBM 720x400 70 31.5

SVGA 800x600 56 35.1

800x600 60 37.9

800x600 72 48.1

800x600 75 46.9

800x600 85 53.7

800x600 120 77.4

Apple, MAC II 832x624 75 49.1

XGA 1024x768 60 48.4

1024x768 70 56.5

1024x768 75 60.0

1024x768 85 68.7

1024x768 120 99.0
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Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

Apple, MAC II 1152x870 75 68.7

SXGA 1280x1024 60 64.0

1280x1024 72 77.0

1280x1024 75 80.0

QuadVGA 1280x960 60 60.0

1280x960 75 75.2

SXGA+ 1400x1050 60 65.3

UXGA 1600x1200 60 75.0

Extended Wide Timing

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

WXGA 1280x720 60 44.8

1280x800 60 49.6

1366x768 60 47.7

1440x900 60 59.9

WSXGA+ 1680x1050 60 65.3
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Component Signal

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

480i 720x480(1440x480) 59.94(29.97) 15.7

576i 720x576(1440x576) 50(25) 15.6

480p 720x480 59.94 31.5

576p 720x576 50 31.3

720p 1280x720 60 45.0

1280x720 50 37.5

1080i 1920x1080 60(30) 33.8

1920x1080 50(25) 28.1

1080p 1920x1080 23.98/24 27.0

1920x1080 60 67.5

1920x1080 50 56.3
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HDMI Digital

PC Signal

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

VGA 640x480 60 31.5

640x480 67 35.0

640x480 72 37.9

640x480 75 37.5

640x480 85 43.3

640x480 120 61.9

IBM 720x400 70 31.5

SVGA 800x600 56 35.1

800x600 60 37.9

800x600 72 48.1

800x600 75 46.9

800x600 85 53.7

800x600 120 77.4

Apple, MAC II 832x624 75 49.1

XGA 1024x768 60 48.4

1024x768 70 56.5

1024x768 75 60.0

1024x768 85 68.7

1024x768 120 99.0
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Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

Apple, MAC II 1152x870 75 68.7

SXGA 1280x1024 60 64.0

1280x1024 72 77.0

1280x1024 75 80.0

QuadVGA 1280x960 60 60.0

1280x960 75 75.2

SXGA+ 1400x1050 60 65.3

UXGA 1600x1200 60 75.0

Extended Wide Timing

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

WXGA 1280x720 60 44.8

1280x800 60 49.6

1366x768 60 47.7

1440x900 60 59.9

WSXGA+ 1680x1050 60 65.3
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Video Signal

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

480p 640x480 59.94/60 31.5

480i 720x480(1440x480) 59.94(29.97) 15.7

576i 720x576(1440x576) 50(25) 15.6

480p 720x480 59.94 31.5

576p 720x576 50 31.3

720p 1280x720 60 45.0

1280x720 50 37.5

1080i 1920x1080 60(30) 33.8

1920x1080 50(25) 28.1

1080p 1920x1080 23.98/24 27.0

1920x1080 60 67.5

1920x1080 50 56.3

HDMI 1.4a Mandatory 3D Timing - Video Signal

Modes Resolution V. Frequency [Hz] H. Frequency [Hz]

Frame Packing 720p 50 31.5

720p 59.94/60 15.7

1080p 23.98/24 15.6

Side-by-Side(Half) 1080i 50 31.5

1080i 59.94/60 31.3

Top and Bottom 720p 50 45.0

720p 59.94/60 37.5

1080p 23.98/24 33.8
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Technical and Environmental Information
This chapter contains technical information for the MimioProjector.

For product specifications and compliance information, visit the Documentation section of
the Support area of our Web site at www.mimio.com.

Usage Notice
Follow all warnings, precautions, and maintenance as recommended in this user guide.

Warnings
n Do not look into the projector lens when the lamp is on. The bright light may hurt and

damage your eyes.
n To avoid the risk of fire or electric shock, do not expose the projector to rain or

moisture.
n Do not open or disassemble the projector as this may cause electric shock.
n When replacing the lamp, allow the unit to cool down first. Follow the instructions as

described under Replacing the Lamp on page 196.
n The projector automatically detects the life of the lamp. Be sure to replace the lamp

when the projector displays the lamp warning message.
n After replacing the projector lamp, reset the lamp hours setting. See Clear Lamp Hours

on page 189 for information about resetting the lamp hours.
n When turning the projector power off, ensure that the cooling cycle completes before

disconnecting the power. Allow 10 seconds for the projector to cool down.
n Do not block the light path between the light source and the lens with any object.

Doing so could cause the object to catch on fire.
n Do not look into or point the laser pointer on your remote control into any person's

eyes. Laser pointers can cause permanent damage to eyesight.

Precautions
n Turn off and unplug the power plug from the AC outlet before cleaning the product.
n Use a soft dry cloth with mild detergent to clean the display housing.
n Disconnect the power plug from the AC outlet if the product is not being used for a

long period of time.
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Do not do the following
n Clean the lens.
n Block the ventilation slots and openings on the unit.
n Use abrasive cleaners, waxes, or solvents to clean the unit.
n Use under the following conditions:

l In extremely hot, cold, or humid environments.
l Ensure that the ambient room temperature is between 5°C - 40°C.
l Ensure relative humidity is a maximum of 80%, non-condensing.

l In areas susceptible to excessive dust and dirt.
l Near any appliance generating a strong magnetic field.
l In direct sunlight.

Regulation & Safety Notices
This section lists the general notices of your projector.

FCC Notice
This device has been tested and found to comply with the limits for a Class B digital device
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This device generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If
this device does cause harmful interference to radio or television reception, which can be
determined by turning the device off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

n Reorient or relocate the receiving antenna.
n Increase the separation between the device and receiver.
n Connect the device into an outlet on a circuit different from that to which the receiver

is connected.
n Consult the dealer or an experienced radio/television technician for help.

Notice

Shielded cables All connections to other computing devices must be made using shielded
cables to maintain compliance with FCC regulations.

Caution

Changes or modifications not expressly approved by the manufacturer could void the user’s
authority, which is granted by the Federal Communications Commission, to operate this
projector.
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Operating Conditions
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions:

1. This device may not cause harmful interference and
2. This device must accept any interference received, including interference that may cause

undesired operation.

Notice: Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Remarque à L’intention des Utilisateurs Canadiens

Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canada.

Declaration of Conformity for EU countries
n EMC Directive 2004/108/EC (including amendments)
n Low Voltage Directive 2006/95/EC
n R & TTE Directive 1999/5/EC (if product has RF function)

Projector Mount Safety Notices
Read these warnings carefully and use the product as intended.

n The manufacturer shall not be legally responsible for any equipment damage or personal
injury caused by incorrect installation or operation.

n The wall mount is designed for easy installation and removal. The manufacturer shall
not be liable for damage to equipment or personal injuries arising from human factors or
acts of God, such as earthquake or typhoon.

n The wall mount must be installed by professional personnel only.
n To avoid any hazard caused by falling objects, a minimum of two persons are needed to

install or remove the wall mount.
n Maintain ample space around the projector to ensure good ventilation.
n To ensure safety and avoid any accident, investigate the structure of the wall and select

an appropriate and durable location for the product before installing.
n The wall must have load-carrying capability to sustain more than four times the total

weight of the projector and the wall mount. Also make sure the wall has enough
strength to withstand earthquakes and other shocks.

n Check the areas around the installation location carefully.
l Do not install the product in an area subject to high temperature, humidity, or
contact with water.

l Do not install the product near air conditioner vents.
l Do not install the product in a location subject to dust or fumes.
l Do not install the product on slanted surfaces; install only on vertical walls.
l Do not install the product in an area subject to vibrations or shocks.
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l Do not install the product in an area subject to direct exposure to bright light; doing
so may cause eye fatigue when viewing the display panel.

n Do not modify any accessory or use broken parts. Contact Mimio Customer Support
with any questions.

n Tighten all screws, but do not apply excessive torque to any screw. Excessive torque
may break or damage the screw or screw threads.

n The wall mount is rated for a maximum load of 15 Kg (33 Ibs.).
n Do not hang or place any objects on the wall mount other than the projector.
n Drill holes and screws remain in the wall once the projector and wall mount are

removed. Stains may occur after extended use.
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Customizing MimioStudio
This chapter describes the general features of MimioStudio Settings.

The following table shows several ways to access MimioStudio Settings.

To start from Do this

Notification area Right-click , and then choose Settings.

MimioStudio Notebook Do one of the following:

n Double-click  on the status bar.
n Choose Settings from the Tools menu.

MimioStudio Gradebook

Do one of the following:

n Double-click  on the status bar.
n Choose Settings from the Tools menu.

MimioStudio Settings contains options for setting and customizing the properties and
characteristics of your MimioClassroom system, including Classroom Devices, Gradebook,
Ink Capture, Interactive, Language, Notebook, and Vote.

To change the settings
1. From the MimioStudio Settings dialog box, select the setting you want to change from

the list on the left.
2. Make the changes you want to the settings.

See later sections in this chapter for a complete description of all settings.
3. Click Apply.

Adjusting the Classroom Devices Settings
The Classroom Devices settings displays a list of all MimioClassroom devices that are
connected or are available to connect to your computer. You can connect to any available
devices using the Classroom Devices settings.
To connect to an available MimioClassroom device
1. Select the device to connect to from the Devices list.
2. Click Connect.

Adjusting the Tablet Devices Settings
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Adjusting the Ink Capture Settings
The Ink Capture settings allow you to do the following:

n Change the surface size for a connected MimioTeach or Mimio Interactive device
n Change the mounting location for a Mimio Interactive device
n Change the width and color assignment for each MimioCapture or Mimio Capture Kit

pen

These settings are only used when your MimioTeach or Mimio Interactive device is used to
capture digital ink.

To adjust the settings for a MimioTeach or Mimio Interactive device
1. Choose the device to adjust from the Device list.
2. Make the changes you want to the settings.
3. Click Apply.
To adjust surface size for a MimioTeach or Mimio Interactive device

Do one of the following:
l Choose a size from the Surface Size list.
l Choose Custom from the Surface Size list and enter the desired values into the
Width and Height boxes.

l Click Auto Size and touch a MimioCapture or Mimio Capture Kit pen at the
location shown in the Auto Size dialog box.

To adjust the mounting location for a Mimio Interactive bar
Choose a mounting location from the Device Mounting list.

The sensors on the Mimio Interactive bar must point in toward the writing surface.
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Location Description

Vertical – Top Left
Default

The Mimio Interactive bar is mounted vertically and aligned with the
top left corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Vertical – Top Right The Mimio Interactive bar is mounted vertically and aligned with the
top right corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Vertical – Bottom Left
The Mimio Interactive bar is mounted vertically and aligned with the
bottom left corner of the whiteboard (maximum size is 4’ tall x 8’
wide).

Vertical – Bottom
Right

The Mimio Interactive bar is mounted vertically and aligned with the
bottom right corner of the whiteboard (maximum size is 4’ tall x 8’
wide).

Horizontal – Top Left The Mimio Interactive bar is mounted horizontally and aligned with the
top left corner of the whiteboard (maximum size is 8’ tall x 4’ wide).

Horizontal – Top
Right

The Mimio Interactive bar is mounted horizontally and aligned with the
top right corner of the whiteboard (maximum size is 8’ tall x 4’ wide).

Horizontal – Bottom
Left

The Mimio Interactive bar is mounted horizontally and aligned with the
bottom left corner of the whiteboard (maximum size is 8’ tall x 4’
wide).

Horizontal – Bottom
Right

The Mimio Interactive bar is mounted horizontally and aligned with the
bottom right corner of the whiteboard (maximum size is 8’ tall x 4’
wide).

This feature is not necessary for MimioTeach. When using MimioTeach with
MimioCapture, the MimioTeach bar is always attached to the MimioCapture tray. When
using MimioTeach without MimioCapture, the MimioTeach bar can be mounted
anywhere on the whiteboard.

To adjust the pen settings
1. Click Pens.

The Pens dialog box appears.
2. Choose the MimioCapture or Mimio Capture Kit pen to adjust from the Pen list.
3. To adjust the line thickness of the pen, drag the Pen Width slider.

Alternately, enter a value into the Pen Width box.
4. To adjust the pen color, select a color from the Pen Color palette.

For additional color choices, click More Colors.
5. Click OK.
To view device information
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Click Settings.
The dialog box appears showing the device information, environmental analysis, and
device memory.

To reset to the default device settings
Click Defaults.

Adjusting the Interactive Settings
The Interactive settings allow you to calibrate or enable (if calibration has already been
done) Interactive mode. The Interactive settings also contain settings for changing the
functions of the MimioTeach stylus, Mimio Interactive mouse, MimioTeach bar,
MimioCapture tray buttons, and Mimio Interactive bar buttons.

General Settings

Setting Description

Use previous calibration Prevents you from having to calibrate each time you start Interactive
mode.
Select this setting if you have a permanently installed whiteboard and
projector.

Automatically enable
when a device is
detected

Automatically starts Interactive mode when a MimioTeach or Mimio
Interactive bar is connected to your computer.

Actions and Commands Settings

Setting Description

Action List of the MimioTeach stylus, Mimio Interactive mouse, MimioTeach
bar, Mimio Interactive bar, and MimioCapture tray buttons.

Function List of the functions that you can associate with a MimioTeach stylus,
Mimio Interactive mouse, MimioTeach bar, Mimio Interactive bar, or
MimioCapture tray button.

Adjusting the Language Settings
You can change the display language for MimioStudio software so that you can work in a
language that is most familiar to you.

To adjust the language
1. Choose a language from the Language list.
2. Click Apply.

The MimioStudio dialog box appears.
3. Click Yes to restart MimioStudio in the selected language.
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Adjusting MimioStudio Notebook Settings
MimioStudio Notebook settings provides options for setting the general parameters of
MimioStudio and the default interaction mode with MimioClassroom devices.

The following tables describe the MimioStudio Notebook settings.

General Settings

Setting Description

Enable audio feedback Enables sound from a Mimio device when buttons are pressed or the
device is connected or disconnected from the computer.

Enable smooth ink,
objects and text

Enables smooth or anti-aliased ink, objects, and text.
Disabling this setting can increase the performance of the application.

Enable auto recovery
Enables the automatic recovery of data if MimioStudio quits unexpectedly.
When this setting is enabled, MimioStudio Notebook saves ink data to a
backup file every 10 minutes.

Enable trashcan
Places the trashcan on the MimioStudio Notebook as an easy method for
deleting content.

Enable fullscreen
border
(Screen Annotation
only)

Enables the border during Screen Annotation mode.
See Marking Up the Display Using Screen Annotations.

Ink Capture Settings

Setting Description

Connect to available
device on file new

Automatically connect devices to newly opened Notebook.

Connect to device when
any pen is used

Automatically open a Notebook in Ink Capture mode when a
MimioCapture or Mimio Capture Kit pen touches the whiteboard.

Download data when
local storage is detected
(Mimio Interactive only)

Automatically download digital ink to a new MimioStudio Notebook
when a Mimio Interactive device is detected by your computer.

Clear local storage after
successful download
(Mimio Interactive only)

Automatically clear digital ink from a Mimio Interactive device after the

information is downloaded to a MimioStudio Notebook.

Create a new page when

the 'Launch' button is

pressed

Automatically add a new page to the MimioStudio Notebook each time the
Launch button, , is pressed.
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Adjusting the Proxy Server Settings
If you activated MimioStudio software using an activation code, the software must be able
to validate the activation code with the licensing server at least once every 15 days. You
can enable MimioStudio software to use a proxy server to validate the activation code.

If you activated MimioStudio software by connecting a Mimio hardware device, no
validation of an activation code is required.

Proxy Server Settings

Setting Description

Enable Proxy Server Select this check box to enable MimioStudio to use a proxy server.

IP Address Enter the IP address of the proxy server.

Port Enter the port to use to access the proxy server.

Username Enter the user name to use to access the proxy server.

Password Enter the password for the proxy server.

Adjusting the Tablet Devices Settings
The Tablet Devices settings displays a list of all tablet devices that are connected to your
computer.

Adjusting the Mobile Settings
The Mobile settings displays the connection information for MimioMobile and the QR code
used to connect the teacher mobile device to your computer.
To connect the teacher mobile device
1. Start MimioStudio Settings.

2. Select Mobile.

3. Tap on your mobile device to start MimioMobile.
4. Under Connection Methods, tap QR scan.
5. Tap the QR code image on the mobile device to launch the camera.
6. Align the guides on the device screen with the QR code in MimioStudio to scan the

QR code.
The device connects to your computer and the desktop is displayed on your mobile
device.

Adjusting the Vote Settings
The following table describes the MimioStudio Vote settings.
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Setting Description

Buttons Select to have each MimioVote unit button illuminated with a different
color or to have all the buttons illuminated with a single color.

Display student scores
on handheld units

Select this check box to have the student score displayed on each
student's MimioVote unit once the student has completed a self-paced
activity.

Store screen snapshot
with question

Select this check box to save a screen shot with each question polled
using MimioStudio Quick Vote.
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Getting Help
This chapter describes how to check for and install software updates, and how to
troubleshoot some common problems.

If you are unable to solve a problem, this chapter also describes how to contact Mimio
Technical Support.

Updating the Software
The Software Update settings allow you to check for and install MimioStudio software
updates.

You must be connected to the Internet to check for updates.

To check for software updates
1. Start MimioStudio Settings.
2. Select Software Update.
3. Click Check for Updates.

A list of available updates is displayed.
To turn on automatic update notification

Select the Notify me when updates are available check box, and then click OK.
To install software updates
1. Select the updates you want to install.
2. Click Install.

Troubleshooting
To test for environmental interference (Mimio Interactive only)
1. Start MimioStudio Settings.
2. Select Ink Capture, and then click Settings.
3. Under Environmental Analysis, click Test.

Contacting Mimio
Mimio maintains an Internet Web site that offers support for MimioClassroom products. In
addition, Mimio’s Technical Support department is available by phone.

Web site: www.mimio.com

Phone: (877) 846-3721

Visit the Support section of our Web site at www.mimio.com to contact us by email.
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Technical and
Environmental Information
This chapter contains technical information for the MimioClassroom products.

For product specifications and compliance information, visit the Documentation section of
the Support area of our Web site at www.mimio.com.

Environmental Information
The equipment that you bought has required the extraction and use of natural resources for
its production. It may contain hazardous substances for the health and the environment.

In order to avoid the dissemination of those substances in our environment and to diminish
the pressure on the natural resources, we encourage you to use the appropriate take-back
systems.

Those systems will reuse or recycle most of the materials of your end life equipment in a
sound way.

The crossed-bin symbol marked in your device invites you to use those systems.

If you need more information on the collection, reuse and recycling systems, please contact
your local or regional waste administration.

You can also contact Mimio for more information on the environmental performances of our
products.

Safety Precautions for Lithium-Ion Rechargeable Batteries
Inaccurate handling of a Lithium-ion rechargeable battery may cause leakage, heat, smoke,
an explosion, or fire. This could cause deterioration of performance or failure. This may also
damage the protection device installed in the battery pack. This could damage equipment or
injure users. Thoroughly follow the instructions below.
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Technical and Environmental Information

While Charging
Danger
l When charging the battery, use dedicated chargers and follow the specified
conditions.

l Do not connect directly to an electric outlet or cigarette lighter charger.
l Do not use or store battery close to fire or inside the car where temperature may be
over 60°C.

Warning
l Stop charging the battery if charging is not completed within the specified time.
Caution
l Thoroughly read this user guide before charging the battery.
l Do not charge in a place that generates static electricity.
l Battery can only be charged within 0°C~45°C temperature range.

When Discharging the Battery
Danger
l Use the battery only in the specified equipment.
l Do not use or store battery close to fire or inside the car where temperature may be
over 60°C.

Caution
l Do not charge in a place that generates static electricity.
l Battery can only be used within -20°C~60°C temperature range.

Documentation Feedback
We are constantly working to produce the highest quality documentation for our products.
We welcome your feedback. Send us your comments or suggestions about our online Help,
printed, or PDF manuals.

Please include the following information with your feedback:

n Product name and version number
n Type of document: printed manual, PDF, or online Help
n Topic title (for online Help) or page number (for printed or PDF manuals)
n Brief description of content (for example, step-by-step instructions that are inaccurate,

information that requires clarification, areas where more detail is needed, and so on)
n Suggestions for how to correct or improve the documentation

We also welcome your suggestions for additional topics you would like to see covered in
the documentation.

Send email feedback to:

documentation@mimio.com
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Documentation Feedback

Please keep in mind that this email address is only for documentation feedback. If you have
a technical question, please contact Customer Service.
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